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This document describes the avionics software options.
Described are the following software options:

● R&S®SMBV-K111
1419.2396.xx

● R&S®SMBV-K151
1419.2621.xx

● R&S®SMBV-K152
1419.2664.xx

● R&S®SMBV-K153
1419.2667.xx

This manual describes firmware version FW 3.20.281.xx and later of the R&S®SMBV100A.
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1 Preface

1.1 About this Manual

This operating manual provides all the information specific to the Avionics options.
All general instrument functions and settings common to all applications and operating
modes are described in the main R&S SMBV operating manual.

The main focus in this manual is on the provided settings and the tasks required to
generate a signal. The following topics are included:
● Welcome to the Avionics options R&S SMBV-K111/-K151/-K152/-K1153

Introduction to and getting familiar with the options
● About the Avionics options

Background information on basic terms and principles in the context of the signal
generation

● GBAS/ ILS/ VOR/ DME Configuration and Settings
A concise description of all functions and settings available to configure signal gen-
eration with their corresponding remote control command for the specific standard

● Remote Control Commands
Remote commands required to configure and perform signal generation in a
remote environment, sorted by tasks
(Commands required to set up the instrument or to perform common tasks on the
instrument are provided in the main R&S SMBV operating manual)
Programming examples demonstrate the use of many commands and can usually
be executed directly for test purposes

● Annex
Reference material

● List of remote commands
Alphabetical list of all remote commands described in the manual

● Index

1.2 Documentation Overview

The user documentation for the R&S SMBV consists of the following parts:

● Online Help system on the instrument,
● "Quick Start Guide" printed manual,
● Documentation CD-ROM with:

– Online help system (*.chm) as a standalone help,
– Operating Manuals for base unit and options,
– Service Manual,
– Data sheet and specifications,
– Links to useful sites on the R&S internet.

 

 

 

About this Manual
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Online Help

The Online Help is embedded in the instrument's firmware. It offers quick, context-sen-
sitive access to the complete information needed for operation and programming. The
online help contains help on operating the R&S SMBV and all available options.

Quick Start Guide

The Quick Start Guide is delivered with the instrument in printed form and in PDF for-
mat on the Documentation CD-ROM. It provides the information needed to set up and
start working with the instrument. Basic operations and an example of setup are descri-
bed. The manual includes also general information, e.g., Safety Instructions.

Operating Manuals

The Operating Manuals are a supplement to the Quick Start Guide. Operating Manuals
are provided for the base unit and each additional (software) option.

These manuals are available in PDF format - in printable form - on the Documentation
CD-ROM delivered with the instrument. In the Operating Manual for the base unit, all
instrument functions are described in detail. Furthermore, it provides an introduction to
remote control and a complete description of the remote control commands with pro-
gramming examples. Information on maintenance, instrument interfaces and error
messages is also given.

In the individual option manuals, the specific functions of the option are described in
detail. For additional information on default settings and parameters, refer to the data
sheets. Basic information on operating the R&S SMBV is not included in the option
manuals.

Service Manual

The Service Manual is available in PDF format - in printable form - on the Documenta-
tion CD-ROM delivered with the instrument. It describes how to check compliance with
rated specifications, on instrument function, repair, troubleshooting and fault elimina-
tion. It contains all information required for repairing the instrument by the replacement
of modules.

This manual can also be orderd in printed form (see ordering information in the data
sheet).

Release Notes

The release notes describe new and modified functions, eliminated problems, and last
minute changes to the documentation. The corresponding firmware version is indicated
on the title page of the release notes. The current release notes are provided in the
Internet.

Web Help

The web help provides online access to the complete information on operating the
R&S SMBV and all available options, without downloading. The content of the web
help corresponds to the user manuals for the latest product version.

Documentation Overview
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The web help is available on the R&S SMBV product page at the Downloads > Web
Help area.

Application Notes

Application notes, application cards, white papers and educational notes are further
publications that provide more comprehensive descriptions and background informa-
tion.

The latest versions are available for download from the Rohde & Schwarz website, at
http://www.rohde-schwarz.com/appnotes.

1.3 Typographical Conventions

The following text markers are used throughout this documentation:

Convention Description

"Graphical user interface ele-
ments"

All names of graphical user interface elements on the screen, such as
dialog boxes, menus, options, buttons, and softkeys are enclosed by
quotation marks.

KEYS Key names are written in capital letters.

File names, commands,
program code

File names, commands, coding samples and screen output are distin-
guished by their font.

Input Input to be entered by the user is displayed in italics.

Links Links that you can click are displayed in blue font.

"References" References to other parts of the documentation are enclosed by quota-
tion marks.

1.4 Notes on Screenshots

When describing the functions of the product, we use sample screenshots. These
screenshots are meant to illustrate as much as possible of the provided functions and
possible interdependencies between parameters. The shown values may not represent
realistic test situations.

The screenshots usually show a fully equipped product, that is: with all options instal-
led. Thus, some functions shown in the screenshots may not be available in your par-
ticular product configuration.

 

 

Typographical Conventions
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2 Welcome to the Avionics Options
The GBAS Option

The R&S SMBV-K111 is a firmware application that adds functionality to generate sig-
nals in accordance with the Ground Based Augmentation System (GBAS).

The most important R&S SMBV-K111 features at a glance:
● Generation of the VHF Data Broadcast (VDB) Signal-in-Space signal transmitted

from the Ground Based Augmentation System (GBAS) ground subsystem to the
airbone subsystem

● User-definable transmission band and support of single and multiple frequency
transmission (up to 11 frequency channels simultaneously), for example for adja-
cent channel emissions measurements

● Configuration of GBAS application data, for example the parameters of message
type 2 and 4, incl. the Final Approach Segment (FAS) data definition and Terminal
Area Path (TAP) data

● Import of differential Global Navigation Satellite System (GNSS) data (message
type 1 and 11)

● Encoding, timing and power settings according to the specification RTCA
DO-246D.

Realtime signal changes for the flight navigation standards ILS, VOR and DME

Changing a parameter in the standards will cause an instant signal change in the
R&S SMBV without a measurement cylcle to calculate the RMS value of the baseband
signal in order to set the correct RF level. If the standards are switched ON for the first
time, or after every subsequent ON/OFF sequence, the measurement cycle will take
place to determine the correct RF level. Every subsequent parameter change in the
standards will be performed without another measurement cycle in order to provide a
continous signal output.

The ILS Option

The R&S SMBV-K151 is a firmware application that adds functionality to generate sig-
nals in accordance with the the ground based instrument landing system (ILS). It pro-
vides lateral and vertical guidance to an aircraft approaching and landing on a runway.

The most important R&S SMBV-K151 features at a glance:
● Generation of glide slope, localizer and marker beacons signals
● Configuration of user definable carrier frequencies or selection of carrier frequen-

cies as defined by ICAO.
● Adjustable COM/ID settings.

The VOR Option

The R&S SMBV-K152 is a firmware application that adds functionality to generate sig-
nals in accordance with the VHF Omni Directional Radio Range radio navigation sys-

 



Welcome to the Avionics OptionsAvionics Standards

11Operating Manual 1176.8600.02 ─ 05

tem. It is used to determine the aircraft position by receiving radio signals from a net-
work of ground beacons.

The most important R&S SMBV-K152 features at a glance:
● Configuration of user definable carrier frequencies or selection of carrier frequen-

cies as defined by ICAO.
● User defined position settings.
● Adjustable COM/ID settings.

The DME Option

The R&S SMBV-K153 is a firmware application that adds functionality to generate sig-
nals in accordance with the distance measuring equipment (DME) for aircraft. It is used
to measure the slant range distance between the vessel and a fixed ground based sta-
tion.

The most important R&S SMBV-K153 features at a glance:
● Generation of DME interrogation and reply signals.
● Configuration of user definable carrier frequencies or selection of carrier frequen-

cies as defined by ICAO.
● Adjustable COM/ID settings.

This operating manual contains a description of the functionality that the application
provides, including remote control operation.

All functions not discussed in this manual are the same as in the base software and
are described in the R&S SMBV operating manual. The latest version is available for
download at the product homepage.

Installation

You can find detailed installation instructions in the delivery of the option or in the
R&S SMBV Service Manual.

2.1 Accessing the Avionics Dialog

To open the dialog with Avionics settings

► In the block diagram of the R&S SMBV, select "Baseband > Avionic Standards" >
"GBAS"/"ILS"/"DME"/ "VOR".

A dialog box opens that displays the provided general settings of the selected
standard.

The signal generation is not started immediately. To start signal generation with the
default settings, select "State > On".

 

Accessing the Avionics Dialog

http://www.rohde-schwarz.com/product/SMBV100a.html
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2.2 Scope

Tasks (in manual or remote operation) that are also performed in the base unit in the
same way are not described here.
In particular, this includes:
● Managing settings and data lists, i.e. storing and loading settings, creating and

accessing data lists, accessing files in a particular directory, etc.
● Information on regular trigger, marker and clock signals as well as filter settings, if

appropriate.
● General instrument configuration, such as configuring networks and remote opera-

tion
● Using the common status registers

For a description of such tasks, see the R&S SMBV operating manual.

 

Scope
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3 About the Avionics Options
The following topics summarize some background information on the related avionics
standards. The provided overview information is intended as explanation of the used
terms and does not aim to be comprehensive.

Brief overview of the avionics standards

● Landing systems: ILS (Instrument Landing System), MLS (Microwave Landing
System)
Landing systems are ground-based approach systems that provides precision
guidance to an aircraft approaching and (blind) landing on a runway.

● Radio/Flight navigation systems: VOR (VHF Omnidirectional Radio), DME (Dis-
tance measuring equipment), TACAN (Tactical Air Navigation), ADF (Automatic
Direction Finder)
The radio navigation systems are aircraft systems that support the pilots to deter-
mine the aircraft positions and stay on course. These systems are more and more
obsolete. However, due to security reasons, these flight navigation systems are still
in use.

● Radar systems: RSR (EnRoute Surveillance Radar), ASR (Airport Surveillance
Radar), PAR (Precision Approach Radar), ASDE (Airport Surface Detection Equip-
ment), SSR (Secondary Surveillance Radar)
Radar systems are divided into two groups, primary (RSR, ASR, PAR and ASDE)
and secondary (SSR). The radar systems are used in air traffic control to mainly
detects and measures the position of aircraft, i.e. its range and bearing.

3.1 The Ground Based Augmentation System (GBAS)

The R&S SMBV-K111 option enables you to define and configure the very high fre-
quency (VHF) Data Broadcast (VDB) Signal-in-Space transmitted from the Ground
Based Augmentation System (GBAS) ground subsystem to the airbone subsystem.
This implementation is in line with the specification RTCA DO-246D. The instrument
generates the GBAS signal at the physical layer and includes configuration of the
application data.

The GBAS is a ground based augmentation system that could among other things
enhance satellite navigation to provide a position estimation of less than one meter.
The GBAS is intended to improve aircraft safety and to enhance satellite navigation
and the full range of precision approach and landing procedures, as well as the termi-
nal area operations. GBAS could replace the Instrument Landing System (ILS) and the
Microwave Landing System (MLS) in many applications.

GBAS components

The illustration on figure 3-1 is a simplified representation of the GBAS three main
components:
● the GNSS satellite subsystem

 

 

The Ground Based Augmentation System (GBAS)
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● the airborne subsystem
● the GBAS ground subsystem.

The ground equipment consists of four reference GNSS receivers at exactly defined
positions around the airport, GBAS ground station, and a VHF data broadcast transmit-
ter (VDB).

Fig. 3-1: GBAS components and signals (simplified representation)

1 = GNSS reference receiver
2 = GBAS ground station
3 = VHF data broadcast (VDB) transmitter
a = GNSS navigation message
b = Pseudorange
c = GBAS Correction message
d = VDB signal

The GBAS GNSS reference receivers receive the GNSS navigation message, perform
pseudorange measurements and transmits this information to the GBAS ground sta-
tion. The GBAS ground station determines errors in the calculated positions, adds
additional parameters and approach path information, produces a GBAS correction
message and sends it the VDB transmitter. The VDB transmitter modulates and enco-
des this message and broadcasts it to the airbone GBAS equipment, for example a
GBAS receiver in the airplane. The GBAS equipment in the airplane is a high-precision
multimode receiver that evaluates the message and applies corrections parameters to
improve the navigation algorithms from GPS.

This list outlines the three signals transmitted between the components and are refer-
red as GBAS Signal-in-Space:
● GNSS satellite to GBAS ground subsystem navigation signal
● GNSS satellite to GBAS airbone subsystem navigation signal
● GBAS ground subsystem to GBAS airbone subsystem VHF data broadcast

The Ground Based Augmentation System (GBAS)
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This firmware option enables you to generate the VHF data broadcast

Carrier frequencies and frequency channels

The VHF data broadcast is defined for carrier frequencies within the range of 108.025
MHz to 117.975 MHz and carrier spacing of 25.0 kHz.

The R&S SMBV supports the whole requred frequency range; you can modulate the
VHF signal on any one of these carrier frequencies. Moreover, this firmware option
supports two frequency allocation modes, a single frequency and a multiple frequency
transmission.

Wenn you chose the frequency allocation mode, consider the follwoing:
● Single frequency mode is suitable to simulate the signal of up to eight VDB trans-

mitters modulated on the same carrier frequency.
The signal calculation is fast and optimized for time sensitive applications.
This mode is also the choice if the DUT or the analyzing equipment supports single
band decoding.

● Multiple frequency channels mode is suitable to allocate the VDB transmitters to
up to 8 out of 11 adjacent frequency channels.
The generated signal is optimized for reduced adjacent and co-channel interfer-
ence to neighboring systems. The setting time, however, increase significantly
compared to the single frequency mode.

The frequency related settings are split into several dialogs. To allocate the VDB in the
frequency domain, set the central frequency ("Status Bar > Frequency"), define the fre-
quency allocation mode ("GBAS > Multiple Frequency Channels") and use the VDB
transmitter configuration settings, see "Freq. Num" on page 28.

For step-by-step instruction, refer to chapter 9.1, "Generating GBAS Signals with Sev-
eral Frequency Channels", on page 97.

Broadcast timing structure

The broadcast is a Time Division Multiple Access (TDMA). According to [1], the TDMA
timing structure uses a two level hierarchy, composed of 500 ms long frames, each
divided into 8 VDB time slots (A - H), see figure 3-2.

The Ground Based Augmentation System (GBAS)
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Fig. 3-2: TDMA timing structure (simplified representation)

A VDB time slot is the minimum resource that an individual VDB transmitter can use.
During one time slot a VDB transmitter transmits exactly one bursts.

The GBAS specification RTCA DO-246D defines the TDMA timing structure, including
timing budget of the VDB bursts, burst data contents and message encoding in great
details. The R&S SMBV generates the required training sequence, encodes the mes-
sage according to RTCA DO-246D and applies the D8PSK modulation automatically,
so that you can concentrate on the configuration of the mandatory application data.
Optional application data defined in RTCA DO-246D is beyond the scope of this imple-
mentation.

To allocate the VDB in the time domain, use the scheduling settings, see chapter 4.3,
"Scheduling Settings", on page 30.

Refer to figure 3-3 for illustration on how a multi frequency TDMA scheduling is per-
formed in this implementation.
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Fig. 3-3: Example of a multi frequency TDMA scheduling

The Ground Based Augmentation System (GBAS)
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For step-by-step instruction, refer to chapter 9.3, "Generating a GBAS Signal for VDB
Slot Detection", on page 99.

Power settings

In the R&S SMBV, the following parameters have impact on the signal power of the
time slots:
● RF output power ("Status Bar > Level")

Defines the RMS level of the generated signal
● Relative power per time slot ("GABS > VDB Transmitters Configuration > VDB#

> Scheduling > Pow")
Sets the relative power of a VDB per time slot (TS).

● Power generation mode ("GBAS > Gated Power Mode")
Defines the way the absolute power of a VDB per time slot is calculated.
The absolute power of a single time slot depends on the power settings of the
remaining time slots.
See example "Calculating the power per time slot in "Gated Power Mode > Off""
on page 17 and example "Calculating the power per time slot in "Gated Power
Mode > On"" on page 18 for explanation on how the parameter "Gated Power
Mode" influence the calculation.

For step-by-step instruction, refer to chapter 9.2, "Generating a GBAS Signal for
Receiver Sensitivity Tests", on page 98.

Example: Calculating the power per time slot in "Gated Power Mode > Off"
● "Level = - 30 dBm"
● "TS1 > State > On", relative power "TS1 > Pow(dB) = 0 dB"
● "TS3 > State > On", relative power "TS3 > Pow(dB) = 0 dB"
● "TS2/TS4/TS5/TS6/TS7/TS8 > State > Off"

"TS2/TS4/TS5/TS6/TS7/TS8 > Pow(dB) = -inf"

The absolute power of both scheduled time slots is PTS1 = PTS3 = -24 dBm.

The Ground Based Augmentation System (GBAS)
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Example: Calculating the power per time slot in "Gated Power Mode > On"
● "Level = - 30 dBm"
● "TS1 > State > On", relative power "TS1 > Pow(dB) = 0 dB"
● "TS3 > State > On", relative power "TS3 > Pow(dB) = -3 dB"
● "TS2/TS4/TS5/TS6/TS7/TS8 > State > Off"

"TS2/TS4/TS5/TS6/TS7/TS8 > Pow(dB) = -inf"

The absolute power of the scheduled time slots is:
● PTS1 = -30 dBm

● PTS3 = -33 dBm.

Supported message types

The GBAS specification RTCA DO-246D defines the following mandatory message
types. This implementation supports all required message types. Refer totable 3-1 for
information on where to find the related settings.

Table 3-1: Overview of the required message types

Message Type Description Related settings

1 Differential Corrections

100 sec smoothed pseudor-
anges

chapter 4.4.3, "Differential GNSS Parame-
ters", on page 41

2 GBAS Related Data chapter 4.4.1, "Message Type 2 Parame-
ters", on page 31

4 Final Approach Segment
(FAS) Construction Data

"FAS Data Set" on page 35

 Terminal Area Path (TAP)
Construction Data

"TAP Data Set" on page 39

11 Differential Corrections

30 sec smoothed pseudor-
anges

chapter 4.4.3, "Differential GNSS Parame-
ters", on page 41

For step-by-step instruction, refer to chapter 9.4, "Generating a GBAS Signal for Mes-
sage Format Detection", on page 100.

The Ground Based Augmentation System (GBAS)



About the Avionics OptionsAvionics Standards

19Operating Manual 1176.8600.02 ─ 05

Rohde&Schwarz solution for radio analysis
If your task requires verifications and measurements of GBAS installations on the
ground and in the air, consider to use the R&S®EVS300 ILS/VOR analyzer.
This instrument is a portable level and modulation analyzer. If equipped with the
required options, it is capable to performe VHF data link measurements on GBAS as
well as measurements on conventional ILS ground systems and VOR systems.

3.2 The Instrument Landing System (ILS)

The instrument landing system is used during the landing approach and monitors the
correct approach path to the runway.

Fig. 3-4: Approach navigation using instrument landing system (ILS) [1MA193]

An ILS system consists of three independent subsystems:

● A glide slope for vertical guidance.
● A localizer for horizontal guidance.
● (optional) marker beacons

Glide Slope

The glide slope transmitter is located near the end of the runway (nearest to the start of
the aircraft approach).

Typically, vertically aligned antennas transmit two intersecting main beams on top of
one another at carrier frequencies between 329 MHz and 335 MHz. The top beam is
usually modulated at 90 Hz and the beam below at 150 Hz [1MA193].

The information on position is provided after demodulation of the beam signals by eval-
uating the difference in depth of modulation (DDM). The following scenarios are possi-
ble:

● Predominance of the 90 Hz beam: the aircraft is too high and must descend
● Predominance of the 150 Hz beam: the aircraft is too low and needs to climb
● The singal strength from both beams is equal: the aircraft is in the center, on the

right course.
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If there is a predominance of the 90 Hz beam, then the aircraft is too high and must
descend. A predominant 150 Hz means that the aircraft is too low and needs to climb.

Localizer

The localizer transmitter is located near the end of the runway (nearest to the start of
the aircraft approach). Typically, horizontally aligned antennas transmit two intersecting
main beams beside one another at carrier frequencies between 108 MHz and 112
MHz. As seen from the approaching aircraft coming in for a landing, the left beam is
usually modulated at 90 Hz and the right beam at 150 Hz.[1MA193]

The information on position is provided after demodulation of the beam signals by eval-
uating the difference in depth of modulation (DDM). The following scenarios are possi-
ble:

● Predominance of the 90 Hz beam: the aircraft is too far to the left and must turn to
the right

● Predominance of the 150 Hz beam: the aircraft is too far to the right and must turn
to the left

● The singal strength from both beams is equal: the aircraft is in the center, on the
right course.

Marker Beacons

Marker beacon (MB) receivers are used for a rough distance measurement. They are
available only for some ILS installations.[1MA193]

The Instrument Landing System (ILS)
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Fig. 3-5: Marker beacon placement with respect to runway

Marker beacon receivers decode audio and provide signaling output to identify one of
three marker beacons installed near the runway. They transmit a narrow beam width at
75 MHz carrier frequency in a vertical direction. Each of them has a different distinct
modulation code to allow the receiver to identify which one it is flying over.[1MA193]

Both visual (color of the marker beacon) and audio tone identification is supported for
determining which marker has been flown over. The audio/visual pairing of marker
beacons is as follows:

● Outer marker flashes BLUE in the cockpit at 400 Hz (“relaxed” tone).
● Middle marker flashes AMBER in the cockpit at 1300 Hz (“hurried” tone).
● Inner marker flashes WHITE in the cockpit at 3000 Hz (“urgent” tone).

3.3 VHF Omni Directional Radio Range (VOR)

Very high frequency (VHF) omnidirectional radio range (VOR) is used for radio naviga-
tion and helps aircrafts to determine their position and stay on course.

A VOR system consists of a ground transmission station and a VOR receiver on the
board of the aircraft.

The transmitter stations operate at VHF frequencies of 108 MHz to 118 MHz, with the
code identification (COM/ID) transmitting on a modulation tone of 1.020 kHz. It emitts
two type of signals:
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● An omnidirectional reference signal (REF) that can consist of two parts:
– 30 Hz frequency modulated (FM) sine wave on subcarrier 9.96 kHz from ampli-

tude modulation (AM) carrier
– 1020 Hz AM modulated sine wave morse code

● A directional positioning signal, variable (VAR): 30 Hz AM modulated sine waves
with variable phase shift

The position of the aircraft is determined by measuring azimuth as the difference in
phase of those two signals. The magnetic north is defined as the reference point, for
which both signals are exactly in phase.

3.4 Distance Measurement Equipment (DME)

DME is a radar system used to determine the slant distance of an aircraft (= DME inter-
rogator) to a ground station (= DME transponder). For this purpose, shaped RF double
pulses are transmitted by the aircraft to the ground station and, after a defined delay (=
reply delay), the ground station sends the pulses back again. The receiver in the air-
craft uses the round trip time of the double pulses to determine the distance to the
ground station.

Fig. 3-6: DME principle

Most DME ground stations are combined with a VOR system in order to allow an air-
craft to determine its precise position relative to this station. The DME channels are
paired with the VOR channels and range from 1025 MHz to 1150 MHz for the aircraft
transmitter and 962 MHz to 1213 MHz for the ground stations. The frequency delta
between received and transmitted signal is always 63 MHz. The channel spacing
between the various DME channels is always 1 MHz.

Each channel has two different codings (X and Y) that differ with regard to their pulse
spacing. The assignment of a channel and coding to a ground station always remains
the same during operation and is determined by the respective national ATC authority.
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Fig. 3-7: Time characteristic of DME signal envelope for X and Y channel

DME Interrogator

The aircraft's DME interrogator sends a sequence of pulses that are received at the
ground station and, after a defined delay time, are returned at a different frequency.
The frequency offset between the sent and received signal is always 63 MHz. The
receiver in the aircraft filters its own pulse sequence out of all received pulses and in
this way determines the time difference between the transmitted and received pulse. It
then uses this time to calculate the slant range to the ground station. The distance is
usually indicated in nautical miles (NM), where 1 NM corresponds to 1852.02 m and a
signal round trip time of 12.359 us. As a result, by taking the flight altitude above
ground as well as the azimuth angle between the aircraft and ground station (VOR sys-
tem) into consideration, it is possible to determine the precise position of the aircraft.

DME Transponder

In the receiver, the validity of all received pulses (i.e. the pulse spacing must be consis-
tent with the channel) is checked in the "decoder". A single pulse, for example, is fil-
tered out as an invalid interrogation and no reply to this pulse is sent.

After a valid DME double pulse is received (i.e. after the 2nd pulse is received), the
receiver at first does not react to any further interrogations for 60 us (= dead time) to
ensure that it does not trigger again to its own transmitted reply. The receiver is there-
fore not ready to process new interrogation pulses until the reply double pulse has
been fully transmitted. All pulse interrogations that are received at the DME ground sta-
tion during the dead time are not answered. This ensures that the gap between two
consecutive pulses is always at least 60 us.

A reply pulse is sent after a defined delay time after a valid interrogation pulse has
been received.

Distance Measurement Equipment (DME)
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4 GBAS Configuration and Settings
► To access the GBAS settings, select "Baseband > Avionics > GBAS".

The remote commands required to define these settings are described in chapter 10.2,
"GBAS Settings", on page 110.

4.1 General Settings

This dialog provides access to the default and the "Save/Recall" settings, as well as to
the general settings of the option and the dialogs with further cinfiguration settings. The
dialog dispalys an indication of the selected key parameters.

State
Activates the standard and deactivates all the other digital standards and digital modu-
lation modes in the same path.

Remote command: 
<subsystem>:STATe on page 108

Set To Default
Calls the default settings. The values of the main parameters are listed in chapter A.3,
"Default Settings", on page 199.

Remote command: 
<subsystem>:PRESet on page 108
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Save/Recall
Accesses the "Save/Recall" dialog, i.e. the standard instrument function for storing and
recalling the complete dialog related settings in a file. The provided navigation possibil-
ities in the dialog are self-explanatory.

The file name and the directory it is stored in are user-definable; the file extension is
however predefined.

Remote command: 
<subsystem>:SETTing:CATalog on page 108
<subsystem>:SETTing:STORe on page 109
<subsystem>:SETTing:STORe:FAST on page 109
<subsystem>:SETTing:LOAD on page 109
<subsystem>:SETTing:DELete on page 108

Data List Management
Accesses the "Data List Management" dialog. In this dialog you can create and edit a
data list.

The instrument stores all data lists as files with the predefined file extension
*.dm_iqd. You can define the file name and the directory they are stored in.

To use an existing data list as a data source,
● select "VDB Transmitters Configuration > VDB# > Data Source > Data List" and
● select "Data Config > Select Data List > navigate to the list file *.dm_iqd > Select".

Generate Waveform File
With enabled signal generation, triggers the instrument to store the current settings as
an ARB signal in a waveform file. Waveform files can be further processed by the ARB
and/or as a multi carrier or a multi segment signal.

The file name and the directory it is stored in are user-definable; the predefined file
extension for waveform files is *.wv.

Remote command: 
[:SOURce<hw>]:BB:GBAS:WAVeform:CREate on page 115

SCAT-I
Enables using of SCAT-I header information instead of the default LAAS (GBAS)
header.

The modulation and TDMA schemes of both systems are identical; the header start
byte is set as listed in table 4-1.
Table 4-1: Header start byte

Landing system Header start byte

LAAS (GBAS) 0xAAh

SCAT-I 0x99h

Remote command: 
[:SOURce<hw>]:BB:GBAS:SCATi on page 115

General Settings
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Multiple Frequency Channels
Enables the configuration of VHF Data Broadcast (VDB) transmissions on more than
one frequency channels.

See "Carrier frequencies and frequency channels" on page 15.

Remote command: 
[:SOURce<hw>]:BB:GBAS:MFCHannels on page 115

Gated Power Mode
Enables gated power mode, see "Power settings" on page 17.

Remote command: 
[:SOURce<hw>]:BB:GBAS:GPOW on page 116

Sample Rate Variation/Sample Rate Info
Sets/displays the used sample rate variation. You can set the sample rate value in the
"Filter/Clipping Settings" dialog.

This setting can be used for testing the symbol rate tolerance.

The RTCA DO-246D specification defines a symbol rate of the GBAS data broadcast
as 10500 symbols/sec. Because of the used modulation (see Modulation Type), each
symbol defines one of eight states. This results in a nominal bit rate of 31500 bits/s.

Remote command: 
[:SOURce<hw>]:BB:GBAS:MSET:SRATe? on page 138
[:SOURce<hw>]:BB:GBAS:SRINfo? on page 116

VDB Transmitters Configuration
Access the "VDB Transmitters Configuration" dialog, see chapter 4.2, "VDB Transmit-
ters Configuration Settings", on page 27.

Filter / Clipping
Access to the dialog for setting baseband filtering, clipping and modulation, see chap-
ter 4.5, "Filter/Clipping Settings", on page 42.

Trigger/Marker
Accesses the dialog for selecting the trigger source, for configuring the marker signals
and for setting the time delay of an external trigger signal, see chapter 8.1, "Trigger
Settings", on page 85 and chapter 8.2, "Marker Settings GBAS", on page 90.

The currently selected trigger source is displayed to the right of the button.

Execute Trigger
Executes trigger manually.

You can execute the trigger manually only if you select an internal trigger source and a
trigger mode other than "Auto".

Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:EXECute on page 183
[:SOURce<hw>]:BB:ILS:TRIGger:EXECute on page 183
[:SOURce<hw>]:BB:VOR:TRIGger:EXECute on page 183
[:SOURce<hw>]:BB:DME:TRIGger:EXECute on page 183
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Arm
For trigger modes "Armed Auto" and "Armed Retrigger", stops the signal generation
until subsequent trigger event occurs.

Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:ARM:EXECute on page 182
[:SOURce<hw>]:BB:ILS:TRIGger:ARM:EXECute on page 182
[:SOURce<hw>]:BB:VOR:TRIGger:ARM:EXECute on page 182
[:SOURce<hw>]:BB:DME:TRIGger:ARM:EXECute on page 182

Clock
Accesses the dialog for selecting the clock source, see "Clock" on page 27.

4.2 VDB Transmitters Configuration Settings

To access this dialog:

1. Select "GBAS > Main dialog > VDB Transmitters Configuration".

The dialog comprises the settings, necessary to configure the VHF Data Broadcast
(VDB) signals.
The graph visualizes 11 adjacent frequency channels, symmetrically located
around the current central frequency. To define the central frequency, set the
parameter "Status Bar > Frequency". In the graph, the central frequency is referred
as frequency number 0.
The frequency channel of the selected VDB is highlighted.

2. Select "VDB Transmitters Configuration > Append" to add new VDB transmitter.
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State
Enables the selected VHF Data Broadcast (VDB) transmitter.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:STATe on page 117

GBAS ID
Sets the GBAS ID, that is a four-character (24-bit) alphanumeric field that identifies the
ground station broadcasting the message. Permitted are capital letter, numbers and
"space".

To identify a ground station, the airbone receive examine the combination of the GBAS
ID and the SSID.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:GID on page 117

SSID
Sets the Station Slot Identifier SSID of the of the ground station.

According to RTCA DO-246D, the SSID is a numeric value from 0 to 7, corresponding
to the letter designation (A through H) of the first time slot assigned to a particular
ground reference station, where slot A = 0 and slot H = 7. All messages in all time slots
employed by a particular ground station use the same SSID.

To identify a ground station, the airbone receive examine the combination of the
"GBAS ID" on page 28 and the SSID.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SSID on page 117

Freq. Num
Sets the frequency number and defines the frequency band the corresponding VDB is
using, see "Carrier frequencies and frequency channels" on page 15.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:FNUMber on page 118

Data/Data Config
Select the data source for the VDB.

The following standard data sources are available:
● "All 0, All 1"

An internally generated sequence containing 0 data or 1 data.
● "PNxx"

An internally generated pseudo-random noise sequence.
● "Pattern"

An internally generated sequence according to a bit pattern.
Use the "Pattern" box to define the bit pattern.

● "Data List/Select DList"
A binary data from a data list, internally or externally generated.
Select "Select DList" to access the standard "Select List" dialog.
– Select the "Select Data List > navigate to the list file *.dm_iqd > Select" to

select an existing data list.

VDB Transmitters Configuration Settings
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– Use the "New" and "Edit" functions to create internally new data list or to edit
an existing one.

– Use the standard "File Manager" function to transfer external data lists to the
instrument.

See also "Main Dialog > Data List Management".

"Real GBAS Data"
Enables you to configure the content of the GBAS messages.
Select "Data Config > Config." to access the provided settings.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:DATA on page 118
[:SOURce<hw>]:BB:GBAS:VDB<ch>:DATA:DSELection on page 118
[:SOURce<hw>]:BB:GBAS:VDB<ch>:DATA:PATTern on page 119

App. Data Length/bytes
Sets the application data length.

For "Data/Data Config > Real GBAS Data" the value of the application data length is
not variable but is automatically set and calculated.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:DLENgth on page 118

No. of Frames
Displays the automatically calculated number of frames of the selected VDB.

Remote command: 
[:SOURce<hw>]:BB:GBAS:NOFRames? on page 119

Scheduling
Accesses the dialog for configuring the scheduling in the time domain, see chapter 4.3,
"Scheduling Settings", on page 30.

Append, Insert, Delete
You can configure up to 8 VDB transmitters. Use the appropriate general functions:

"Append" Adds a new row in the table of VDB transmitters.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB:APPend on page 116

"Insert" Adds a new row above the currently selected one.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:INSert on page 116

"Delete" Deletes the selected row.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:DELete on page 117
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4.3 Scheduling Settings

To access this dialog:

1. Select "GBAS > Main dialog > VDB Transmitters Configuration".

2. Select "VDB Transmitters Configuration > VDB# > Scheduling > Config"

The dialog comprises the settings, necessary to configure the time domain sched-
uling of the VDB transmitters on the selected frequency. The transmisson is based
on TDMA and hence on one particular frequency you can allocate only one VDB
transmitter per one time slot (TS).
For more information, see "Broadcast timing structure" on page 15.

TS0..TS7
Enables the VDB in the corresponding time slot (TS).

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:TS<st>:STATe on page 119

Pow(dB)
Sets the relative power of a VDB per time slot (TS).

See "Power settings" on page 17 for more information.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:TS<st>:POWer on page 119

4.4 Message Configuration Settings

To access this dialog:

1. Select "GBAS > Main dialog > VDB Transmitters Configuration".

2. Select "VDB Transmitters Configuration > VDB# > Data > Real GBAS Data"

3. Select "Data Config > Msg. Config".
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The dialog comprises the settings, necessary to configure the messages of each of
the VDB transmitters.

4. Select "Message Configuration > Message Type 2/4 > On" to enable configuration
of the particular message.

5. Select "Message Configuration > Differential GNSS > On" to enable the load of a
file containing differential GBAS settings.

4.4.1 Message Type 2 Parameters

The dialog comprises the parameters of message type 2, according to RTCA
DO-246D, Table 2.14.

Message type 2 carries information on the exact location for which the are referenced
as well as other GBAS related parameters.

Provided are the following settings:

Message Type 2
Enables you to configure the parameters of message type 2, according to RTCA
DO-246D, Table 2.14.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:MT2State on page 130
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Ground Station Reference Receivers
Selects the number of the GNSS reference receivers installed in this system.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:GSRReceivers on page 126

Ground Station Accuracy Designator
Selects the letter designator indicating the minimum signal-in-space accuracy perform-
ance provided by the ground station.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:GSADesignator on page 126

Ground Station Continuity/Integrity Designator
Selects the numerical designator that indicates the operational status of GBAS.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:GCID on page 125

Local Magnetic Variation
Sets the published local magnetic variation at the differential reference point. A positive
value represents an east variation (clockwise from true north).

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LMVariation on page 128

Sigma_vert_iono_gradient
Sets the parameter σvert_iono_gradient, that is the standard deviation of a normal distribu-
tion associated with the residual ionospheric uncertainty due to spatial decorrelation.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SVIGradient on page 134

Refractivity Index
Sets the estimated tropospheric refractivity index NR at the reference point

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RFINdex on page 131

Scale Height
Sets the parameter scale height (h0), used for scaling the tropospheric refractivity as a
function of differential altitude.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SHEight on page 133

Refractivity Uncertainty
Sets the parameter σN, that is the standard deviation of a normal distribution associ-
ated with the residual tropospheric uncertainty.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RUNCertainty on page 133
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Reference Location Configuration
The coordinates of the ground station reference point are defined in WGS84 coordi-
nates. In this coordinate system, a location is identified by three coordinates, the alti-
tude, the latitude and the longitude. The last two can be displayed in decimal or DMS
format. Use the parameter "Position Format" to select the display format.
Table 4-2: Reference location configuration

Parameter Description

"Position Format" Sets the format in which the Latitude and Longitude are displayed.
● "DEG:MIN:SEC"

The display format is Degree:Minute:Second and Direction, i.e.
XX°XX'XX.XX" Direction, where direction can be North/South and
East/West.

● "Decimal Degree"
The display format is decimal degree, i.e. +/-XX.XXXXX°, where "+"
indicates North and East and "-" indicates South and West.

"Altitude" Sets the altitude of the ground station reference point, that is the height above
the ellipsoid (HAE) altitude.

"Latitude" Sets the latitude of the ground station reference point.

"Longitude" Sets the longitude of the ground station reference point.

Remote command: 
to enter the coordinates in Degree:Minute:Second format
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LOCation:COORdinates:DMS
on page 129
to enter the coordinates in decimal degree format
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LOCation:COORdinates:
DECimal on page 129

4.4.2 Message Type 4 Parameters

To access this settings:

1. Select "GBAS > Main dialog > VDB Transmitters Configuration".

2. Select "VDB Transmitters Configuration > VDB# > Data > Real GBAS Data"

3. Select "Data Config > Msg. Config".

4. Select "Message Configuration > Message Type 4 > On"

5. Enable "FAS Data Set > On"

6. Enable "TAP Data Set > On"

The dialog comprises the parameters of message type 4, according to RTCA
DO-246D, Table 2.14.
According to the RTCA DO-246D, the Message Type 4 contains one or more data
sets that contain approach data, associated vertical/lateral alert limits, and/or the
Terminal Area Path (TAP). With the settings provided in this dialog, you can config-
ure the Final Approach Segment (FAS) data set, the TAP data set or both.
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Message Type 4
Enables you to configure the parameters of message type 4, according to RTCA
DO-246D, Table 2.18.
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Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:MT4State on page 130

FAS Data Set
Enables you to configure the parameters of the Final Approach Segment (FAS) data
set.

Provided are the parameters necessary to configure a single precision approach. The
FAS path is a line in space that defines the path an airplane follows on its final
approach. This line is defined by the Landing Threshold Point/Fictitious Threshold
Point (LTP/FTP), Flight Path Alignment Point (FPAP), Threshold Crossing Height
(TCH), and the Glide Path Angle (GPA).

The dialog displays also two graphs, a "Plan View" and a "Profile View", to visualize a
typical final approach path.
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Fig. 4-1: Final Approach Segment (FAS) diagram, according to RTCA DO-246D

LTP/FTP = Landing Threshold Point/Fictitious Threshold Point; point at the center of the landing runway,
defined by its WGS84 coordinates

GPIP = Glide Path Intercept Point; the point where the final approach path intercepts the local level
plane

FPAP = Flight Path Alignment Point; point at the end of the runway that in conjunction with the LTP/FTP
defines the geodesic plane of the precision final approach, landing and flight path.

TCH = Threshold Crossing Height
GAP = Glide Path Angle; angle at the TCH that describes the intended angle of descent at the final

approach path.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDSState on page 124

Plan View/Profile View Parameters ← FAS Data Set
The following parameters define the approach path (see also figure 4-1):

"Glide Path Angle"
Sets the angle of the FAS path (glide path) with respect to the hori-
zontal plane tangent to the WGS84 ellipsoid at the LTP/FTP.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:GPANgle on page 126

"TCH" Sets the threshold crossing height (TCH) , that is the height of the
FAS path above the LTP/FTP defined in either feet or meters.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:ATCHeight on page 120
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:ATUSelector on page 120

"LTP/FTP Height"
Sets the height of the LTP/FTP above the WGS84 ellipsoid.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LFLocation:HEIGht
on page 128
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Airport ID ← FAS Data Set
Sets the airport identification as three or four alphanumeric characters used to desig-
nate airport facilities. Permitted are upper letters, numbers and "space".

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:AID on page 120

Runway Number ← FAS Data Set
Sets the approach runway number.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RNUMber on page 132

Runway Letter ← FAS Data Set
Sets the runway letter, to distinguish between parallel runways. The conventional des-
ignation is used.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RLETter on page 131

Approach Performance Designator ← FAS Data Set
Sets the general information about the approach design. The conventional designation
is used.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:APDesignator on page 120

Route Indicator ← FAS Data Set
Sets the route indicator, that is a single alphabetic character used to differentiate
between multiple approaches to the same runway end. Allowed are the upper case let-
ters, excluding “I” and “O”, or the “space” character.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RUINdicator on page 133

Reference Path Data Selector ← FAS Data Set
Sets the reference path data selector (RPDS), that is a numerical identifier that is
unique on a frequency in the broadcast region and used to select the FAS.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RPDF on page 132

Reference Path ID ← FAS Data Set
Sets the reference path identifier as three or four alphanumeric characters used to des-
ignate the reference path.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RPIF on page 132

LTP/FTP Location Configuration ← FAS Data Set
The coordinates of the LTP/FTP are defined in WGS84 coordinates. In this coordinate
system, a location is identified by three coordinates, the altitude, the latitude and the
longitude. The last two can be displayed in decimal or DMS format. Use the parameter
"Position Format" to select the display format.
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Use the parameter LTP/FTP Height to define the altitude.
Table 4-3: LTP/FTP location configuration

Parameter Description

"Position Format" Sets the format in which the Latitude and Longitude are displayed.
● "DEG:MIN:SEC"

The display format is Degree:Minute:Second and Direction, i.e.
XX°XX'XX.XX" Direction, where direction can be North/South and
East/West.

● "Decimal Degree"
The display format is decimal degree, i.e. +/-XX.XXXXX°, where "+"
indicates North and East and "-" indicates South and West.

"Latitude" Sets the latitude of the LTP/FTP in arc seconds.

"Longitude" Sets the longitude of the LTP/FTP in arc seconds.

Remote command: 
to enter the coordinates in Degree:Minute:Second format
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LFLocation:COORdinates:DMS
on page 127
to enter the coordinates in decimal degree format
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LFLocation:COORdinates:
DECimal on page 126

Delta_FPAP Location Configuration ← FAS Data Set
The Delta FPAD (ΔFPAD) represents the difference of latitude/longitude of the runway
Flight Path Alignment Point (FPAP) from the LTP/FTP.

The Delta FPAD coordinates are defined in WGS84 coordinates. In this coordinate
system, a location is identified by three coordinates, the altitude, the latitude and the
longitude. The last two can be displayed in decimal or DMS format. Use the parameter
"Position Format" to select the display format.
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Table 4-4: Delta_FPAP location configuration

Parameter Description

"Position Format" Sets the format in which the Latitude and Longitude are displayed.
● "DEG:MIN:SEC"

The display format is Degree:Minute:Second and Direction, i.e.
XX°XX'XX.XX" Direction, where direction can be North/South and
East/West.

● "Decimal Degree"
The display format is decimal degree, i.e. +/-XX.XXXXX°, where "+"
indicates North and East and "-" indicates South and West.

"Latitude" Sets the difference of latitude of the FPAP in arc seconds.

Positive values indicate the FPAP latitude north of LTP/FTP latitude.

"Longitude" Sets the difference of longitude of the FPAP in arc seconds.

Positive values indicate the FPAP longitude east of LTP/FTP longitude.

Remote command: 
to enter the coordinates in Degree:Minute:Second format
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DFLocation:COORdinates:DMS
on page 121
to enter the coordinates in decimal degree format
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DFLocation:COORdinates:
DECimal on page 121

Course Width at Threshold ← FAS Data Set
Sets the lateral displacement from the path defined by the FAS at the LTP/FTP at
which full-scale course deviation indicator (CDI) deflection is attained.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:CWAThreshold on page 121

Delta_Length Offset ← FAS Data Set
Sets the parameter delta length (ΔLength) offset, that is the distance from the stop end
of the runway to the FPAP.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DLOFfset on page 124

FAS Vertical Alert Limit / Approach Status ← FAS Data Set
Sets the value of the broadcast vertical alert limit.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FVAA on page 125

FAS Lateral Alert Limit / Approach Status ← FAS Data Set
Sets the value of the broadcast lateral alert limit.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FLAA on page 124

TAP Data Set
Enables you to configure the parameters of the Terminal Area Path (TAP) data set.
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A TAP defines the initial fix (IF), track-to-fix (TF) and radius-to-fix (RF) legs and pro-
vides additional support for terminal area operations.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:TDSState on page 134

Reference Path Data Selector ← TAP Data Set
Sets the reference path data selector, that is a numerical identifier that is unique on a
frequency in the broadcast region and used to select the TAP.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RPDT on page 132

Reference Path ID ← TAP Data Set
Sets the reference path identifier as three or four alphanumeric characters used to des-
ignate the reference path.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RPIT on page 133

Number of Path Points - N ← TAP Data Set
Indicates the total number of path points included in this TAP.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:NOPPoint on page 131

Waypoint File ← TAP Data Set
Accesses the "Select Waypoint File" dialog to select predefined or user defined way-
point files.

A waypoint file is description of a moving scenario, like for example a sequence of
positions. A waypoint file must have the extension *.txt and file format as described
in chapter A.4.1, "Waypoint File Format", on page 202.
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Use the "Predefined Files" fuction, to load a predefined file.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:WAYPoint:PREDefined:
CATalog? on page 135
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:WAYPoint:USER:CATalog?
on page 135
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:WAYPoint:PREDefined:FILE
on page 135
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:WAYPoint:USER:FILE
on page 135
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:WAYPoint:FILE? on page 136

Predefined Files ← TAP Data Set
Access a list with predefined files.

FAS RPDS or Continuation Link ← TAP Data Set
Sets the FAS reference path data selector (RPDS) or the continuation link. Continua-
tion link is the RPDS for the next segment that is a continuation of the previous seg-
ment.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FRCLink on page 125

TAP Vertical Alert Limit / Status ← TAP Data Set
Sets the value of the broadcast vertical alert limit.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:TVAS on page 134

TAP Lateral Alert Limit / Status ← TAP Data Set
Sets the value of the broadcast lateral alert limit.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:TLAS on page 134

4.4.3 Differential GNSS Parameters

Differential GNSS is an approach that uses known GNSS reference locations to deter-
mine channel correction parameters. The retrieved information is transmitted to other
GNSS receivers to increase the accuracy of their position information.

To access this settings:

1. Select "GBAS > Main dialog > VDB Transmitters Configuration".

2. Select "VDB Transmitters Configuration > VDB# > Data > Real GBAS Data"

3. Select "Data Config > Msg. Config".

4. Select "Message Configuration > Differential GNSS > On".
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The dialog enables you to load a file with GBAS differential data. Per default, the
Correction1.rs_gbas file is used.

5. Select "GBAS Differential File" and load your user defined file.
Refer to chapter A.4.2, "GBAS Differential File Format", on page 203 for descrip-
tion of the required file format.

Differential GNSS
Enables the use of differential GNSS data.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:STATe on page 122

GBAS Differential File...
Accesses the "Select Proprietary File" dialog to select a file containing differential
GBAS information. The differential GBAS file must have the extension *.rs_gbas and
file format as described in chapter A.4.2, "GBAS Differential File Format",
on page 203.

Use the "Predefined Files" fuction, to load a predefined file.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:PREDefined:CATalog?
on page 123
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:USER:CATalog? on page 123
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:PREDefined:FILE
on page 123
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:USER:FILE on page 123
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:FILE? on page 124

Predefined Files
Access a list with predefined files.

4.5 Filter/Clipping Settings

To access this dialog:

1. Select "Main dialog > Multiple Frequency Channels > Off".
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2. Select "Main dialog > Filter/Clipping Settings".

The dialog comprises the settings, necessary to configure the baseband filter and
to enable clipping, as well as information on the applied modulation type and sam-
ple rate.

4.5.1 Filter Settings

Selection and configuration of baseband filter is enabled in single freqency mode, i.e.
"Multiple Frequency Channels > Off"

Provided are the following settings for configuring the baseband filter:

Filter
Selects the baseband filter.

Remote command: 
[:SOURce<hw>]:BB:GBAS:FILTer:TYPE on page 136

Roll Off Factor or BxT
Sets the filter parameter.

The filter parameter offered ("Roll Off Factor" or "BxT") depends on the currently
selected filter type. This parameter is preset to the default for each of the predefined
filters.

The Roll Off Factor affects the steepness of the filter flanks. A "Roll Off Factor" = 0
results in the steepest flanks; values near to 1 make the flanks more flat.
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Fig. 4-2: Example of the frequency response of a filter with different Roll Off Factors

Remote command: 
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:APCO25 on page 136
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:COSine on page 136
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:GAUSs on page 136
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:PGAuss on page 136
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:RCOSine on page 137
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:SPHase on page 137

Cut Off Frequency Factor
Sets the value for the cut off frequency factor. The cut off frequency of the filter can be
adjusted to reach spectrum mask requirements.

Remote command: 
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:LPASs on page 136
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:LPASSEVM on page 136

Cut Off Frequency Shift
(available for filter parameter Cosine only.)

The cut off frequency is a filter characteristic that defines the frequency at the 3 dB
down point. The "Cut Off Frequency Shift" affects this frequency in the way that the fil-
ter flanks are "moved" and the transition band increases by "Cut Off Frequency
Shift"*"Sample Rate".
● A "Cut Off Frequency Shift" = -1 results in a very narrow-band filter
● Increasing the value up to 1 makes the filter more broad-band
● By "Cut Off Frequency Shift" = 0, the -3 dB point is at the frequency determined by

the half of the selected "Sample Rate".
Tip: Use this parameter to adjust the cut off frequency and reach spectrum mask
requirements.
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Fig. 4-3: Example of the frequency response of a filter with different Cut Off Frequency Shift

Remote command: 
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:COSine:COFS on page 136

4.5.2 Modulation Settings

Provided are the following settings:

Modulation Type
According to the GBAS standard, symbols are converted to differentially-encoded 8
phase shift keyed (D8PSK) carrier phase shifts.

Remote command: 
[:SOURce<hw>]:BB:GBAS:MSET:MTYPe? on page 138

Sample Rate Variation/Sample Rate Info
Sets/displays the used sample rate variation. You can set the sample rate value in the
"Filter/Clipping Settings" dialog.

This setting can be used for testing the symbol rate tolerance.

The RTCA DO-246D specification defines a symbol rate of the GBAS data broadcast
as 10500 symbols/sec. Because of the used modulation (see Modulation Type), each
symbol defines one of eight states. This results in a nominal bit rate of 31500 bits/s.

Remote command: 
[:SOURce<hw>]:BB:GBAS:MSET:SRATe? on page 138
[:SOURce<hw>]:BB:GBAS:SRINfo? on page 116

4.5.3 Clipping Settings

Provided are the following settings:

Clipping State
Switches baseband clipping on and off.
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Baseband clipping is a very simple and effective way of reducing the crest factor of the
signal. Since clipping is done prior to filtering, the procedure does not influence the
spectrum. The EVM however increases.

Remote command: 
[:SOURce<hw>]:BB:GBAS:CLIPping:STATe on page 137

Clipping Level
Sets the limit for clipping.

This value indicates at what point the signal is clipped. It is specified as a percentage,
relative to the highest level. 100% indicates that clipping does not take place.

Remote command: 
[:SOURce<hw>]:BB:GBAS:CLIPping:LEVel on page 137

Clipping Mode
Selects the clipping method. A graphic illustration of the way in which these two meth-
ods work is given in the dialog.
● "Vector | i + jq |"

The limit is related to the amplitude | i + q |. The I and Q components are mapped
together, the angle is retained.

● "Scalar | i | , | q |"
The limit is related to the absolute maximum of all the I and Q values | i | + | q |.
The I and Q components are mapped separately, the angle changes.

Remote command: 
[:SOURce<hw>]:BB:GBAS:CLIPping:MODE on page 138

4.6 Global Settings

The buttons in this section lead to dialogs for general trigger, clock and mapping set-
tings.

Global Trigger/Clock Settings
Calls the "Global Trigger/Clock/Input Settings" dialog.

This dialog is used among other things for setting the trigger threshold, the input impe-
dance and the polarity of the clock and trigger inputs.

The parameters in this dialog affect all digital modulations and standards, and are
described in chapter "Global Trigger/Clock/Input Settings" in the Operating Manual.
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5 ILS Configuration and Settings
► To access this dialog select "Baseband Block > ILS".

5.1 General Settings

This dialog provides access to the general settings of the ILS standard, like enabling
the standard and selecting the ILS component.

Changing a parameter in the ILS standard will cause an instant signal change in the
R&S SMBV without a measurement cylcle to calculate the RMS value of the baseband
signal in order to set the correct RF level. If the standard is switched ON for the first
time, or after every subsequent ON/OFF sequence, the measurement cycle will take
place to determine the correct RF level. Every subsequent parameter change in the
ILS standard will be performed without another measurement cycle in order to provide
a continous signal output.

State
Activates the standard and deactivates all the other digital standards and digital modu-
lation modes in the same path.

Remote command: 
<subsystem>:STATe on page 108

Set To Default
Calls the default settings. The values of the main parameters are listed in chapter A.3,
"Default Settings", on page 199.

Remote command: 
<subsystem>:PRESet on page 108
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Save/Recall
Accesses the "Save/Recall" dialog, i.e. the standard instrument function for storing and
recalling the complete dialog related settings in a file. The provided navigation possibil-
ities in the dialog are self-explanatory.

The file name and the directory it is stored in are user-definable; the file extension is
however predefined.

Remote command: 
<subsystem>:SETTing:CATalog on page 108
<subsystem>:SETTing:STORe on page 109
<subsystem>:SETTing:STORe:FAST on page 109
<subsystem>:SETTing:LOAD on page 109
<subsystem>:SETTing:DELete on page 108

ILS Component
Selects the ILS component.

"Glide slope" Enables the glide slope.

"Localizer" Enables the localizer.

"Marker Beacons"
Enables the marker beacons.

Remote command: 
[:SOURce<hw>]:BB:ILS:TYPE on page 139

System Configuration
Accesses the "System Configuration" dialog, see:
● chapter 5.2, "System Configuration Settings - Glide Slope", on page 49 for the

glide slope settings
● chapter 5.3, "System Configuration Settings Localizer", on page 53 for the local-

izer settings
● chapter 5.4, "System Configuration Settings Marker Beacons", on page 60 for the

marker beacons settings

Trigger/Marker...
Accesses the dialog for selecting the trigger source, for configuring the marker signals
and for setting the time delay of an external trigger signal, see chapter 8.1, "Trigger
Settings", on page 85 .

The currently selected trigger source is displayed to the right of the button.

Execute Trigger
Executes trigger manually.

You can execute the trigger manually only if you select an internal trigger source and a
trigger mode other than "Auto".

Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:EXECute on page 183
[:SOURce<hw>]:BB:ILS:TRIGger:EXECute on page 183
[:SOURce<hw>]:BB:VOR:TRIGger:EXECute on page 183
[:SOURce<hw>]:BB:DME:TRIGger:EXECute on page 183
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Arm
For trigger modes "Armed Auto" and "Armed Retrigger", stops the signal generation
until subsequent trigger event occurs.

Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:ARM:EXECute on page 182
[:SOURce<hw>]:BB:ILS:TRIGger:ARM:EXECute on page 182
[:SOURce<hw>]:BB:VOR:TRIGger:ARM:EXECute on page 182
[:SOURce<hw>]:BB:DME:TRIGger:ARM:EXECute on page 182

Clock...
Accesses the dialog for selecting the clock source, see chapter 8.4, "Clock Settings",
on page 94.

5.2 System Configuration Settings - Glide Slope

To access this dialog:

1. Select "ILS Component > Glide slope".

2. Select "ILS > System Configuration".

5.2.1 Signal Settings

The dialog comprises the settings, necessary to configure the ILS Glide slope (ILS-GS)
modulation signal.

Carrier Frequency Mode
Sets the mode for the carrier frequency of the signal.

"User Defined" Activates user defined variation of the carrier frequency.
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"ICAO" Activates variation in predefined steps according to the standardized
ILS-GS transmitting frequencies (see chapter A.2.1, "ILS Channel
Frequencies", on page 195). The start value can be selected in the
field "ICAO Channel" below.
The selection is effective on both ILS modulations. A change to mod-
ulation ILS-GS automatically causes the RF frequency to be adapted
to the glide slope value which is coupled to the localizer setting (see
chapter A.2.1, "ILS Channel Frequencies", on page 195).

Remote command: 
[:SOURce<hw>]:BB:ILS:LOCalizer:FREQuency:MODE on page 150
[:SOURce<hw>]:BB:ILS[:GS|GSLope]:FREQuency:MODE on page 142

Carrier Frequency
Available only for "Carrier Frequency Mode > User Defined".

Sets the carrier frequency of the signal.

Remote command: 
[:SOURce<hw>]:BB:ILS[:GS|GSLope]:FREQuency on page 142

ICAO Channel
Available only for "Carrier Frequency Mode > ICAO".

Selects the ICAO channel and sets the corresponding transmitting frequency. The
ICAO channel settings for ILS-GS and ILS-LOC are coupled.

Refer to chapter A.2, "ICAO Channel Frequencies", on page 195 for an overview of
the standard defined ILS transmitting frequencies.

Remote command: 
[:SOURce<hw>]:BB:ILS:LOCalizer:ICAO:CHANnel on page 150
[:SOURce<hw>]:BB:ILS[:GS|GSLope]:ICAO:CHANnel on page 142

DDM Polarity
Defines the polarity for DDM calculation (see "DDM Depth" on page 52).

Remote command: 
[:SOURce<hw>]:BB:ILS[:GS|GSLope]:DDM:POLarity on page 141

Mode
Selects the operating mode for the ILS (ILS-GS) modulation signal.

"Norm" ILS-GS modulation is active.

"90 Hz" Amplitude modulation of the output signal with the upper lobe signal
component (90Hz signal content) of the ILS-GS signal.

The modulation depth of the 90-Hz signal results from the settings of
the parameters Sum of Depth (SDM) and DDM Depth according to:
● "Fly > Down"

AM(90 Hz) = 0.5 × (SDM + DDM × 100%)
● "Fly > Up"

AM(90 Hz) = 0.5 × (SDM - DDM × 100%)
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"150 Hz" Amplitude modulation of the output signal with the lower lobe signal
component (150-Hz signal content) of the ILS-GS signal.

The modulation depth of the 150-Hz signal results from the settings of
parameters Sum of Depth (SDM) and DDM Depth according to:
● "Fly > Down"

AM (150 Hz) = 0,5 × (SDM + DDM × 100%)
● "Fly > Up"

AM (150 Hz) = 0,5 × (SDM - DDM × 100%)

Remote command: 
[:SOURce<hw>]:BB:ILS[:GS|GSLope]:MODE on page 143

Up Frequency
Sets the modulation frequency of the upper antenna lobe.

Remote command: 
[:SOURce<hw>]:BB:ILS[:GS|GSLope]:ULOBe[:FREQuency] on page 144

Down Frequency
Sets the modulation frequency of the lower antenna lobe.

Remote command: 
[:SOURce<hw>]:BB:ILS[:GS|GSLope]:LLOBe[:FREQuency] on page 143

Up/Down Phase
Sets the phase between the modulation signals of the upper and lower antenna lobe.
The zero crossing of the lower lobe (150Hz) signal serves as a reference. The angle
refers to the period of the signal of the lower antenna lobe.

Remote command: 
[:SOURce<hw>]:BB:ILS[:GS|GSLope]:PHASe on page 143

5.2.2 Amplitude Settings

The dialog comprises the settings, necessary to configure the ILS-GS amplitude.
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Sum of Depth (SDM)
Sets the arithmetic sum of the modulation depths of the upper lobe (90Hz) and lower
lobe (150Hz) ILS-GS signal contents. The RMS modulation depth of the sum signal
depends on the phase setting of both modulation tones.

Remote command: 
[:SOURce<hw>]:BB:ILS[:GS|GSLope]:SDM on page 144

Fly
Selects the simulation mode for the ILS-GS modulation signal. A change of the setting
automatically changes the sign of the DDM value.

This setting simulates the direction in which the pilot has to correct the course.

"Up" The 150-Hz modulation signal is predominant, the DDM value is neg-
ative (the airplane is too low, it must climb).

"Down" The 90-Hz modulation signal is predominant, the DDM value is posi-
tive (the airplane is too high, it must descend).

Remote command: 
[:SOURce<hw>]:BB:ILS[:GS|GSLope]:DDM:DIRection on page 140

DDM Step
Selects the variation of the DDM values.

"Decimal" Decimal variation according to the current cursor position.

"Predifined" Variation in predefined steps according to the standardized DDM val-
ues.

Remote command: 
n.a.

DDM Current
Sets the current of the ILS indicating the instrument corresponding to the DDM value.
The instrument current is calculated according to:

DDM uA = DDM × 857,125 uA

A variation of the instrument current automatically leads to a variation of the DDM
value and the DDM value in dB.

Remote command: 
[:SOURce<hw>]:BB:ILS[:GS|GSLope]:DDM:CURRent on page 140

DDM Depth
Sets the difference in depth of modulation between the upper lobe (90Hz) and the
lower lobe (150Hz) tone of the ILS-GS modulation signal.

The DDM value is calculated with the formula:
● "DDM Polarity > 90 Hz - 150 Hz" (default setting):

DDM = [ AM(90 Hz) - AM (150 Hz) ] / 100%
● "DDM Polarity > 150 Hz - 90 Hz":

DDM = [ AM(150 Hz) - AM (90 Hz) ] / 100%
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A variation of the DDM value automatically leads to a variation of the value of the
instrument current and the DDM value in dB.

Remote command: 
[:SOURce<hw>]:BB:ILS[:GS|GSLope]:DDM:DEPTh on page 142

DDM Logarithmic
Sets the DDM value in dB. The dB value is calculated according to:

DDM dB = 20 × LOG [(SDM+DDM×100%) / (SDM-DDM×100%)]

A variation of the value automatically leads to a variation of the DDM value and the
instrument current.

Remote command: 
[:SOURce<hw>]:BB:ILS[:GS|GSLope]:DDM:LOGarithmic on page 141

DDM Percent
Sets the difference in depth of modulation between the upper lobe (90Hz) and the
lower lobe (150Hz) tone of the ILS-GS modulation signal.

The DDM value in percent is calculated as follows:
● "DDM Polarity > 90 Hz - 150 Hz" (default setting):

DDM = [ AM(90 Hz) - AM (150 Hz) ]
● "DDM Polarity > 150 Hz - 90 Hz":

DDM = [ AM(150 Hz) - AM (90 Hz) ]
A variation of the DDM value automatically leads to a variation of the value of the
instrument current and the DDM value in dB.

Remote command: 
[:SOURce<hw>]:BB:ILS[:GS|GSLope]:DDM:PCT on page 141

DDM - SDM Coupling
Selects if the DDM value is fixed or is changed with a change of sum of modulation
depths (SDM, see below).

"Fixed DDM" The absolute DDM values stays constant when the SDM is changed.

"Coupled to SDM"
The absolute DDM values changes when the SDM is changed. The
DDM value expressed in dB stays constant.

Remote command: 
[:SOURce<hw>]:BB:ILS[:GS|GSLope]:DDM:COUPling on page 140

5.3 System Configuration Settings Localizer

To access this dialog,

1. Select "ILS > ILS Component > Localizer".

2. Select "ILS > System Configuration"
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5.3.1 Signal Settings

The dialog comprises the settings, necessary to configure the ILS localizer (ILS-LOC)
modulation signal.

Carrier Frequency Mode
Sets the mode for the carrier frequency of the signal.

"User Defined" Activates user defined variation of the carrier frequency.

"ICAO" Activates variation in predefined steps according to the standardized
ILS-GS transmitting frequencies (see chapter A.2.1, "ILS Channel
Frequencies", on page 195). The start value can be selected in the
field "ICAO Channel" below.
The selection is effective on both ILS modulations. A change to mod-
ulation ILS-GS automatically causes the RF frequency to be adapted
to the glide slope value which is coupled to the localizer setting (see
chapter A.2.1, "ILS Channel Frequencies", on page 195).

Remote command: 
[:SOURce<hw>]:BB:ILS:LOCalizer:FREQuency:MODE on page 150
[:SOURce<hw>]:BB:ILS[:GS|GSLope]:FREQuency:MODE on page 142

Carrier Frequency
Available only for "Carrier Frequency Mode > User Defined".

Sets the carrier frequency of the signal.

Remote command: 
[:SOURce<hw>]:BB:ILS:LOCalizer:FREQuency on page 150

ICAO Channel
Available only for "Carrier Frequency Mode > ICAO".

Selects the ICAO channel and sets the corresponding transmitting frequency. The
ICAO channel settings for ILS-GS and ILS-LOC are coupled.

Remote command: 
[:SOURce<hw>]:BB:ILS:LOCalizer:ICAO:CHANnel on page 150

DDM polarity
Defines the polarity for DDM calculation (see "DDM Depth" on page 57).

Remote command: 
[:SOURce<hw>]:BB:ILS:LOCalizer:DDM:POLarity on page 149
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Mode
Selects the operating mode for the ILS-LOC modulation signal.

"Norm" ILS-LOC modulation is active.

"90 Hz" Amplitude modulation of the output signal with the left lobe (90Hz)
signal component of the ILS-LOC signal.

The modulation depth of the 90Hz signal results from the settings of
parameters Sum of Depth and DDM Depth according to:
● "Fly > Right"

AM(90 Hz) = 0,5 × (SDM + DDM × 100%)
● "Fly > Left"

AM(90 Hz) = 0,5 × (SDM - DDM × 100%)

"150 Hz" Amplitude modulation of the output signal with the right lobe (150Hz)
signal component of the ILS-LOC signal.

The modulation depth of the 150Hz signal results from the settings of
parameters Sum of Depth and DDM Depth according to:
● parameter "Fly" = "Right"

AM (150 Hz) = 0,5 × (SDM + DDM × 100%)
● parameter "Fly" = "Left"

AM (150 Hz) = 0,5 × (SDM - DDM × 100%)

Remote command: 
[:SOURce<hw>]:BB:ILS:LOCalizer:MODE on page 151

Left Frequency
Sets the modulation frequency of the antenna lobe arranged at the left viewed from the
air plane.

Remote command: 
[:SOURce<hw>]:BB:ILS:LOCalizer:LLOBe[:FREQuency] on page 150

Right Frequency
Sets the modulation frequency of the antenna lobe arranged at the right viewed from
the air plane.

Remote command: 
[:SOURce<hw>]:BB:ILS:LOCalizer:RLOBe[:FREQuency] on page 151

Left/Right Phase
Sets the phase between the modulation signals of the left and right antenna lobe. The
zero crossing of the right lobe (150Hz) signal serves as a reference. The angle refers
to the period of the signal of the right antenna lobe.

Remote command: 
[:SOURce<hw>]:BB:ILS:LOCalizer:PHASe on page 151

5.3.2 Amplitude Settings

The dialog comprises the settings, necessary to configure the ILS-LOC amplitude.
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Sum of Depth
Sets the arithmetic sum of the modulation depths of the left lobe (90Hz) and right lobe
(150Hz) ILS-LOC signal contents. The RMS modulation depth of the sum signal
depends on the phase setting of both modulation tones. The sum of "Sum of Depth"
on page 56 and "Depth" on page 59 must be smaller than 100 PCT.

Remote command: 
[:SOURce<hw>]:BB:ILS:LOCalizer:SDM on page 152

Fly
Selects the simulation mode for the ILS-LOC modulation signal. A change of the set-
ting automatically changes the sign of the DDM value.

This setting simulates the direction in which the pilot has to correct the course.

"Left" The 150-Hz modulation signal is predominant, the DDM value is neg-
ative (the airplane is too far to the right, it must turn to the left).

"Right" The 90-Hz modulation signal is predominant, the DDM value is posi-
tive (the airplane is too far to the left, it must turn to the right).

Remote command: 
[:SOURce<hw>]:BB:ILS:LOCalizer:DDM:DIRection on page 148

DDM Step
Selects the variation of the DDM values.

"Decimal" Decimal variation according to the current cursor position.

"Predifined" Variation in predefined steps according to the standardized DDM val-
ues.

Remote command: 
tbd

DDM Current
Sets the current of the ILS indicating instrument corresponding to the DDM value. The
instrument current is calculated according to:

DDM uA = DDM × 967.75 uA
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A variation of the instrument current automatically leads to a variation of the DDM
value and the DDM value in dB.

Remote command: 
[:SOURce<hw>]:BB:ILS:LOCalizer:DDM:CURRent on page 148

DDM Depth
Sets the difference in depth of modulation (DDM) between the signal of the left lobe
(90 Hz) and the right lobe (150 Hz) of the ILS-LOC modulation signal.

The DDM value in percent is calculated as follows:
● "DDM Polarity > 90 Hz - 150 Hz" (default setting):

DDM = [ AM(90 Hz) - AM (150 Hz) ] / 100%
● "DDM Polarity > 150 Hz - 90 Hz":

DDM = [ AM(150 Hz) - AM (90 Hz) ] / 100%
A variation of the DDM value automatically leads to a variation of the DDM value in dB
and the value of the instrument current.

Remote command: 
[:SOURce<hw>]:BB:ILS:LOCalizer:DDM:DEPTh on page 149

DDM Logarithmic
Sets the DDM value in dB. The dB value is calculated according to:

DDM dB = 20 × LOG [(SDM+DDM×100%) / (SDM-DDM×100%)]

A variation of the value automatically leads to a variation of the DDM value and the
instrument current.

Remote command: 
[:SOURce<hw>]:BB:ILS:LOCalizer:DDM:LOGarithmic on page 148

DDM Percent
Sets the difference in depth of modulation between the signal of the left lobe (90 Hz)
and the right lobe (150 Hz).

The DDM value in percent is calculated to formula:
● "DDM Polarity > 90 Hz - 150 Hz" (default setting):

DDM = [ AM(90 Hz) - AM (150 Hz) ]
● "DDM Polarity > 150 Hz - 90 Hz":

DDM = [ AM(150 Hz) - AM (90 Hz) ]
A variation of the DDM value automatically leads to a variation of the DDM value in dB
and the value of the instrument current.

Remote command: 
[:SOURce<hw>]:BB:ILS:LOCalizer:DDM:PCT on page 149

DDM - SDM Coupling
Selects if the DDM value is fixed or is changed with a change of sum of modulation
depths (SDM, see below).

"Fixed DDM" The absolute DDM values stays constant when the SDM is changed.
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"Coupled to
SDM"

The absolute DDM values changes when the SDM is changed. The
DDM value expressed in dB stays constant.

Remote command: 
[:SOURce<hw>]:BB:ILS:LOCalizer:DDM:COUPling on page 147

5.3.3 COM/ID Settings

The dialog comprises the settings, necessary to configure the COM/ID settings availa-
ble for the ILS-LOC modulation.

State
Enables/disables an additional communication/identification (COM/ID) signal.

Remote command: 
[:SOURce<hw>]:BB:ILS:LOCalizer:COMid[:STATe] on page 147

Show/Hide Details
Reveals the detailed setting options for the COM/ID signal.

Once the details are revealed, the labeling on the button changes to "Hide Details".
Use this to hide the detailed setting options display again.

Code
Sets the coding of the COM/ID signal by the international short name of the airport
(e.g. MUC for the Munich airport). If no coding is entered, the COM/ID tone is sent
uncoded (key down).

Remote command: 
[:SOURce<hw>]:BB:ILS:LOCalizer:COMid:CODE on page 145

Frequency
Sets the frequency of the COM/ID signal.

Remote command: 
[:SOURce<hw>]:BB:ILS:LOCalizer:COMid:FREQuency on page 146
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Period
Sets the period of the COM/ID signal in seconds.

Remote command: 
[:SOURce<hw>]:BB:ILS:LOCalizer:COMid:PERiod on page 146

Depth
Sets the AM modulation depth of the COM/ID signal.

Remote command: 
[:SOURce<hw>]:BB:ILS:LOCalizer:COMid:DEPTh on page 145

Time Schema
Sets the time schema for the COM/ID signal.
● "Standard"

The set dot length determines the length of the dash, the symbol space and letter
space.

● "User"
You can set each length value seperately.

Remote command: 
[:SOURce<hw>]:BB:ILS:LOCalizer:COMid:TSCHema on page 147

Dot Length
Sets the length of a Morse dot in seconds.

For "Time Schema > Standard" this value determines also the length of the dash
(3xDot length), symbol space (= Dot length) and letter space (3xDot length).

Remote command: 
[:SOURce<hw>]:BB:ILS:LOCalizer:COMid:DOT on page 146

Symbol Space
Available only for "Time Schema > User".

Sets the length of a symbol space in milliseconds.

Remote command: 
[:SOURce<hw>]:BB:ILS:LOCalizer:COMid:SYMBol on page 147

Dash Length
Available only for "Time Schema > User".

Sets the length of a Morse dash in milliseconds.

Remote command: 
[:SOURce<hw>]:BB:ILS:LOCalizer:COMid:DASH on page 145

Letter Space
Available only for "Time Schema > User".

Sets the length of a letter space in milliseconds.

Remote command: 
[:SOURce<hw>]:BB:ILS:LOCalizer:COMid:LETTer on page 146
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5.4 System Configuration Settings Marker Beacons

To access this dialog:

1. Select "ILS > ILS Component > Marker Beacons".

2. Select "System Configuration".

5.4.1 Signal Settings

This section covers the different signal settings available for the marker beacons mod-
ulation.

Carrier Frequency Mode
Sets the mode for the carrier frequency of the signal.

"User Defined" Activates user defined variation of the carrier frequency.

"Predefined" Activates variation in predefined steps according to the standardized
ILS transmitting frequencies .

Remote command: 
[:SOURce<hw>]:BB:ILS:MBEacon:FREQuency:MODE on page 155

Carrier Frequency
Available only for "Carrier Frequency Mode > User Defined".

Sets the carrier frequency of the signal.

Remote command: 
[:SOURce<hw>]:BB:ILS:MBEacon:FREQuency on page 155

Marker Frequency
Sets the modulation frequency of the marker signal.

Remote command: 
[:SOURce<hw>]:BB:ILS:MBEacon:MARKer:FREQuency on page 155

Marker Depth
Sets the modulation depth of the marker signal.

Remote command: 
[:SOURce<hw>]:BB:ILS:MBEacon[:MARKer]:DEPTh on page 155
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5.4.2 COM/ID Settings

The dialog comprises the settings, necessary to configure the COM/ID settings availa-
ble for the ILS marker beacon modulation.

State
Enables/disables an additional communication/identification (COM/ID) signal.

Remote command: 
[:SOURce<hw>]:BB:ILS:MBEacon:COMid[:STATe] on page 155

Show/Hide Details
Reveals the detailed setting options for the COM/ID signal.

Once the details are revealed, the labeling on the button changes to "Hide Details".
Use this to hide the detailed setting options display again.

Code
Sets the coding of the COM/ID signal by the international short name of the airport
(e.g. MUC for the Munich airport). If no coding is entered, the COM/ID tone is sent
uncoded (key down).

Remote command: 
[:SOURce<hw>]:BB:ILS:MBEacon:COMid:CODE on page 152

Frequency
Sets the frequency of the COM/ID signal.

Remote command: 
[:SOURce<hw>]:BB:ILS:MBEacon:COMid:FREQuency on page 153

Period
Sets the period of the COM/ID signal in seconds.

Remote command: 
[:SOURce<hw>]:BB:ILS:MBEacon:COMid:PERiod on page 154

Depth
Sets the AM modulation depth of the COM/ID signal.

Remote command: 
[:SOURce<hw>]:BB:ILS:MBEacon:COMid:DEPTh on page 153
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Time Schema
Sets the time schema for the COM/ID signal.
● "Standard"

The set dot length determines the length of the dash, the symbol space and letter
space.

● "User"
You can set each length value seperately.

Remote command: 
[:SOURce<hw>]:BB:ILS:MBEacon:COMid:TSCHema on page 154

Dot Length
Sets the length of a Morse dot in seconds.

For "Time Schema > Standard" this value determines also the length of the dash
(3xDot length), symbol space (= Dot length) and letter space (3xDot length).

Remote command: 
[:SOURce<hw>]:BB:ILS:MBEacon:COMid:DOT on page 153

Dash Length
Available only for "Time Schema > User".

Sets the length of a Morse dash in milliseconds.

Symbol Space
Available only for "Time Schema > User".

Sets the length of a symbol space in milliseconds.

Remote command: 
[:SOURce<hw>]:BB:ILS:MBEacon:COMid:SYMBol on page 154

Letter Space
Available only for "Time Schema > User".

Sets the length of a letter space in milliseconds.

Remote command: 
[:SOURce<hw>]:BB:ILS:MBEacon:COMid:LETTer on page 153
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6 VOR Configuration and Settings
► To access this dialog select "Baseband Block > VOR".

This section contains information about the VOR configuration settings.

6.1 General Settings

This dialog provides access to the general settings of the VOR standard.

Changing a parameter in the VOR standard will cause an instant signal change in the
R&S SMBV without a measurement cylcle to calculate the RMS value of the baseband
signal in order to set the correct RF level. If the standard is switched ON for the first
time, or after every subsequent ON/OFF sequence, the measurement cycle will take
place to determine the correct RF level. Every subsequent parameter change in the
VOR standard will be performed without another measurement cycle in order to pro-
vide a continous signal output.

State
Activates the standard and deactivates all the other digital standards and digital modu-
lation modes in the same path.

Remote command: 
<subsystem>:STATe on page 108

Set To Default
Calls the default settings. The values of the main parameters are listed in chapter A.3,
"Default Settings", on page 199.

Remote command: 
<subsystem>:PRESet on page 108

Save/Recall
Accesses the "Save/Recall" dialog, i.e. the standard instrument function for storing and
recalling the complete dialog related settings in a file. The provided navigation possibil-
ities in the dialog are self-explanatory.
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The file name and the directory it is stored in are user-definable; the file extension is
however predefined.

Remote command: 
<subsystem>:SETTing:CATalog on page 108
<subsystem>:SETTing:STORe on page 109
<subsystem>:SETTing:STORe:FAST on page 109
<subsystem>:SETTing:LOAD on page 109
<subsystem>:SETTing:DELete on page 108

System Configuration
Accesses the "System Configuration" dialog for configuration of the VOR modulation,
see chapter 6.2, "System Configuration Settings", on page 65.

Trigger/Marker...
Accesses the dialog for selecting the trigger source, for configuring the marker signals
and for setting the time delay of an external trigger signal, see chapter 8.1, "Trigger
Settings", on page 85 .

The currently selected trigger source is displayed to the right of the button.

Execute Trigger
Executes trigger manually.

You can execute the trigger manually only if you select an internal trigger source and a
trigger mode other than "Auto".

Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:EXECute on page 183
[:SOURce<hw>]:BB:ILS:TRIGger:EXECute on page 183
[:SOURce<hw>]:BB:VOR:TRIGger:EXECute on page 183
[:SOURce<hw>]:BB:DME:TRIGger:EXECute on page 183

Arm
For trigger modes "Armed Auto" and "Armed Retrigger", stops the signal generation
until subsequent trigger event occurs.

Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:ARM:EXECute on page 182
[:SOURce<hw>]:BB:ILS:TRIGger:ARM:EXECute on page 182
[:SOURce<hw>]:BB:VOR:TRIGger:ARM:EXECute on page 182
[:SOURce<hw>]:BB:DME:TRIGger:ARM:EXECute on page 182

Clock...
Accesses the dialog for selecting the clock source, see chapter 8.4, "Clock Settings",
on page 94.

General Settings



VOR Configuration and SettingsAvionics Standards

65Operating Manual 1176.8600.02 ─ 05

6.2 System Configuration Settings

To access this dialog:

► Select "VOR > System Configuration".

6.2.1 Signal Settings

The dialog comprises the settings, necessary to configure the VOR modulation signal.

Carrier Frequency Mode
Sets the mode for the carrier frequency of the signal.

"User Defined" Activates user defined variation of the carrier frequency.

"ICAO" Activates variation in predefined steps according to the standardized
VOR transmitting frequencies (see chapter A.2.2, "VOR Channel Fre-
quencies ", on page 195). The start value can be selected in the field
"ICAO Channel".

Remote command: 
[:SOURce<hw>]:BB:VOR:FREQuency:MODE on page 158

Carrier Frequency
Available only for "Carrier Frequency Mode > User Defined".

Sets the carrier frequency of the signal.

Remote command: 
[:SOURce<hw>]:BB:VOR:FREQuency on page 158

ICAO Channel
Available only for "Carrier Frequency Mode > ICAO".

Selects the ICAO channel and the corresponding transmitting frequency. Refer to
chapter A.2.2, "VOR Channel Frequencies ", on page 195 for an overview of the
standard defined VOR transmitting frequencies.

Remote command: 
[:SOURce<hw>]:BB:VOR:ICAO:CHANnel on page 158

 

 

System Configuration Settings



VOR Configuration and SettingsAvionics Standards

66Operating Manual 1176.8600.02 ─ 05

Mode
Selects the operating mode for the VOR modulation signal.

"Norm" VOR modulation is active.

"Var" Amplitude modulation of the output signal with the VAR signal com-
ponent (30Hz signal content) of the VOR signal. The modulation
depth corresponds to the value set under "VAR Depth".

"Subcarrier" Amplitude modulation of the output signal with the unmodulated FM
carrier (9960Hz) of the VOR signal. The modulation depth corre-
sponds to the value set under "Subcarrier Depth".

"Subcarrier +
FM"

Amplitude modulation of the output signal with the frequency-modula-
ted FM carrier (9960Hz) of the VOR signal. The frequency deviation
corresponds to the value set under "REF Deviation", the modulation
depth corresponds to the value set under "Subcarrier Depth".

Remote command: 
[:SOURce<hw>]:BB:VOR:MODE on page 156

VAR/REF Frequency
Sets the frequency of the VAR signal and the REF signal. As the two signals must
have the same frequency, the setting is valid for both signals.

Remote command: 
[:SOURce<hw>]:BB:VOR:VAR:FREQuency on page 160

VAR Depth
Sets the AM modulation depth of the 30Hz VAR signal.

Note: The sum of "Subcarrier depth", "VAR depth" and "COM/ID > Depth" must be
smaller than 100 %.

Remote command: 
[:SOURce<hw>]:BB:VOR:VAR:DEPTh on page 160

Subcarrier Frequency
Sets the frequency of the FM carrier.

Remote command: 
[:SOURce<hw>]:BB:VOR:SUBCarrier[:FREQuency] on page 160

Subcarrier Depth
Sets the AM modulation depth of the FM carrier.

Note: The sum of "Subcarrier depth", "VAR depth" and "COM/ID > Depth" must be
smaller than 100 %.

Remote command: 
[:SOURce<hw>]:BB:VOR:SUBCarrier:DEPTh on page 159

6.2.2 Position Settings

The dialog comprises the settings, necessary to configure the different position settings
available for the VOR modulation.
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Bearing Angle
Sets the phase angle between the 30Hz VAR signal and the 30Hz reference signal.
The orientation of the angle depends on the selected "Direction".

Remote command: 
[:SOURce<hw>]:BB:VOR:BANGle on page 160

Direction
Sets the reference position of the phase information. The angle set under "Bearing
Angle" corresponds to the angle between the geographic north and the connection line
from beacon to airplane.

"From" Selection of the beacon as a reference position.

"To" Selection of the airplane position as a reference position.

Remote command: 
[:SOURce<hw>]:BB:VOR:BANGle:DIRection on page 161

6.2.3 COM/ID Settings

The dialog comprises the settings, necessary to configure the COM/ID settings availa-
ble for the VOR modulation.

State
Enables/disables an additional communication/identification (COM/ID) signal.

Remote command: 
[:SOURce<hw>]:BB:VOR:COMid[:STATe] on page 163

Show/Hide Details
Reveals the detailed setting options for the COM/ID signal.

Once the details are revealed, the labeling on the button changes to "Hide Details".
Use this to hide the detailed setting options display again.
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Code
Sets the coding of the COM/ID signal by the international short name of the airport
(e.g. MUC for the Munich airport). If no coding is entered, the COM/ID tone is sent
uncoded (key down).

Remote command: 
[:SOURce<hw>]:BB:VOR:COMid:CODE on page 161

Frequency
Sets the frequency of the COM/ID signal.

Remote command: 
[:SOURce<hw>]:BB:VOR:COMid:FREQuency on page 162

Period
Sets the period of the COM/ID signal in seconds.

Remote command: 
[:SOURce<hw>]:BB:VOR:COMid:PERiod on page 163

Depth
Sets the AM modulation depth of the COM/ID signal.

Note: The sum of "Subcarrier depth", "VAR depth" and "COM/ID > Depth" must be
smaller than 100 %.

Remote command: 
[:SOURce<hw>]:BB:VOR:COMid:DEPTh on page 162

Time Schema
Sets the time schema for the COM/ID signal.
● "Standard"

The set dot length determines the length of the dash, the symbol space and letter
space.

● "User"
You can set each length value seperately.

Remote command: 
[:SOURce<hw>]:BB:VOR:COMid:TSCHema on page 163

Dot Length
Sets the length of a Morse dot in seconds.

For "Time Schema > Standard" this value determines also the length of the dash
(3xDot length), symbol space (= Dot length) and letter space (3xDot length).

Remote command: 
[:SOURce<hw>]:BB:VOR:COMid:DOT on page 162

Dash Length
Available only for "Time Schema > User".

Sets the length of a Morse dash in milliseconds.
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Symbol Space
Available only for "Time Schema > User".

Sets the length of a symbol space in milliseconds.

Remote command: 
[:SOURce<hw>]:BB:VOR:COMid:SYMBol on page 163

Letter Space
Available only for "Time Schema > User".

Sets the length of a letter space in milliseconds.

Remote command: 
[:SOURce<hw>]:BB:VOR:COMid:LETTer on page 162
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7 DME Configuration and Settings
► To access this dialog select "Baseband Block > DME".

7.1 General Settings

This dialog provides access to the general settings of the DME standard, like enabling
the standard and selecting the DME mode.

Changing a parameter in the DME standard will cause an instant signal change in the
R&S SMBV without a measurement cylcle to calculate the RMS value of the baseband
signal in order to set the correct RF level. If the standard is switched ON for the first
time, or after every subsequent ON/OFF sequence, the measurement cycle will take
place to determine the correct RF level. Every subsequent parameter change in the
DME standard will be performed without another measurement cycle in order to pro-
vide a continous signal output.

State
Activates the standard and deactivates all the other digital standards and digital modu-
lation modes in the same path.

Remote command: 
<subsystem>:STATe on page 108

Set To Default
Calls the default settings. The values of the main parameters are listed in chapter A.3,
"Default Settings", on page 199.

Remote command: 
<subsystem>:PRESet on page 108

Save/Recall
Accesses the "Save/Recall" dialog, i.e. the standard instrument function for storing and
recalling the complete dialog related settings in a file. The provided navigation possibil-
ities in the dialog are self-explanatory.
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The file name and the directory it is stored in are user-definable; the file extension is
however predefined.

Remote command: 
<subsystem>:SETTing:CATalog on page 108
<subsystem>:SETTing:STORe on page 109
<subsystem>:SETTing:STORe:FAST on page 109
<subsystem>:SETTing:LOAD on page 109
<subsystem>:SETTing:DELete on page 108

DME Mode
Selects the DME modulation mode. The mode determines the signal type that is simu-
lated. The exact timing of the signal for each mode is determined by the selected X or
Y channel.

The timing and shape of the pulses can be freely selected. By default these values are
set according to the standard.

"Interrogation" The interrogation signal of the airborne transmitter is simulated.

"Reply" The reply signal of the ground based transponder is simulated.
The trigger is automatically set to external and the default trigger
delay either to 50 µs (channel X) or 56 µs (channel Y) depending on
the selected channel.
The interval between the pulse pairs can be set to a fixed value (rep-
etition rate) or to random generation (pulse squitter).

Remote command: 
[:SOURce<hw>]:BB:DME:MODE on page 164

System Configuration
Accesses the "System Configuration" dialog for configuration of the interrogation or
reply modulation, see chapter 7.2, "System Configuration Settings", on page 72.

Trigger/Marker...
Accesses the dialog for selecting the trigger source, for configuring the marker signals
and for setting the time delay of an external trigger signal, see chapter 8.1, "Trigger
Settings", on page 85 .

The currently selected trigger source is displayed to the right of the button.

Execute Trigger
Executes trigger manually.

You can execute the trigger manually only if you select an internal trigger source and a
trigger mode other than "Auto".

Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:EXECute on page 183
[:SOURce<hw>]:BB:ILS:TRIGger:EXECute on page 183
[:SOURce<hw>]:BB:VOR:TRIGger:EXECute on page 183
[:SOURce<hw>]:BB:DME:TRIGger:EXECute on page 183
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Arm
For trigger modes "Armed Auto" and "Armed Retrigger", stops the signal generation
until subsequent trigger event occurs.

Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:ARM:EXECute on page 182
[:SOURce<hw>]:BB:ILS:TRIGger:ARM:EXECute on page 182
[:SOURce<hw>]:BB:VOR:TRIGger:ARM:EXECute on page 182
[:SOURce<hw>]:BB:DME:TRIGger:ARM:EXECute on page 182

Clock...
Accesses the dialog for selecting the clock source, see chapter 8.4, "Clock Settings",
on page 94.

7.2 System Configuration Settings

To access this dialog:

1. Select "DME > DME Mode > Interrogation".

2. Select "System Configuration".

7.2.1 Signal Settings

The dialog comprises the settings, necessary to configure the DME modulation signal.

Signal settings for "DME Mode > Interrogation"

Signal settings for "DME Mode > Reply"

Channel Mode
Selects the channel that is simulated.

Standard compliant X and Y channels differ in the spacing between the two pulses of
the pulse pair and the reply delay of the ground station (see chapter A.2.3, "DME
Channel Frequencies", on page 196). ICAO indicates the ICAO channel parameters
below for selecting the correct channel.
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Table 7-1: Pulse spacing and reply delay

Channel Pulse spacing

interrogation
mode

Pulse spacing

reply mode

Reply delay

1st pulse

Reply delay

2nd pulse

X 12 µs 12 µs 50 µs 50 µs

Y 36 µs 30 µs 56 µs 50 µs

Remote command: 
[:SOURce<hw>]:BB:DME:CSUFfix on page 165

Carrier Frequency
Available only for "Channel Mode > X Channel"/ "Channel Mode > Y Channel".

Sets the carrier frequency of the signal.

Remote command: 
[:SOURce<hw>]:BB:DME:FREQuency on page 166

ICAO Channel
Available only for "Channel Mode > ICAO".

Selects the corresponding channel as indicated by ICAO. Refer to chapter A.2.3, "DME
Channel Frequencies", on page 196 for an overview of the standard defined DME
transmitting frequencies.

Remote command: 
[:SOURce<hw>]:BB:DME:ICAO:CHANnel on page 166

Range Distance
Available only for "DME Mode > Reply".

Sets the simulated distance between the interrogator and the transponder for reply
mode. The distance can be given in nautic miles (NM) or µs. 1 nm is 1852.01 meters
and corresponds to a run time of 12.359 µs.

The range distance and the external trigger delay are dependent according to:

"Range Distance" = ("Trigger Delay" – X/Y mode delay)/12.359 µs/nm, where

X mode delay = 50 µs, Y mode delay = 56 µs

Changing one value automatically changes the other value.

Remote command: 
[:SOURce<hw>]:BB:DME:RDIStance on page 168
[:SOURce<hw>]:BB:DME:RDIStance:UNIT on page 169

Pulse Squitter
Enables/disables squitter pulses.
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Squitter pulses are random pulse pairs sent by a ground station if the average transmit
pulse rate drops to values between 700 pulse pairs per second (pp/s). The squitter pul-
ses ensure that a minimum pulse rate is provided which is cruical for the proper moni-
toring and adjustment of important pulse paramaters of the ground station.

Remote command: 
[:SOURce<hw>]:BB:DME:SQUitter on page 170

Pulse Repetition Rate
Sets the number of DME pulse pairs per second.

Remote command: 
[:SOURce<hw>]:BB:DME:RATE on page 168

Reply Efficiency
Available only for "DME Mode > Reply".

Sets the relation between reply pulse pairs and received trigger signals, e.g. with a set
efficiency of 50% only every second trigger event leads to the generation of a reply
pulse pair.

Remote command: 
[:SOURce<hw>]:BB:DME:ANALysis:EFFiciency? on page 173

Pulse Input
Opens a dialog for configuration of the pulse input settings.

Input Source ← Pulse Input
Selects the input of the DME pulses. In case "DME Mode >Interrogation" the setting
selects the input for the reply pulses of a ground station, while for "DME Mode > Reply"
the input of the interogation pulses of an airplane is choosen.

"Ext Triggered"
The pulses are received via the backward TRIG connector. Please
make sure that only the demodulated pulse envelope is input at this
connector. If a modulated RF signal is applied, use the "Ext Power
Sensor" mode.

"Ext Power Sensor"
The R&S NRP-Z81 power sensor as an input for modulated RF pul-
ses. An external DME signal is fed into a sensor. The 50% voltage
point of this signal is used by the R&S NRP-Z81 power sensor sensor
to generate the trigger for the R&S SMBV.

Remote command: 
[:SOURce<hw>]:BB:DME:PINPut:SOURce on page 170
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Reply Delay ← Pulse Input
Sets the delay between the external trigger and the first DME output pulse (50% volt-
age point of first pulse).

For DME Reply mode this simulates the defined delay of the DME transponder and
twice the run time of the signal (from interrogator to transponder and back). The delay
is a measure of the range distance, thus, the two values are interdependent according
to:

Delay = X/Y mode delay + range distance * 12.359 nm/µs, where

X mode delay = 50 us, Y mode delay = 56 us

Changing one value automatically changes the other value.

Remote command: 
[:SOURce<hw>]:BB:DME:PINPut:DELay on page 171

Search Trigger Level ← Pulse Input
Available only for "Trigger Mode > Ext Power Sensor".

Determines the trigger level = 50% voltage point of first pulse of the external DME
interrogation signal.

After connecting the R&S NRP-Z81 sensor to the external interrogation signal source,
"Search Trigger Level" determines the trigger point. The search function has to be exe-
cuted with each change of the level of the external DME signal.

Remote command: 
[:SOURce<hw>]:BB:DME:PINPut:TRIGger:SEARch? on page 172

7.2.2 Pulse Settings

The dialog comprises the settings, necessary to configure the pulse settings available
for DME interrogation.

Pulse Shape
Selects the pulse shape.

"Cos^2" The falling and the rising edge of the pulse are cos^2 shaped.

"Cos Cos^2" The rising edge is cos shaped and the falling edge is cos^2 shaped.

"Linear" The falling and the rising edge of the pulse are linear shaped.

"Gauss" The pulse has a gaussian form.

Remote command: 
[:SOURce<hw>]:BB:DME:SHAPe on page 169
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Pulse Rise
Sets the rise time of the pulse (10% to 90% of the peak voltage).

Remote command: 
[:SOURce<hw>]:BB:DME:RISE on page 169

Pulse Width
Sets the pulse width (50% to 50% of peak voltage).

Remote command: 
[:SOURce<hw>]:BB:DME:WIDTh on page 172

Pulse Fall
Sets the fall time of the pulse (90% to 10% of peak voltage).

Remote command: 
[:SOURce<hw>]:BB:DME:FALL on page 165

Pulse Spacing
Sets the spacing between the first and second pulse of a pulse pair (the time between
the half-voltage points on the leading edge of each pulse).

Remote command: 
[:SOURce<hw>]:BB:DME:PPS on page 167

Single Pulse
Activates/deactivates generation of a single test pulse.

Remote command: 
[:SOURce<hw>]:BB:DME:SINGle on page 170

DME Analysis
Available only for "DME Mode > Interrogation".

Accesses the "DME Analysis" dialog.

For a description of the available settings, refer to chapter 7.2.4, "DME Analysis",
on page 77.

7.2.3 Receive Settings

The dialog comprises the settings, necessary to configure the receiving of the pulse.

Pulse Pair Spacing Tolerance
Determines the pulse pair spacing tolerance.

If the spacing is e.g. 12 us, the reply station will see a pulse pair with a spacing of 11.5
to 12.5 us as a valid interrogation pair and will respond to it. Otherwise, no reply will be
generated.

Remote command: 
[:SOURce<hw>]:BB:DME:PPS on page 167
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7.2.4 DME Analysis

The settings in this dialog are available only if an R&S NRP-Z81 power sensor is con-
nected to the R&S SMBV.

1. To access this dialog:

2. Select "DME > DME Mode > Interrogation".

3. Select "System Configuration > DME Analysis".

The "DME Analyisis" dialog comprises the settings to configure the parameters of
the reply signal of the ground station transponder.

State
Activates the DME analysis. The R&S SMBV generates interrogation pulse pairs and
starts an internal counter for time measurement.

The measurement gate settings determine the measurement window (expected reply
delay +/- gate length/2). Only reply pulses for which the 50% voltage point of the rising
edge of the first pulse is within the measurement window are used to evaluate the
delay time and reply efficiency. The delay measurement is averaged within the mea-
surement cycle. The reply efficiency is calculated once for each measurement cycle.

 

System Configuration Settings



DME Configuration and SettingsAvionics Standards

78Operating Manual 1176.8600.02 ─ 05

Example: 
The gate length is 1 µs and the expected reply delay is 50 µs. The measurement win-
dow lies in the range between 49.5 and 50.5 µs. Only pulse pairs are used for the mea-
surement whose 50% voltage point of the rising edge of the first pulse is within this
range.

Remote command: 
[:SOURce<hw>]:BB:DME:ANALysis:STATe on page 176

Expected Reply Delay
Sets the expected reply delay.

Remote command: 
[:SOURce<hw>]:BB:DME:ANALysis:GATE:EDELay on page 173

Gate Length
Sets the gate length for the measurement window.

Remote command: 
[:SOURce<hw>]:BB:DME:ANALysis:GATE[:LENGth] on page 174

Measurement Time
Sets the time for the measurement cycle.

Remote command: 
[:SOURce<hw>]:BB:DME:ANALysis:GATE:COUNt on page 173

Peak Level
Indicates the measured average peak level of all pulse pairs in a measurement cycle.

Remote command: 
[:SOURce<hw>]:BB:DME:ANALysis:POWer? on page 175
[:SOURce<hw>]:BB:DME:ANALysis:POWer:OK? on page 175

Range Distance
Indicates the measured average range distance of all valid pulse pairs in a measure-
ment cycle. If there are no valid measurements available in the set measurement win-
dow 'invalid' is indicated.

Remote command: 
[:SOURce<hw>]:BB:DME:ANALysis:RDIStance? on page 176
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Reply Delay
Indicates the measured average reply delay of all valid pulse pairs in a measurement
cycle. If there are no valid measurements available in the set measurement window
'invalid' is indicated.

Remote command: 
[:SOURce<hw>]:BB:DME:ANALysis:TIME? on page 176
[:SOURce<hw>]:BB:DME:ANALysis:TIME:OK? on page 177

Reply Efficiency
Indicates the measured reply efficiency in percent. The measurement is the ratio of the
number of measured valid reply pulse pairs to transmitted pulse pairs in a measure-
ment cycle.If there are no valid measurements available in the set measurement win-
dow 'invalid' is indicated.

Remote command: 
[:SOURce<hw>]:BB:DME:ANALysis:EFFiciency? on page 173
[:SOURce<hw>]:BB:DME:ANALysis:EFFiciency:OK? on page 173

Pulse Repetition Rate
Indicates the measured mean pulse repetition rate of the DME ground station.

If there are no valid measurements available in the set measurement window 'invalid' is
indicated.

Remote command: 
[:SOURce<hw>]:BB:DME:ANALysis:PRRate? on page 175
[:SOURce<hw>]:BB:DME:ANALysis:PRRate:OK? on page 176

7.2.5 COM/ID Settings

To access this dialog:

1. Select "DME > DME Mode > Reply".

2. Select "DME > System Configuration".

The dialog comprises the settings, necessary to configure the COM/ID settings availa-
ble for the DME reply modulation.
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COM/ID State
Enables/disables an additional communication/identification (COM/ID) signal.

The ID signal consists of a regular group of pulses that generates Morse code dots and
dashes.

The transmission of the ground signal is interrupted every 40 seconds (ID period) and
one ID sequence is transmitted instead. The "key down time" of the ground signal cor-
responds to the period of transmission for a dot or dash in the Morse code ID
sequence (e.g. 100ms for a dot). During the key down times reply pulses are not trans-
mitted, however, they are transmitted between the key down times.

Remote command: 
[:SOURce<hw>]:BB:DME:ID[:STATe] on page 181

Show/Hide Details
Reveals the detailed setting options for the COM/ID signal.

Once the details are revealed, the labeling on the button changes to "Hide Details".
Use this to hide the detailed setting options display again.

Pair of Pulse Pairs
Enables the transmission of a pair of pulse pairs during the set "Rate".

The ID signal consists of a regular group of pulses that generates Morse code dots and
dashes. To form the regular pulse groups, two pulse pairs are separated by 100 us.
This is called a pair of pairs. These pair combinations are transmitted at a regular rate
of 1350 pairs of pairs, see figure 7-1. This results in a repetition rate of 1350 Hz, which
is an audible tone for an ident.

Fig. 7-1: Signal with enabled pair of puse pairs
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If the "Pair of Pulse Pairs" is disabled only a single pulse pair is transmitted in the
selected "Rate", see figure 7-2.

Fig. 7-2: Signal with disabled pair of puse pairs

Remote command: 
[:SOURce<hw>]:BB:DME:ID:PPP[:STATe] on page 179

Pulse Pair Spacing
Sets the value for the pulse pair spacing when "Pair of Pulse Pairs" is enabled.

Remote command: 
[:SOURce<hw>]:BB:DME:ID:PPS on page 180

Code
Sets the coding of the COM/ID signal by the international short name of the airport
(e.g. MUC for the Munich airport). If no coding is entered, the COM/ID tone is sent
uncoded (key down).

Remote command: 
[:SOURce<hw>]:BB:DME:ID:CODE on page 178

Rate
Sets the pulse repetition rate of the ID sequence.

Remote command: 
[:SOURce<hw>]:BB:DME:ID:RATE on page 180

Period
Sets the period of the COM/ID signal in seconds.

Remote command: 
[:SOURce<hw>]:BB:DME:ID:PERiod on page 180

Time Schema
Sets the time schema for the COM/ID signal.
● "Standard"

The set dot length determines the length of the dash, the symbol space and letter
space.

● "User"
You can set each length value seperately.

Remote command: 
[:SOURce<hw>]:BB:DME:ID:TSCHema on page 181

Dot Length
Sets the length of a Morse dot in seconds.
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For "Time Schema > Standard" this value determines also the length of the dash
(3xDot length), symbol space (= Dot length) and letter space (3xDot length).

Remote command: 
[:SOURce<hw>]:BB:DME:ID:DOT on page 179

Dash Length
Available only for "Time Schema > User".

Sets the length of a Morse dash in milliseconds.

Remote command: 
[:SOURce<hw>]:BB:DME:ID:DASH on page 178

Symbol Space
Available only for "Time Schema > User".

Sets the length of a symbol space in milliseconds.

Remote command: 
[:SOURce<hw>]:BB:DME:ID:SYMBol on page 180

Letter Space
Available only for "Time Schema > User".

Sets the length of a letter space in milliseconds.

Remote command: 
[:SOURce<hw>]:BB:DME:ID:LETTer on page 179

7.2.6 Adjustment Factors

The dialog comprises the settings, necessary to normalize the setup when triggering
the instrument with a power sensor.

In order to calibrate a measurement setup regarding external pulse input and internal
processing delays, the "Normalize Setup" functionality can be used.

For DME operation in combination with a power sensor as input channel, the exact trig-
ger point has to be known to compensate for the pulse shape and the internal delay of
the Sensor.

As shown in figure 7-3, the R&S SMBV gets interrogation pulses from an external DUT
using the same pulse shape. According to the settings, the R&S SMBV should send a
reply pulse pair 50us after receiving the interrogation pulse pair.
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In order to to guarantee, that the 50% edge levels are exactly 50us separated from
each other, the R&S SMBV has to start the reply pulse before the 50us reply delay
period has elapsed.

Using the "Normalize Setup" calibration, an adjustment factor t is measured. This
adjustment factor is taken into account, when generating the reply pulses. The signal
output is started earlier to compensate for the trigger point of the sensor. This calibra-
tion works best, when both stations use the same pulse shape with the same timing
characteristics.

Fig. 7-3: Normalize setup

Normalize Setup
Available only if an R&S NRP-Z81 power sensor is connected to the R&S SMBV.

Performs a normalization of the test setup. The delay due to the test setup is measured
and subsequently considered in the reply measurements.

Remote command: 
[:SOURce<hw>]:BB:DME:ANALysis:NORMalize? on page 174

Power Sensor Adjustment Factor
Displays the power sensor adjustment factor determined during a normalization of the
setup.

Remote command: 
[:SOURce<hw>]:BB:DME:ANALysis:PSAFactor? on page 177
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Internal Adjustment Factor
Displays the internal adjustment factor, the mathematically calculated value of the time,
when the pulse reaches its 50% level.

Remote command: 
[:SOURce<hw>]:BB:DME:ANALysis:IAFactor? on page 177

Used Adjustment Factor
Selects which internal adjustment factor should be used.

"Internal" The mathematically calculated value of the time, when the pulse rea-
ches its 50% level. The power sensor trigger hysteresis and the small
delay from the power sensor trigger output to the R&S SMBV are not
considered by the calculation.

"Power Sen-
sor"

The during a normalization setup measured adjustment factor.

Remote command: 
[:SOURce<hw>]:BB:DME:ANALysis:UAFactor on page 178
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8 Trigger/Marker/Clock Settings
The "Trigger In" section is where the trigger for the signal is set. Various parameters
will be provided for the settings, depending on which trigger source - internal or exter-
nal - is selected. The current status of signal generation ("Running" or "Stopped") is
indicated for all trigger modes.

The "Marker Mode" section is where the marker signals at the MARKER output con-
nectors are configured.

The "Marker Delay" section is where a marker signal delay can be defined, either with-
out restriction or restricted to the dynamic section, i.e., the section in which it is possi-
ble to make settings without restarting signal and marker generation.

The "Clock Settings" section is where the clock source is selected and - in the case of
an external source - the clock type.

The buttons in the last section lead to submenu for general trigger, clock and mapping
settings.

8.1 Trigger Settings

To access this dialog, select "GBAS >Trigger/Marker..." /"ILS > Trigger..."/"VOR > Trig-
ger..."/"DME >Trigger/Marker...".

This dialog provides access to the settings necessary to select and configure the trig-
ger.

Trigger Mode
Selects trigger mode, i.e. determines the effect of a trigger event on the signal genera-
tion.
● "Auto"

The signal is generated continuously.
● "Retrigger"

The signal is generated continuously. A trigger event (internal or external) causes a
restart.

● "Armed_Auto"
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The signal is generated only when a trigger event occurs. Then the signal is gener-
ated continuously.
An "Arm" stops the signal generation. A subsequent trigger event (internal with or
external) causes a restart.

● "Armed_Retrigger"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated continuously. Every subsequent trigger event causes a restart.
An "Arm" stops signal generation. A subsequent trigger event (internal with or
external) causes a restart.

● "Single"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated once to the length specified at "Signal Duration".
Every subsequent trigger event (internal or external) causes a restart.

Remote command: 
[:SOURce<hw>]:BB:GBAS[:TRIGger]:SEQuence on page 186
[:SOURce<hw>]:BB:ILS[:TRIGger]:SEQuence on page 186
[:SOURce<hw>]:BB:VOR[:TRIGger]:SEQuence on page 186
[:SOURce<hw>]:BB:DME[:TRIGger]:SEQuence on page 186

Signal Duration Unit
Available only for R&S SMBV-K111 (GBAS) option.

Defines the unit for describing the length of the signal sequence to be output in the
"Single" trigger mode.

Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:SLUNit on page 185

Trigger Signal Duration
Enters the length of the signal sequence to be output in the "Single" trigger mode.

Use this parameter to deliberately output part of the signal, an exact sequence of the
signal, or a defined number of repetitions of the signal.

Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:SLENgth on page 184
[:SOURce<hw>]:BB:ILS:TRIGger:SLENgth on page 185
[:SOURce<hw>]:BB:VOR:TRIGger:SLENgth on page 185
[:SOURce<hw>]:BB:DME:TRIGger:SLENgth on page 184

Arm
For trigger modes "Armed Auto" and "Armed Retrigger", stops the signal generation
until subsequent trigger event occurs.

Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:ARM:EXECute on page 182
[:SOURce<hw>]:BB:ILS:TRIGger:ARM:EXECute on page 182
[:SOURce<hw>]:BB:VOR:TRIGger:ARM:EXECute on page 182
[:SOURce<hw>]:BB:DME:TRIGger:ARM:EXECute on page 182

Running/Stopped
For enabled modulation, displays the status of signal generation for all trigger modes.
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● "Running"
The signal is generated; a trigger was (internally or externally) initiated in triggered
mode.

● "Stopped"
The signal is not generated and the instrument waits for a trigger event.

Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:RMODe? on page 184
[:SOURce<hw>]:BB:ILS:TRIGger:RMODe? on page 184
[:SOURce<hw>]:BB:VOR:TRIGger:RMODe? on page 184
[:SOURce<hw>]:BB:DME:TRIGger:RMODe? on page 184

Execute Trigger
Executes trigger manually.

You can execute the trigger manually only if you select an internal trigger source and a
trigger mode other than "Auto".

Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:EXECute on page 183
[:SOURce<hw>]:BB:ILS:TRIGger:EXECute on page 183
[:SOURce<hw>]:BB:VOR:TRIGger:EXECute on page 183
[:SOURce<hw>]:BB:DME:TRIGger:EXECute on page 183

Trigger Source
Selects trigger source. This setting is effective when a trigger mode other than "Auto"
has been selected.
● "Internal"

The trigger event is executed by "Execute Trigger".
● "External"

The trigger event is the active edge of an external trigger signal, supplied at the
TRIGGER connector.
Use the "Global Trigger/Clock Settings" dialog to define the polarity, the trigger
threshold and the input impedance of the trigger signal.

Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:SOURce on page 185
[:SOURce<hw>]:BB:ILS:TRIGger:SOURce on page 185
[:SOURce<hw>]:BB:VOR:TRIGger:SOURce on page 185
[:SOURce<hw>]:BB:DME:TRIGger:SOURce on page 185

Sync. Output to External Trigger
(enabled for Trigger Source External)

Enables/disables output of the signal synchronous to the external trigger event.

For R&S SMBV instruments:

For two or more R&S SMBVs configured to work in a master-slave mode for synchro-
nous signal generation, configure this parameter depending on the provided system
trigger event and the properties of the output signal. See below for an overview of the
required settings.
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Typical Applications
● All instruments are synchronous to the external trigger event

– System Trigger = common External Trigger event for the master and the slave
instruments

– "Sync. Output to External Trigger" = ON
● All instruments are synchronous among themselves but starting the signal from first

symbol is more important than synchronicity with external trigger event
– System Trigger = common External Trigger event for the master and the slave

instruments
– "Sync. Output to External Trigger" = OFF

● All instruments are synchronous among themselves
– System Trigger = internal trigger signal of the master R&S SMBV for the slave

instruments
– "Sync. Output to External Trigger" = OFF

"On" Corresponds to the default state of this parameter.
The signal calculation starts simultaneously with the external trigger
event but because of the instrument’s processing time the first sam-
ples are cut off and no signal is output. After elapsing of the internal
processing time, the output signal is synchronous to the trigger event.
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"Off" The signal output begins after elapsing of the processing time and
starts with sample 0, i.e. the complete signal is output.
This mode is recommended for triggering of short signal sequences
with signal duration comparable with the processing time of the
instrument.

Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:EXTernal:SYNChronize:OUTPut
on page 183
[:SOURce<hw>]:BB:ILS:TRIGger:EXTernal:SYNChronize:OUTPut
on page 183
[:SOURce<hw>]:BB:VOR:TRIGger:EXTernal:SYNChronize:OUTPut
on page 183
[:SOURce<hw>]:BB:DME:TRIGger:EXTernal:SYNChronize:OUTPut
on page 183

Trigger Delay
Delays the trigger event of the signal from:
● the external trigger source
Use this setting to:
● synchronize the instrument with the device under test (DUT) or other external devi-

ces

Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger[:EXTernal<ch>]:DELay on page 185
[:SOURce<hw>]:BB:ILS:TRIGger[:EXTernal<ch>]:DELay on page 185
[:SOURce<hw>]:BB:VOR:TRIGger[:EXTernal<ch>]:DELay on page 185
[:SOURce<hw>]:BB:DME:TRIGger[:EXTernal<ch>]:DELay on page 185
[:SOURce<hw>]:BB:GBAS:TRIGger:OBASeband:DELay on page 184
[:SOURce<hw>]:BB:ILS:TRIGger:OBASeband:DELay on page 184
[:SOURce<hw>]:BB:VOR:TRIGger:OBASeband:DELay on page 184
[:SOURce<hw>]:BB:DME:TRIGger:OBASeband:DELay on page 184
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Trigger Inhibit
For external trigger signal or trigger signal from the other path, sets the duration a new
trigger event subsequent to triggering is suppressed. In "Retrigger" mode for example,
a new trigger event will not cause a restart of the signal generation until the specified
inhibit duration does not expire.

Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger[:EXTernal<ch>]:INHibit on page 186
[:SOURce<hw>]:BB:ILS:TRIGger[:EXTernal<ch>]:INHibit on page 186
[:SOURce<hw>]:BB:VOR:TRIGger[:EXTernal<ch>]:INHibit on page 186
[:SOURce<hw>]:BB:DME:TRIGger[:EXTernal<ch>]:INHibit on page 186
[:SOURce<hw>]:BB:GBAS:TRIGger:OBASeband:INHibit on page 184
[:SOURce<hw>]:BB:ILS:TRIGger:OBASeband:INHibit on page 184
[:SOURce<hw>]:BB:VOR:TRIGger:OBASeband:INHibit on page 184
[:SOURce<hw>]:BB:DME:TRIGger:OBASeband:INHibit on page 184

8.2 Marker Settings GBAS

The marker settings are available only for option R&S SMBV-K111(GBAS).

This dialog provides access to the settings necessary to select and configure the
marker output signal, like the marker mode or marker delay settings.

Marker Mode
Marker configuration for up to two marker channels. The settings are used to select the
marker mode defining the shape and periodicity of the markers. The contents of the
dialog change with the selected marker mode; the settings are self-explanatory.

"1PPS" Marker signal for every start of second.
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"Pulse" Regular marker signal.
Enter a divider to define the clock frequency. The software derives
the frequency by dividing the sample rate by this divider; the dialog
indicates the resulting pulse frequency.

Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:PULSe:DIVider on page 189
[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:PULSe:FREQuency?
on page 189

"Pattern" Marker signal that is defined by a 64-bit long pattern.

Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:PATTern on page 189

"ON/OFF
Ratio"

Regular marker signal defined by an ON/OFF ratio.
A marker period lasts one ON and OFF cycle.
The "ON Time" and "OFF Time" are each expressed as a number of
samples.

Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:ONTime on page 190
[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:OFFTime on page 190

"Trigger" A received internal or external trigger signal is output at the marker
connector.

Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:MODE on page 188

Marker x Delay
Defines the delay between the marker signal at the marker outputs relative to the sig-
nal generation start.

"Marker x" For the corresponding marker, sets the delay as a number of sam-
ples.

Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:DELay on page 190

"Current Range without Recalculation"
Displays the dynamic range within which the delay of the marker sig-
nals can be set without restarting the marker and the signal.
Move the setting mark to define the delay.

Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:DELay:MINimum?
on page 190
[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:DELay:MAXimum?
on page 190

Marker Settings GBAS
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"Fix marker delay to current range"
Restricts the marker delay setting range to the dynamic range.

Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut:DELay:FIXed on page 190

8.3 Marker Settings DME

The marker settings are available only for options R&S SMBV-K111 /-K153 (DME).

This dialog provides access to the settings necessary to select and configure the
marker output signal, like the marker mode or marker delay settings.

Marker x
Selects a marker signal for the associated marker channel. The settings are used to
select the marker mode defining the shape and periodicity of the markers. The con-
tents of the dialog change with the selected marker mode.

"First Pulse (Start) / Pulse Start"
Sets the marker at the begining of the pulse.
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"First Pulse (50% Level) / Pulse (50% Level)"
Sets the markers to the point, where the level of the pulse has
reached 50%.

"Received Pulse"
Sets "Marker 2" on the received pulse.

Remote command: 
[:SOURce<hw>]:BB:DME:MARKer<ch>:MODE on page 188

Marker Width
Sets the width of the corresponding marker.

Remote command: 
[:SOURce<hw>]:BB:DME:MARKer<ch>:WIDTh on page 188

Marker Delay
Defines the delay between the marker signal at the marker outputs relative to the sig-
nal generation start.

Remote command: 
[:SOURce<hw>]:BB:DME:MARKer<ch>:DELay on page 187

Marker Settings DME
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Processing Delay
Displays the processing delay, the delay between the position of the markers for the
interrogation pulse and the corresponding marker positions for the reply pulse, when
"Marker 2" is set to "Received Pulse".

Remote command: 
[:SOURce<hw>]:BB:DME:MARKer<ch>:PDELay? on page 188

8.4 Clock Settings

To access this dialog, select "GBAS > Clock..."/"ILS > Clock..."/"VOR > Clock..."/"DME
> Clock...".

This dialog provides access to the settings necessary to select and configure the clock
signal, like the clock source and clock mode.

Sync. Mode
(for R&S SMBV only)

Selects the synchronization mode.

This parameter is used to enable generation of very precise synchronous signals of
several connected R&S SMBVs.

Note: If several instruments are connected, the connecting cables from the master
instrument to the slave one and between each two consecutive slave instruments must
have the same length and type. Avoid unnecessary cable length and branching points.
● "None"

The instrument is working in stand-alone mode.
● "Sync. Master"

The instrument provides all connected instruments with its synchronisation (includ-
ing the trigger signal) and reference clock signal.

● "Sync. Slave"
The instrument receives the synchronisation and reference clock signal from
another instrument working in a master mode.

Remote command: 
[:SOURce<hw>]:BB:GBAS:CLOCk:SYNChronization:MODE on page 193
[:SOURce<hw>]:BB:ILS:CLOCk:SYNChronization:MODE on page 193
[:SOURce<hw>]:BB:VOR:CLOCk:SYNChronization:MODE on page 193
[:SOURce<hw>]:BB:DME:CLOCk:SYNChronization:MODE on page 193
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Set Synchronization Settings
(for R&S SMBV only)

Performs an automatic adjustment of the instrument's settings required for the synchro-
nization mode, selected with the parameter "Synchronization Mode".

Remote command: 
[:SOURce<hw>]:BB:GBAS:CLOCk:SYNChronization:EXECute on page 192
[:SOURce<hw>]:BB:ILS:CLOCk:SYNChronization:EXECute on page 192
[:SOURce<hw>]:BB:VOR:CLOCk:SYNChronization:EXECute on page 192
[:SOURce<hw>]:BB:DME:CLOCk:SYNChronization:EXECute on page 192

Clock Source
Selects the clock source.
● "Internal"

The internal clock reference is used to generate the symbol clock.
● "External"

The external clock reference is fed in as the symbol clock or multiple thereof via the
CLOCK connector.
The symbol rate must be correctly set to an accuracy of +/-2 % (see data sheet).
The polarity of the clock input can be changed with the aid of "Global Trigger/Clock
Settings".

Remote command: 
[:SOURce<hw>]:BB:GBAS:CLOCk:SOURce on page 192
[:SOURce<hw>]:BB:ILS:CLOCk:SOURce on page 192
[:SOURce<hw>]:BB:VOR:CLOCk:SOURce on page 192
[:SOURce<hw>]:BB:DME:CLOCk:SOURce on page 192

Clock Mode
Enters the type of externally supplied clock.

Remote command: 
[:SOURce<hw>]:BB:ILS:CLOCk:MODE on page 191
[:SOURce<hw>]:BB:VOR:CLOCk:MODE on page 191
[:SOURce<hw>]:BB:DME:CLOCk:MODE on page 191
[:SOURce<hw>]:BB:GBAS:CLOCk:MODE on page 191

Clock Multiplier
Enters the multiplication factor for clock type "Multiple".

Remote command: 
[:SOURce<hw>]:BB:GBAS:CLOCk:MULTiplier on page 191
[:SOURce<hw>]:BB:ILS:CLOCk:MULTiplier on page 192
[:SOURce<hw>]:BB:VOR:CLOCk:MULTiplier on page 192
[:SOURce<hw>]:BB:DME:CLOCk:MULTiplier on page 191

Measured External Clock
Provided for permanent monitoring of the enabled and externally supplied clock signal.

Remote command: 
CLOCk:INPut:FREQuency?

Clock Settings
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8.5 Global Settings

The buttons in this section lead to dialogs for general trigger, clock and mapping set-
tings.

Global Trigger/Clock Settings
Calls the "Global Trigger/Clock/Input Settings" dialog.

This dialog is used among other things for setting the trigger threshold, the input impe-
dance and the polarity of the clock and trigger inputs.

The parameters in this dialog affect all digital modulations and standards, and are
described in chapter "Global Trigger/Clock/Input Settings" in the Operating Manual.
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9 How to Work with the GBAS Option
Testing GBAS receivers can be a challenging task. The main error sources that influ-
ence the performance of a GBAS airborne device are typically caused by distortion on
the VHF link or mismatch in the application data. The former could be caused by inter-
ference, multipath effects as well as ground and/or surface reflections. The latter is
usually related to a bias in the differential corrections (message type 1 and 11) and/or
mismatch between the TAP/FAS data transmited on the link and the actually wanted
flight path by the air traffic control (ATC) (message type 4).

The following step-by-step instructions demonstrate how to perform some signal gen-
eration tasks with the GBAS option and generate signals suitable for GBAS testing.
The following sections focus on the R&S SMBV configuration. Necessary configuration
in VDB receivers, devices under test (DUT) or other test equipment are beyond the
scope of this description.

9.1 Generating GBAS Signals with Several Frequency
Channels

With the R&S SMBV, you can generate simulataneously multiple frequency GBAS sig-
nal. Multiple frequency signals are suitable for testing the capability of VDB receivers of
tuning frequencies in the frequency range, as specified in RTCA DO-246D.

This example shows how to use the multiple frequency function to generate a GBAS
signal, containing GBAS Frequency Channels 39 to 45.

To enable the generation of several frequency channels

1. Calculate the channel number of the central frequency.
(39 + 45)/2 = 42

2. For frequency channel number 42, calculate the channel frequency.
Channel frequency = 108.025 MHz + 42*25 kHz = 109.075 MHz

3. Select "Status Bar > Frequency = 109.075 MHz" to set the center frequency.

4. Select "Baseband > Avionics > GBAS" and select "Multiple Frequency Channels >
On".

5. Select "VDB Transmitters Configuration"

The graph confirms the selected center frequency.
The R&S SMBV selects the 10 adjacent frequency channels, symmetrically located
around the central one. The central frequency is referred as frequency number 0.

6. Use the "Append" function to enable seven VDBs, VDB#1 to VBD#7.

7. In the VDB table, for each VDB, select different "Feq. Num." to allocated them to
different frequency channels.
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8. Select "GBAS > State > On"

9. Select "RF > State > On"

The R&S SMBV generates a GBAS signal, composed of seven adjicent frequency
channels.

The generated GBAS signal is suitable for unwanted emissions measurements, adja-
cent and co-channels rejections masurements and carrier frequency stability measure-
ments.

9.2 Generating a GBAS Signal for Receiver Sensitivity
Tests

Sensitivity tests are very essential for the performance of VDB receivers and used to
measure their ability to demodulate GBAS signal at low power level. To perform a sen-
sitivity test it is suffisient to generate a single frequency signal. We use the advantages
of the gated power mode and vary the level of the generated GBAS signal. The goal of
the test is to find out the signal with the minimum level that the DUT requires to cor-
rectly detect the GBAS signal.

To generate a GBAS signal for sensitivity tests

1. Press PRESET to set the R&S SMBV to a definite state.

2. Select "Staus Bar > Frequency = 108.4 MHz"

3. Select "Staus Bar > Level = -10 dBm"

4. Select "Baseband > Avionics > GBAS"
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5. Select "Gated Power Mode > On"

6. Select "VDB Transmitter Configuration", use the default configuration and select
"VDB#1 > Schedulling > Config".

7. In the "GBAS Scheduling 1" dialog, enable:

a) "TS1 > State > On", relative power "TS1 > Pow(dB) = 0 dB"
b) "TS3 > State > On", relative power "TS3 > Pow(dB) = -15 dB"
c) "TS2/TS4/TS5/TS6/TS7/TS8 > State > Off"
d) "TS2/TS4/TS5/TS6/TS7/TS8 > Pow(dB) = -inf"

8. Select "GBAS > State > On"

9. Select "RF > State > On"

The R&S SMBV generates a single frequency signal; the VDB transmission is allo-
cated on two time slots, TS1 and TS3 with different relative power (see also exam-
ple "Calculating the power per time slot in "Gated Power Mode > On"" on page 18).
The signal is generated at physical layer and the bursts carry arbitrary data (PN9).

10. In the R&S SMBV, vary the relative power of TS3 and measure the received power
level at the VDB receiver.
For example, to simulate conditions of weak signal, reduce the relative power down
to -60 dBm.

11. Check whether the received signal is correcty decodded.

The sensitvity level of the receiver is the level at that the receiver does not detect
any signal on TS3.

9.3 Generating a GBAS Signal for VDB Slot Detection

The goal of VDB slot detection tests is to prove correct detection of all time slots from
which each VDB message was received.

To generate a GBAS signal for slot detection tests

1. Press PRESET to set the R&S SMBV to a definite state.

2. Select "Staus Bar > Frequency = 110 MHz"

3. Select "Baseband > Avionics > GBAS" and select "Multiple Frequency Channels >
Off".

4. Select "VDB Transmitters Configuration"

The graph confirms the selected center frequency.

5. Use the "Append" function to enable three VDBs, VDB#1 to VBD#3.

6. Select "VDB#1 > Schedulling > Config" and allocate VDB#1, VDB#2 and VDB#3 as
follwoing:

 

Generating a GBAS Signal for VDB Slot Detection
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7. Select "GBAS > State > On"

8. Select "RF > State > On"

The signal is generated at physical layer and the bursts carry arbitrary data (PN9).
Prove that the VDB receiver detects the correct time slots. For example, the trans-
mission of VDB#2 on frequency channel with 110 MHz carrier frequency and time
slots TS2, TS5 and TS7.

9.4 Generating a GBAS Signal for Message Format Detec-
tion

Message format detection tests verify wheteher the VDB receiver receives and deco-
ded correctly parameters in the GBAS messages. The generated VDB signal in this
example contains real application data. Enabled are GBAS Message Type 2 and Mes-
sage Type 1.

To generate a GBAS signal for testing of correct message detection

1. Press PRESET to set the R&S SMBV to a definite state.

2. Select "Staus Bar > Frequency = 110 MHz"

3. Select "Baseband > Avionics > GBAS" and select "Multiple Frequency Channels >
Off".

4. Select "VDB Transmitters Configuration"

The graph confirms the selected center frequency.

5. Select "VDB#1 > Data > Real GBAS Data" and select "Data Config > Message
Config".

6. Enable "Message Type 2 > On".
Configre the settings as required. For this example, enable a reference location
with coorrdinates "Altitude = 110m", "Latitude = 48.150 deg" and "Longitude =
11.5833 deg"

7. Enable "Differantial GNSS > On" ans select "GBAS Differential File > Predefined
Files > Correction1"

 

Generating a GBAS Signal for Message Format Detection
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8. Select "GBAS > State > On"

9. Select "RF > State > On"

10. At the VDB receiver, verify that:

● the received values of each parameter are within the allowed value range
● the received parameters are decoded correctly
● the VDB messages are discarded if they do not comply to the standards.

9.5 Generating a GPS and a GBAS Signal for Multi Mode
Receiver Tests

GBAS airborne receivers are based on the multi mode receiver (MMR) technology. A
multi mode receiver consists of a GPS antenna, a VHF antenna and processing equip-
ment and supports simultaneous signal reception of different landing and precision
navigation systems, like GPS, GBAS and ILS.

In this example, we use two R&S SMBV to generate a GPS signal and a GBAS signal
for MMR testing. The aim of this GBAS test is to measure the resulting (improved) aug-
mentation.

 

Generating a GPS and a GBAS Signal for Multi Mode Receiver Tests
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Overview of required relevant options

Instrument#1
● option GPS (R&S SMBV-K44)
● GNSS global option R&S SMBV-K91 (Extension to 12 Satellites)
● generation of more than 12 satellites requires additionally GNSS global option

R&S SMBV-K96 (Extension to 24 Satellites)
● GNSS Extension for Obscuration Simulation and Automatic Multipath (R&S SMBV-

K101)

Instrument#2
● option GBAS (R&S SMBV-K111)

Connecting and configuring the two R&S SMBV instruments for synchronous
signal generation

In this following, only the related settings are discussed. For detailed information on
cabling and required configuration, refer to:
● R&S SMBV Operating Manual, section "Synchronous Signal Generation"
● Application Note 1GP84 "Time Synchronous Signals with Multiple R&S SMBV100A

Vector Signal Generators "

► Connect the instruments to work in master-slave mode, see figure 9-1.

Generating a GPS and a GBAS Signal for Multi Mode Receiver Tests
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Fig. 9-1: Example of test setup

The required steps are beyong the scope of this description. For details, see the
proposed reference descriptions.

The first R&S SMBV provides the second one with its system clock, trigger and fre-
quency reference signals.

Generating a GPS signal

To configure the instrument#1 to generate a GPS signal with 12 or more satellites, fol-
low these general guidelines.

For details, see R&S SMBV Satellite Navigation operating manual.

1. Select "Baseband > GPS"

2. Select "GPS > Simulation Mode > Auto Localization"

3. Select "User Environment > Vehicle Type > Aircraft"

4. Select "Localization Data", select "Waypoint/Attitude File" and load a suitable
*.xtd file, describing the movement of airplane the DUT is installed in.

5. Select "GPS > Navigation Data > Almanac" and select a suitable file.

Generating a GPS and a GBAS Signal for Multi Mode Receiver Tests
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6. Open the "GPS > Real Time S.P.O.T." to observe the current satellites constella-
tion.

7. Select "GPS > State > On"

8. Select "RF > State > On"

Generating a GBAS signal

To configure the instrument#2 to generate a GBAS signal, follow the steps described in
"To generate a GBAS signal for testing of correct message detection" on page 100

1. Configure the required reference location

2. Select a suitable "GBAS Differential File" (message type 1), containing ephemeris
as well as ionospheric corrections.

3. Select "GBAS > State > On"

4. Select "RF > State > On"

5. In the instrument#1, trigger the signal generation.

6. At the multi mode receiver, measure the resulting bias.
Is the augmentation improved?

The multi mode receiver should calculate the plane position with ideally less error
than in the case of a standalone GPS.
The differential GPS correction parameters transmited by the VHF link (message
types 1 and 11) enhance the navigation algorithm and should lead to a better posi-
tion fix.

Possible extensions

With this test setup you can simulated different conditions and perform a number of
measurement, like:
● Use the AWGN generator of the R&S SMBV and superimpose noise on the gener-

ated GBAS signal
● Simulate the GNSS signal in multipath environment
● Use the ephemeris parameters in the navigation message to simulate satellite fail-

ure
● Simulate the effects caused by obscuration and multipath on the GNSS signal, like

reflections and absorption from different surfaces
● Use the clock correction parameters to simulate satellite clock errors
● Change the ionospheric parameters in the atmospheric message

The full range of GBAS test include flight testing. Consider a test setup with two
R&S SMBVs, where:
● the first R&S SMBV simulates a GBAS signal with message type 4 corresponding

to the Path to be followed (TAP and FAS)
● the second R&S SMBV simulates a real time errors in the actual path followed by

the airplane when compared to the TAP path the Air Traffic Controller (ATC) is ask-
ing for.

Generating a GPS and a GBAS Signal for Multi Mode Receiver Tests
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Consider a hadrware in the loop (HIL) setup with the second R&S SMBV.

Generating a GPS and a GBAS Signal for Multi Mode Receiver Tests
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10 Remote-Control Commands
The following commands are required to perform signal generation with the Avionics
option in a remote environment. We assume that the R&S SMBV has already been set
up for remote operation in a network as described in the R&S SMBV documentation. A
knowledge about the remote control operation and the SCPI command syntax are
assumed.

Conventions used in SCPI command descriptions
For a description of the conventions used in the remote command descriptions, see
section "Remote Control Commands" in the R&S SMBV operating manual.

Placeholder <Subsystem>

To simplify the description of the remote control commands, the placeholder
<Subsystem> is introduced. Depending on the avionic standard used as an entry
standard, replace this placeholder <Subsystem> with for example SOURce:BB:GBAS
for GBAS.

The replacement of the place holder <Subsystem> is mandatory, i.e. remote control
commands containing this placeholder are not recognized and accepted by the instru-
ment.

Example: 
SCPI command <subsystem>:STATe on page 108:
● Entry Standard = DME

SOURce:BB:DME:STATe
● Entry Standard = GBAS

SOURce:BB:GBAS:STATe
● Entry Standard = ILS

SOURce:BB:ILS:STATe
● Entry Standard = VOR

SOURce:BB:VOR:STATe
● invalid command

<Subsystem>:STAT

Common Suffixes

The following common suffixes are used in remote commands:
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Suffix Value range Description

SOURce<hw> [1] available baseband signals

OUTPut<ch> 1 .. 2 available markers

R&S SMBV supports two markers

EXTernal<ch> 1 .. 2 external trigger connectors

The following commands specific to the Avionics standards are described here:

● Primary Settings....................................................................................................107
● GBAS Settings...................................................................................................... 110
● ILS Settings...........................................................................................................139
● VOR Settings........................................................................................................ 156
● DME Settings........................................................................................................ 164
● Trigger Settings ....................................................................................................181
● Marker Settings DME............................................................................................187
● Marker Settings GBAS..........................................................................................188
● Clock Settings....................................................................................................... 191

10.1 Primary Settings

<subsystem>:STATe......................................................................................................108
[:SOURce<hw>]:BB:DME:STATe.....................................................................................108
[:SOURce<hw>]:BB:GBAS:STATe...................................................................................108
[:SOURce<hw>]:BB:ILS:STATe.......................................................................................108
[:SOURce<hw>]:BB:VOR:STATe.....................................................................................108
<subsystem>:PRESet.....................................................................................................108
[:SOURce<hw>]:BB:DME:PRESet................................................................................... 108
[:SOURce<hw>]:BB:GBAS:PRESet................................................................................. 108
[:SOURce<hw>]:BB:ILS:PRESet..................................................................................... 108
[:SOURce<hw>]:BB:VOR:PRESet................................................................................... 108
<subsystem>:SETTing:CATalog......................................................................................108
[:SOURce<hw>]:BB:DME:SETTing:CATalog?...................................................................108
[:SOURce<hw>]:BB:GBAS:SETTing:CATalog?.................................................................108
[:SOURce<hw>]:BB:ILS:SETTing:CATalog?..................................................................... 108
[:SOURce<hw>]:BB:VOR:SETTing:CATalog?...................................................................108
<subsystem>:SETTing:DELete........................................................................................108
[:SOURce<hw>]:BB:DME:SETTing:DELete...................................................................... 108
[:SOURce<hw>]:BB:GBAS:SETTing:DELete.....................................................................109
[:SOURce<hw>]:BB:ILS:SETTing:DELete.........................................................................109
[:SOURce<hw>]:BB:VOR:SETTing:DELete...................................................................... 109
<subsystem>:SETTing:LOAD..........................................................................................109
[:SOURce<hw>]:BB:DME:SETTing:LOAD........................................................................ 109
[:SOURce<hw>]:BB:GBAS:SETTing:LOAD.......................................................................109
[:SOURce<hw>]:BB:ILS:SETTing:LOAD...........................................................................109
[:SOURce<hw>]:BB:VOR:SETTing:LOAD........................................................................ 109
<subsystem>:SETTing:STORe........................................................................................109
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[:SOURce<hw>]:BB:DME:SETTing:STORe...................................................................... 109
[:SOURce<hw>]:BB:GBAS:SETTing:STORe.....................................................................109
[:SOURce<hw>]:BB:ILS:SETTing:STORe.........................................................................109
[:SOURce<hw>]:BB:VOR:SETTing:STORe.......................................................................109
<subsystem>:SETTing:STORe:FAST...............................................................................109
[:SOURce<hw>]:BB:DME:SETTing:STORe:FAST............................................................. 109
[:SOURce<hw>]:BB:GBAS:SETTing:STORe:FAST........................................................... 109
[:SOURce<hw>]:BB:ILS:SETTing:STORe:FAST............................................................... 110
[:SOURce<hw>]:BB:VOR:SETTing:STORe:FAST............................................................. 110

<subsystem>:STATe
[:SOURce<hw>]:BB:DME:STATe <State>
[:SOURce<hw>]:BB:GBAS:STATe <State>
[:SOURce<hw>]:BB:ILS:STATe <State>
[:SOURce<hw>]:BB:VOR:STATe <State>

Activates/deactivates the VOR modulation.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

<subsystem>:PRESet
[:SOURce<hw>]:BB:DME:PRESet
[:SOURce<hw>]:BB:GBAS:PRESet
[:SOURce<hw>]:BB:ILS:PRESet
[:SOURce<hw>]:BB:VOR:PRESet
Sets all parameters to their default values (*RST values specified for the commands).

<subsystem>:SETTing:CATalog
[:SOURce<hw>]:BB:DME:SETTing:CATalog?
[:SOURce<hw>]:BB:GBAS:SETTing:CATalog?
[:SOURce<hw>]:BB:ILS:SETTing:CATalog?
[:SOURce<hw>]:BB:VOR:SETTing:CATalog?
Queries the files with the standard settings in the default directory. Listed are files with
the file extension *.dme/*.gbas/*.ils/*.vor.

Refer to section "MMEM Subsystem" in the R&S SMBV manual for general information
on file handling in the default and a specific directories.

Return values: 
<Catalog> <filename1>,<filename2>,...

Returns a string of file names separated by commas.

Usage: Query only

<subsystem>:SETTing:DELete
[:SOURce<hw>]:BB:DME:SETTing:DELete <Filename>

Primary Settings
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[:SOURce<hw>]:BB:GBAS:SETTing:DELete <Filename>
[:SOURce<hw>]:BB:ILS:SETTing:DELete <Filename>
[:SOURce<hw>]:BB:VOR:SETTing:DELete <Filename>

Deletes the selected file from the default or specified directory. Deleted are files with
the file extension *.dme/*.gbas/*.ils/*.vor.

Refer to section "MMEM Subsystem" in the R&S SMBV manual for general information
on file handling in the default and a specific directories.

Setting parameters: 
<Filename> string

Usage: Setting only

<subsystem>:SETTing:LOAD
[:SOURce<hw>]:BB:DME:SETTing:LOAD <Filename>
[:SOURce<hw>]:BB:GBAS:SETTing:LOAD <Filename>
[:SOURce<hw>]:BB:ILS:SETTing:LOAD <Filename>
[:SOURce<hw>]:BB:VOR:SETTing:LOAD <Filename>

Loads the selected file from the default or the sepcified directory. Load are files with
extension *.dme/*.gbas/*.ils/*.vor .

Refer to section "MMEM Subsystem" in the R&S SMBV manual for general information
on file handling in the default and a specific directories.

Setting parameters: 
<Filename> string

Usage: Setting only

<subsystem>:SETTing:STORe
[:SOURce<hw>]:BB:DME:SETTing:STORe <Filename>
[:SOURce<hw>]:BB:GBAS:SETTing:STORe <Filename>
[:SOURce<hw>]:BB:ILS:SETTing:STORe <Filename>
[:SOURce<hw>]:BB:VOR:SETTing:STORe <Filename>

Stores the current settings into the selected file; the file extensions *.dme/*.gbas/
*.ils/*.vor is assined automatically.

Refer to section "MMEM Subsystem" in the R&S SMBV operating manual for general
information on file handling in the default and a specific directories.

Setting parameters: 
<Filename> string

Usage: Setting only

<subsystem>:SETTing:STORe:FAST
[:SOURce<hw>]:BB:DME:SETTing:STORe:FAST <FastSave>
[:SOURce<hw>]:BB:GBAS:SETTing:STORe:FAST <Fast>
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[:SOURce<hw>]:BB:ILS:SETTing:STORe:FAST <FastSave>
[:SOURce<hw>]:BB:VOR:SETTing:STORe:FAST <FastSave>

Determines whether the instrument performs an absolute or a differential storing of the
settings.

Enable this function to accelerate the saving process by saving only the settings with
values different to the default ones.

Note: This function is not affected by the "Preset" function.

Parameters:
<FastSave> 0 | 1 | OFF | ON

*RST: 1

10.2 GBAS Settings

10.2.1 Programming Examples

This description provides simple programming examples. The purpose of the examples
is to present all commands for a given task. In real applications, one would rather
reduce the examples to an appropriate subset of commands.

The programming examples have been tested with a software tool which provides an
environment for the development and execution of remote tests. To keep the example
as simple as possible, only the "clean" SCPI syntax elements are reported. Non-exe-
cutable command lines (e.g. comments) start with two // characters.

At the beginning of the most remote control program, an instrument (p)reset is recom-
mended to set the instrument to a definite state. The commands *RST and
SYSTem:PRESet are equivalent for this purpose. *CLS also resets the status registers
and clears the output buffer.

Example: Generating a GBAS signal for sensitivity tests
The following example uses the gated power mode.

*RST
SOURce1:FREQuency:CW 108.4MHz
SOURce1:POWer:LEVel:IMMediate:AMPLitude  -10

SOURce1:BB:GBAS:GPOW ON
SOURce1:BB:GBAS:VDB1:SCH:TS1:STATe ON
SOURce1:BB:GBAS:VDB1:SCH:TS1:POWer 0
SOURce1:BB:GBAS:VDB1:SCH:TS3:STATe ON
SOURce1:BB:GBAS:VDB1:SCH:TS3:POWer -15
SOURce1:BB:GBAS:STATe ON
OUTput1:STATe ON
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// vary (reduce) the relative power of TS3
SOURce1:BB:GBAS:VDB1:SCH:TS3:POWer -45

Example: Generating a GBAS signal for VDB slot detection
The following is an example on how to configure transmission of two VDBs on a com-
mon carrier frequency of 100 MHz. VDB#1 and VDB#2 use different time slots.

*RST
SOURce1:FREQuency:CW 110MHz

SOURce1:BB:GBAS:MFCHannels OFF
// enable 2 VDBs
SOURce1:BB:GBAS:VDB:APPend
SOURce1:BB:GBAS:VDB1:SCH:TS1:STATe ON
SOURce1:BB:GBAS:VDB1:SCH:TS1:POWer 0
SOURce1:BB:GBAS:VDB1:SCH:TS8:STATe ON
SOURce1:BB:GBAS:VDB1:SCH:TS8:POWer 0
SOURce1:BB:GBAS:VDB2:SCH:TS2:STATe ON
SOURce1:BB:GBAS:VDB2:SCH:TS2:POWer 0
SOURce1:BB:GBAS:VDB2:SCH:TS5:STATe ON
SOURce1:BB:GBAS:VDB2:SCH:TS5:POWer 0
SOURce1:BB:GBAS:VDB2:SCH:TS7:STATe ON
SOURce1:BB:GBAS:VDB2:SCH:TS7:POWer 0

SOURce1:BB:GBAS:VDB2:STATe?
// Response: 1
SOURce1:BB:GBAS:STATe ON
OUTput1:STATe ON
// generate a waveform and store it in the default directory
SOURce1:BB:GBAS:WAVeform:CREate "gbas_slot_detection"
// store the settings in a file in the default directory
SOURce1:BB:GBAS:SETTing:STORe:FAST?
// Respone: 1
SOURce1:BB:GBAS:SETTing:STORe "gbas_slot_detection"

Example: Generating a GBAS signal for message format detection
The following is an example on how to generate a VDB signal with real application data
and enabled GBAS Message Type 2 and Message Type 1.

*RST
SOURce1:FREQuency:CW 110MHz

SOURce1:BB:GBAS:MFCHannels OFF
SOURce1:BB:GBAS:VDB1:DATA RGData
SOURce1:BB:GBAS:VDB1:MCONfig:MT2State ON
SOURce1:BB:GBAS:VDB1:MCONfig:GSRReceivers GW3R
SOURce1:BB:GBAS:VDB1:MCONfig:GSADesignator GADB
SOURce1:BB:GBAS:VDB1:MCONfig:GCID FC
SOURce1:BB:GBAS:VDB1:MCONfig:LMVariation 58
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SOURce1:BB:GBAS:VDB1:MCONfig:SVIGradient 0
SOURce1:BB:GBAS:VDB1:MCONfig:RFINdex 379
SOURce1:BB:GBAS:VDB1:MCONfig:SHEight 100
SOURce1:BB:GBAS:VDB1:MCONfig:RUNCertainty 20
SOURce1:BB:GBAS:VDB1:MCONfig:LOCation:COORdinates:DECimal 11.5833, 48.150, 110
SOURce1:BB:GBAS:VDB1:MCONfig:LOCation:COORdinates:DMS?
// Response: 11,34,59.88,EAST,48,9,0,NORT,110

SOURce1:BB:GBAS:VDB1:MCONfig:DG:STATe ON
SOURce1:BB:GBAS:VDB1:MCONfig:DG:PREDefined:CATalog?
// Response: Correction1
SOURce1:BB:GBAS:VDB1:MCONfig:DG:PREDefined:FILE "Correction1"
SOURce1:BB:GBAS:VDB1:MCONfig:DG:FILE?
// Response: "Correction1.rs_gbas"

SOURce1:BB:GBAS:VDB1:SSID?
// Response: A
SOURce1:BB:GBAS:VDB1:GID?
// REsponse: TR0
SOURce1:BB:GBAS:VDB1:NOFRames?
// Response: 20
SOURce1:BB:GBAS:VDB1:FNUMber?
// Response: 0

SOURce1:BB:GBAS:STATe ON
OUTput1:STATe ON

SOURce1:BB:GBAS:SETTing:STORe "gbas_msg_fmt_detection"
SOURce1:BB:GBAS:SETTing:CATalog?
// Response: gbas_msg_fmt_detection,gbas_slot_detection

Example: Generating a GBAS signal containing message type 4
The following is an example on how to generate a VDB signal with real application data
and enabled GBAS Message Type 4.

*RST
SOURce1:FREQuency:CW 110MHz

SOURce1:BB:GBAS:MFCHannels OFF
SOURce1:BB:GBAS:VDB1:DATA RGData
SOURce1:BB:GBAS:VDB1:MCONfig:MT4State ON

SOURce1:BB:GBAS:VDB1:MCONfig:FDSState ON
SOURce1:BB:GBAS:VDB1:MCONfig:GPANgle 30
SOURce1:BB:GBAS:VDB1:MCONfig:ATUSelector MET
SOURce1:BB:GBAS:VDB1:MCONfig:ATCHeight 1200
SOURce1:BB:GBAS:VDB1:MCONfig:LFLocation:HEIGht 103
SOURce1:BB:GBAS:VDB1:MCONfig:AID KJFK
SOURce1:BB:GBAS:VDB1:MCONfig:RNUMber 13
SOURce1:BB:GBAS:VDB1:MCONfig:RLETter LETL
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SOURce1:BB:GBAS:VDB1:MCONfig:APDesignator GC
SOURce1:BB:GBAS:VDB1:MCONfig:RUINdicator "A"
SOURce1:BB:GBAS:VDB1:MCONfig:RPDF 3
SOURce1:BB:GBAS:VDB1:MCONfig:RPIF "L13A"
SOURce1:BB:GBAS:VDB1:MCONfig:LFLocation:COORdinates:DECimal -0.012650,0.027897
SOURce1:BB:GBAS:VDB1:MCONfig:LFLocation:COORdinates:DMS?
// Response: 73,47,13.83,EAST,40,39,22.95,NORT
SOURce1:BB:GBAS:VDB1:MCONfig:DFLocation:COORdinates:DECimal -0.012650, 0.027897
SOURce1:BB:GBAS:VDB1:MCONfig:DFLocation:COORdinates:DMS?
// Response: 0,0,45.54,WEST,0,1,40.429,NORT
SOURce1:BB:GBAS:VDB1:MCONfig:CWAThreshold 105
SOURce1:BB:GBAS:VDB1:MCONfig:DLOFfset 0
SOURce1:BB:GBAS:VDB1:MCONfig:FVAA 0
SOURce1:BB:GBAS:VDB1:MCONfig:FLAA 40

SOURce1:BB:GBAS:VDB1:MCONfig:TDSState ON
SOURce1:BB:GBAS:VDB1:MCONfig:RPDT 21
SOURce1:BB:GBAS:VDB1:MCONfig:RPIT "GTN"
SOURce1:BB:GBAS:VDB1:MCONfig:WAYPoint:PREDefined:CATalog?
// Response: Braunschweig
SOURce1:BB:GBAS:VDB1:MCONfig:WAYPoint:PREDefined:FILE "Braunschweig"
SOURce1:BB:GBAS:VDB1:MCONfig:WAYPoint:FILE?
// Response: "Braunschweig.txt"
SOURce1:BB:GBAS:VDB1:MCONfig:NOPPoint?
// Response: 11
// to query user waypoint files in the default directory
// SOURce1:BB:GBAS:VDB1:MCONfig:WAYPoint:USER:CATalog? 
// Response: gbas_waypoint
SOURce1:BB:GBAS:VDB1:MCONfig:FRCLink 3
SOURce1:BB:GBAS:VDB1:MCONfig:TVAS 50
SOURce1:BB:GBAS:VDB1:MCONfig:TLAS 2

SOURce1:BB:GBAS:STATe ON
OUTput1:STATe ON

Example: Adjusting clock, marker and trigger settings
The following example lists the provided commands:

// ******************************************************************
// Clock settings
// ******************************************************************
SOURce1:BB:GBAS:CLOCk:SOURce INTernal

// ******************************************************************
// Configure and enable standard marker signal
// ******************************************************************
SOURce1:BB:GBAS:TRIGger:OUTPut1:MODE RATio
SOURce1:BB:GBAS:TRIGger:OUTPut1:ONTime 40
SOURce1:BB:GBAS:TRIGger:OUTPut1:OFFTime 20
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// ******************************************************************
// Configure and enable signal generation
// ******************************************************************
SOURce1:BB:GBAS:TRIGger:SOURce INTernal
SOURce1:BB:GBAS:TRIGger:SEQuence ARETrigger
SOURce1:BB:GBAS:STAT ON
SOURce1:BB:GBAS:TRIGger:EXECute
SOURce1:BB:GBAS:TRIGger:ARM:EXECute
SOURce1:BB:GBAS:TRIGger:RMODe?
// Stopped
SOURce1:BB:GBAS:TRIGger:EXECute
SOURce1:BB:GBAS:TRIGger:RMODe?
// Run

Example: Quering the default filter, clipping and modulation settings
The follwoing is a general example on working with these settings.

SOURce1:BB:GBAS:PRESet

SOURce1:BB:GBAS:SRINfo?
// Response: "10.5 kHz"
SOURce1:BB:GBAS:FILTer:TYPE?
// Response: COS
SOURce1:BB:GBAS:FILTer:PARameter:COSine?
// Response: 0.6
SOURce1:BB:GBAS:FILTer:PARameter:COSine:COFS?
// Response:0
SOURce1:BB:GBAS:MSET:MTYPe?
// Response: "D8PSK"
SOURce1:BB:GBAS:MSET:SRATe?
// Response: 10500

SOURce1:BB:GBAS:MFCHannels ON
SOURce1:BB:GBAS:MSET:SRATe?
// Response: 525000
SOURce1:BB:GBAS:SRINfo?
// Response: "525 kHz"

SOURce1:BB:GBAS:CLIPping:STATe?
// Response: 0
SOURce1:BB:GBAS:CLIPping:LEVel?
// Response: 100
SOURce1:BB:GBAS:CLIPping:MODE?
// Response: VECTor
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10.2.2 General Settings

[:SOURce<hw>]:BB:GBAS:VERSion?

Queries the specification according to that the settings are implement.

Return values: 
<Version> string

Example: SOURce1:BB:GBAS:VERSion?
Response: "RTCA DO-246D"

Usage: Query only

[:SOURce<hw>]:BB:GBAS:WAVeform:CREate <Filename>

With enabled signal generation, triggers the instrument to store the current settings as
an ARB signal in a waveform file. Waveform files can be further processed by the ARB
and/or as a multi carrier or a multi segment signal.

The file name and the directory it is stored in are user-definable; the predefined file
extension for waveform files is *.wv.

Setting parameters: 
<Filename> string

Example: see example "Generating a GBAS signal for VDB slot detection"
on page 111

Usage: Setting only

Manual operation: See "Generate Waveform File" on page 25

[:SOURce<hw>]:BB:GBAS:SCATi <SCAT>

Enables using of SCAT-I header information instead of the default LAAS (GBAS)
header.

Parameters:
<SCAT> 0 | 1 | OFF | ON

*RST: 0

Example: SOURce1:BB:GBAS:SCATi 0
Manual operation: See "SCAT-I" on page 25

[:SOURce<hw>]:BB:GBAS:MFCHannels <MFCh>

Enables the configuration of multiple frequency channels.

Parameters:
<MFCh> 0 | 1 | OFF | ON

*RST: 0
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Example: see example "Generating a GBAS signal for VDB slot detection"
on page 111

Manual operation: See "Multiple Frequency Channels" on page 26

[:SOURce<hw>]:BB:GBAS:GPOW <GPow>

Enables gated power mode.

Parameters:
<GPow> 0 | 1 | OFF | ON

*RST: 1

Example: see example "Generating a GBAS signal for sensitivity tests"
on page 110

Manual operation: See "Gated Power Mode" on page 26

[:SOURce<hw>]:BB:GBAS:SRINfo?

Queries the used sample rate.

Return values: 
<SRInfo> string

Example: see example "Quering the default filter, clipping and modulation
settings" on page 114

Usage: Query only

Manual operation: See "Sample Rate Variation/Sample Rate Info" on page 26

10.2.3 VDB Transmission Configuration Settings

[:SOURce<hw>]:BB:GBAS:VDB:APPend

Appends a new VDB to the end of the VDB list.

Example: see example "Generating a GBAS signal for VDB slot detection"
on page 111

Usage: Event

Manual operation: See "Append, Insert, Delete" on page 29

[:SOURce<hw>]:BB:GBAS:VDB<ch>:INSert

Inserts a new VDB before the selected one.

Example: see example "Generating a GBAS signal for VDB slot detection"
on page 111

Usage: Event
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Manual operation: See "Append, Insert, Delete" on page 29

[:SOURce<hw>]:BB:GBAS:VDB<ch>:DELete

Deletes the selected VDB.

Example: see example "Generating a GBAS signal for VDB slot detection"
on page 111

Usage: Event

Manual operation: See "Append, Insert, Delete" on page 29

[:SOURce<hw>]:BB:GBAS:VDB<ch>:STATe <VState>

Enables the selected VHF Data Broadcast (VDB) transmiter.

Parameters:
<VState> 0 | 1 | OFF | ON

*RST: 1

Example: see example "Generating a GBAS signal for VDB slot detection"
on page 111

Manual operation: See "State" on page 28

[:SOURce<hw>]:BB:GBAS:VDB<ch>:GID <GId>

Sets the GBAS ID.

Parameters:
<GId> string

A four-character (24-bit) alphanumeric field that identifies the
ground station broadcasting the message.
Permited are capital letter, numbers and "space".

Example: see example "Generating a GBAS signal for message format
detection" on page 111

Manual operation: See "GBAS ID" on page 28

[:SOURce<hw>]:BB:GBAS:VDB<ch>:SSID <Ssid>

Sets the Station Slot Identifier SSID of the of the ground station.

Parameters:
<Ssid> A | B | C | D | E | F | G | H

*RST: A

Example: see example "Generating a GBAS signal for message format
detection" on page 111

Manual operation: See "SSID" on page 28
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[:SOURce<hw>]:BB:GBAS:VDB<ch>:FNUMber <FNum>

Sets the frequency number the corresponding VDB is using.

Parameters:
<FNum> integer

Range: -5  to  5
*RST: 0

Example: see example "Generating a GBAS signal for message format
detection" on page 111

Manual operation: See "Freq. Num" on page 28

[:SOURce<hw>]:BB:GBAS:VDB<ch>:DLENgth <DataLen>

Sets the application data length.

Parameters:
<DataLen> integer

Range: 1  to  65495
*RST: 222

Manual operation: See "App. Data Length/bytes" on page 29

[:SOURce<hw>]:BB:GBAS:VDB<ch>:DATA <Data>

Selects the data source, e.g. a sequence of 0 or 1, a pseudo-random sequence with
different lenght, a pattern or a data list (DLISt).

Parameters:
<Data> ZERO | ONE | PATTern | PN9 | PN11 | PN15 | PN16 | PN20 |

PN21 | PN23 | DLISt | RGData
*RST: PN9

Example: see example "Generating a GBAS signal for message format
detection" on page 111

Manual operation: See "Data/Data Config" on page 28

[:SOURce<hw>]:BB:GBAS:VDB<ch>:DATA:DSELection <DSelection>

Selects the data list for the data source.

Parameters:
<DSelection> string

Example: SOURce1:BB:GBAS:VDB2:DATA DLISt
SOURce1:BB:GBAS:VDB2:DATA:DSELection
"/var/user/gbas_dl.dm_iqd "

Manual operation: See "Data/Data Config" on page 28
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[:SOURce<hw>]:BB:GBAS:VDB<ch>:DATA:PATTern <Pattern>

Selects the bit pattern for the data source.

Parameters:
<Pattern> integer

Example: SOURce1:BB:GBAS:VDB2:DATA PATTern
SOURce1:BB:GBAS:VDB2:DATA:PATTern #HB8A,12

Manual operation: See "Data/Data Config" on page 28

[:SOURce<hw>]:BB:GBAS:NOFRames?

Queries the number of VD frames.

Return values: 
<NOFrame> integer

Range: 1  to  12500
*RST: 1

Usage: Query only

Manual operation: See "No. of Frames" on page 29

10.2.4 Scheduling Settings

[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:TS<st>:STATe <State>

Enables the VDB in the corresponding time slot (TS).

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: see example "Generating a GBAS signal for sensitivity tests"
on page 110

Manual operation: See "TS0..TS7" on page 30

[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:TS<st>:POWer <Power>

Sets the relative power of a VDB per time slot (TS).

Parameters:
<Power> float

Range: -21  to  0
Increment: 0.01
*RST: 0

Example: see example "Generating a GBAS signal for sensitivity tests"
on page 110
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Manual operation: See "Pow(dB)" on page 30

10.2.5 Message Configuration

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:AID <AId>

Sets the airport ID.

Parameters:
<AId> string

Example: see example "Generating a GBAS signal containing message
type 4" on page 112

Manual operation: See "Airport ID" on page 37

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:APDesignator <ApPerDes>

Sets the approach performance designator.

Parameters:
<ApPerDes> GAB | GC | GCD

*RST: GAB

Example: see example "Generating a GBAS signal containing message
type 4" on page 112

Manual operation: See "Approach Performance Designator" on page 37

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:ATCHeight <Tch>

Sets the approach threshold crossing height.

Parameters:
<Tch> float

Range: 0  to  1638.35
Increment: 0.05
*RST: 0

Example: see example "Generating a GBAS signal containing message
type 4" on page 112

Manual operation: See "Plan View/Profile View Parameters" on page 36

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:ATUSelector <TchUnit>

Sets the units the approach TCH is experssed in, see [:SOURce<hw>]:BB:GBAS:
VDB<ch>:MCONfig:ATCHeight.

Parameters:
<TchUnit> FEET | MET

*RST: FEET
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Example: see example "Generating a GBAS signal containing message
type 4" on page 112

Manual operation: See "Plan View/Profile View Parameters" on page 36

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:CWAThreshold <CrWdAtTh>

Sets the course width at threshold.

Parameters:
<CrWdAtTh> float

Range: 80  to  143.75
Increment: 0.01
*RST: 80

Example: see example "Generating a GBAS signal containing message
type 4" on page 112

Manual operation: See "Course Width at Threshold" on page 39

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DFLocation:COORdinates:
DECimal <Longitude>, <Latitude>

Defines the coordinates of the Delta FPAD location in decimal format.

Parameters:
<Longitude> float

Range: -1.0  to  1.0
Increment: 1E-6
*RST: 0

<Latitude> float
Range: -1.0  to  1.0
Increment: 1E-6
*RST: 0

Example: see example "Generating a GBAS signal containing message
type 4" on page 112

Manual operation: See "Delta_FPAP Location Configuration" on page 38

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DFLocation:COORdinates:DMS
<LongitudeDeg>, <LongitudeMin>, <LongitudeSec>, <LongitudeDir>,
<LatitudeDeg>, <LatitudeMin>, <LatitudeSec>, <LatitudeDir>

Defines the coordinates of the Delta FPAD location in degrees, minutes and seconds.

Parameters:
<LongitudeDeg> integer

Range: 0  to  1.0
*RST: 0
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<LongitudeMin> integer
Defines the longitude minutes.
Range: 0  to  59
*RST: 0

<LongitudeSec> float
Defines the longitude seconds.
Range: 0  to  59.999
Increment: 0.001
*RST: 0

<LongitudeDir> EAST | WEST
Defines the longitude direction.
*RST: EAST

<LatitudeDeg> integer
Defines the latitude degrees.
Range: 0  to  1.0
*RST: 0

<LatitudeMin> integer
Defines the latitude minutes.
Range: 0  to  59
*RST: 0

<LatitudeSec> float
Defines the latitude seconds.
Range: 0  to  59.999
Increment: 0.001
*RST: 0

<LatitudeDir> NORTh | SOUTh
Defines the latitude direction.
*RST: NORT

Example: see example "Generating a GBAS signal containing message
type 4" on page 112

Manual operation: See "Delta_FPAP Location Configuration" on page 38

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:STATe <DiffGnssState>

Enables the use of differential GNSS data.

Parameters:
<DiffGnssState> 0 | 1 | OFF | ON

*RST: 0

Example: see example "Generating a GBAS signal for message format
detection" on page 111
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Manual operation: See "Differential GNSS" on page 42

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:PREDefined:CATalog?
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:USER:CATalog?
Queries the names of the existing user defined/predefined GBAS differential files.

Per default, the instrument stores user defined files in the /var/user/ directory. Use
the command MMEM:CDIRectory to change the default directory to the currently used
one.

Only files with extension *.rs_gbas are listed.

Example: see example "Generating a GBAS signal for message format
detection" on page 111

Usage: Query only

Manual operation: See "GBAS Differential File..." on page 42

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:PREDefined:FILE <Filename>

Loads the selected predeifned file (extension *.rs_gbas).

Setting parameters: 
<Filename> string

Only the file name is required

Example: see example "Generating a GBAS signal for message format
detection" on page 111

Usage: Setting only

Manual operation: See "GBAS Differential File..." on page 42

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:USER:FILE <Filename>

Loads the selected user-defined file (extension *.rs_gbas).

Per default, the instrument stores user defined files in the /var/user/ directory. Use
the command MMEM:CDIRectory to change the default directory to the currently used
one.

Setting parameters: 
<Filename> string

For files stored in the default directory, only the file name is
required.

Example: SOURce1:BB:GBAS:VDB3:MCONfig:DG:USER:CATalog?
Response: gbas_correction
SOURce1:BB:GBAS:VDB3:MCONfig:DG:USER:FILE
"gbas_correction"

Usage: Setting only
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Manual operation: See "GBAS Differential File..." on page 42

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:FILE?

Queries the currently selected GBAS differential file.

Return values: 
<Filename> string

filename with file extension (*.rs_gbas)

Example: see example "Generating a GBAS signal for message format
detection" on page 111

Usage: Query only

Manual operation: See "GBAS Differential File..." on page 42

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DLOFfset <DelLenOff>

Sets the Delta_Length offset.

Parameters:
<DelLenOff> float

Range: 0  to  2032
Increment: 8
*RST: 0

Example: see example "Generating a GBAS signal for message format
detection" on page 111

Manual operation: See "Delta_Length Offset" on page 39

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDSState <Fdss>

Enables the configuration of Final Approach Segment (FAS) data set.

Parameters:
<Fdss> 0 | 1 | OFF | ON

*RST: 1

Example: see example "Generating a GBAS signal for message format
detection" on page 111

Manual operation: See "FAS Data Set" on page 35

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FLAA <FasVt>

Sets the value of the broadcast lateral alert limit.
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Parameters:
<FasVt> float

Range: 0  to  50.8
Increment: 0.2
*RST: 0

Example: see example "Generating a GBAS signal containing message
type 4" on page 112

Manual operation: See "FAS Lateral Alert Limit / Approach Status" on page 39

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FRCLink <Rpcl>

Sets the FAS RPDS or continuation link.

Parameters:
<Rpcl> integer

Range: 0  to  255
*RST: 0

Example: see example "Generating a GBAS signal containing message
type 4" on page 112

Manual operation: See "FAS RPDS or Continuation Link" on page 41

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FVAA <Fvaa>

Sets the value of the broadcast vertical alert limit.

Parameters:
<Fvaa> float

Range: 0  to  25.4
Increment: 0.1
*RST: 0

Example: see example "Generating a GBAS signal containing message
type 4" on page 112

Manual operation: See "FAS Vertical Alert Limit / Approach Status" on page 39

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:GCID <Gcid>

Sets the ground station continuity/integrity designator.

Parameters:
<Gcid> FC | FD

*RST: FC

Example: see example "Generating a GBAS signal for message format
detection" on page 111

Manual operation: See "Ground Station Continuity/Integrity Designator" on page 32
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[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:GPANgle <Gpa>

Sets the glide path angle.

Parameters:
<Gpa> float

Range: 0  to  90
Increment: 0.01
*RST: 0

Example: see example "Generating a GBAS signal containing message
type 4" on page 112

Manual operation: See "Plan View/Profile View Parameters" on page 36

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:GSADesignator <Gsad>

Sets the ground station accuracy designator.

Parameters:
<Gsad> GADA | GADB | GADC

*RST: GADA

Example: see example "Generating a GBAS signal for message format
detection" on page 111

Manual operation: See "Ground Station Accuracy Designator" on page 32

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:GSRReceivers <Gsrr>

Sets the number of ground station reference receivers.

Parameters:
<Gsrr> GW3R | GW4R | GW2R

*RST: GW2R

Example: see example "Generating a GBAS signal for message format
detection" on page 111

Manual operation: See "Ground Station Reference Receivers" on page 32

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LFLocation:COORdinates:
DECimal <Longitude>, <Latitude>

Defines the coordinates of the LTP/FTP in decimal format.

Parameters:
<Longitude> float

Range: -180  to  180
Increment: 1E-6
*RST: 0
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<Latitude> float
Range: -90  to  90
Increment: 1E-6
*RST: 0

Example: see example "Generating a GBAS signal containing message
type 4" on page 112

Manual operation: See "LTP/FTP Location Configuration" on page 37

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LFLocation:COORdinates:DMS
<LongitudeDeg>, <LongitudeMin>, <LongitudeSec>, <LongitudeDir>,
<LatitudeDeg>, <LatitudeMin>, <LatitudeSec>, <LatitudeDir>

Defines the coordinates of the LTP/FTP in degrees, minutes and seconds.

Parameters:
<LongitudeDeg> integer

Range: 0  to  180
*RST: 0

<LongitudeMin> integer
Defines the longitude minutes.
Range: 0  to  59
*RST: 0

<LongitudeSec> float
Defines the longitude seconds.
Range: 0  to  59.999
Increment: 0.001
*RST: 0

<LongitudeDir> EAST | WEST
Defines the longitude direction.
*RST: EAST

<LatitudeDeg> integer
Defines the latitude degrees.
Range: 0  to  90
*RST: 0

<LatitudeMin> integer
Defines the latitude minutes.
Range: 0  to  59
*RST: 0
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<LatitudeSec> float
Defines the latitude seconds.
Range: 0  to  59.999
Increment: 0.001
*RST: 0

<LatitudeDir> NORTh | SOUTh
Defines the latitude direction.
*RST: NORT

Example: see example "Generating a GBAS signal containing message
type 4" on page 112

Manual operation: See "LTP/FTP Location Configuration" on page 37

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LFLocation:HEIGht <LfHeight>

Sets the LTP/FTP height.

Parameters:
<LfHeight> float

Range: -512  to  6041.5
Increment: 0.1
*RST: 0

Example: see example "Generating a GBAS signal containing message
type 4" on page 112

Manual operation: See "Plan View/Profile View Parameters" on page 36

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LMVariation <Lmv>

Sets the local magnetic variation.

Parameters:
<Lmv> float

A positive value represents an east variation (clockwise from
true north)
Range: -180  to  180
Increment: 0.01
*RST: 0
Default unit: deg

Example: see example "Generating a GBAS signal for message format
detection" on page 111

Manual operation: See "Local Magnetic Variation" on page 32
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[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LOCation:COORdinates:DECimal
<Longitude>, <Latitude>, <Altitude>

Defines the coordinates of the ground station reference location in decimal format.

Parameters:
<Longitude> float

Range: -180  to  180
Increment: 1E-6
*RST: 0

<Latitude> float
Range: -90  to  90
Increment: 1E-6
*RST: 0

<Altitude> float
Range: -83886.07  to  83886.07
Increment: 0.01
*RST: 0

Example: see example "Generating a GBAS signal for message format
detection" on page 111

Manual operation: See "Reference Location Configuration" on page 33

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LOCation:COORdinates:DMS
<LongitudeDeg>, <LongitudeMin>, <LongitudeSec>, <LongitudeDir>,
<LatitudeDeg>, <LatitudeMin>, <LatitudeSec>, <LatitudeDir>, <Altitude>

Defines the coordinates of the ground station reference location in degrees, minutes
and seconds.

Parameters:
<LongitudeDeg> integer

Range: 0  to  180
*RST: 0

<LongitudeMin> integer
Defines the longitude minutes.
Range: 0  to  59
*RST: 0

<LongitudeSec> float
Defines the longitude seconds.
Range: 0  to  59.999
Increment: 0.001
*RST: 0
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<LongitudeDir> EAST | WEST
Defines the longitude direction.
*RST: EAST

<LatitudeDeg> integer
Defines the latitude degrees.
Range: 0  to  90
*RST: 0

<LatitudeMin> integer
Defines the latitude minutes.
Range: 0  to  59
*RST: 0

<LatitudeSec> float
Defines the latitude seconds.
Range: 0  to  59.999
Increment: 0.001
*RST: 0

<LatitudeDir> NORTh | SOUTh
Defines the latitude direction.
*RST: NORT

<Altitude> float
Defines the height above the ellipsoid (HAE) altitude.
Range: -83886.07  to  83886.07
Increment: 0.01
*RST: 0

Example: see example "Generating a GBAS signal for message format
detection" on page 111

Manual operation: See "Reference Location Configuration" on page 33

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:MT2State <Mt2State>

Enables the message type 2 configuration.

Parameters:
<Mt2State> 0 | 1 | OFF | ON

*RST: 0

Example: see example "Generating a GBAS signal for message format
detection" on page 111

Manual operation: See "Message Type 2" on page 31

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:MT4State <Mt4State>

Enables the configuration of message type 4.
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Parameters:
<Mt4State> 0 | 1 | OFF | ON

*RST: 0

Example: see example "Generating a GBAS signal containing message
type 4" on page 112

Manual operation: See "Message Type 4" on page 34

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:NOPPoint <Nofp>

Queries the number of path points - N.

Parameters:
<Nofp> integer

Range: 2  to  11
*RST: 2

Example: see example "Generating a GBAS signal containing message
type 4" on page 112

Manual operation: See "Number of Path Points - N" on page 40

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RFINdex <RefIdx>

Sets the refractivity index.

Parameters:
<RefIdx> integer

Range: 16  to  781
*RST: 16

Example: see example "Generating a GBAS signal for message format
detection" on page 111

Manual operation: See "Refractivity Index" on page 32

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RLETter <Rlet>

Sets the runway letter.

Parameters:
<Rlet> NLETter | LETR | LETL | LETC

*RST: NLETter

Example: see example "Generating a GBAS signal containing message
type 4" on page 112

Manual operation: See "Runway Letter" on page 37
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[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RNUMber <Rnum>

Sets the runway number.

Parameters:
<Rnum> integer

Range: 1  to  36
*RST: 1

Example: see example "Generating a GBAS signal containing message
type 4" on page 112

Manual operation: See "Runway Number" on page 37

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RPDF <Rpdf>

Sets the reference path data selector for FAS.

Parameters:
<Rpdf> integer

Range: 0  to  48
*RST: 1

Example: see example "Generating a GBAS signal containing message
type 4" on page 112

Manual operation: See "Reference Path Data Selector" on page 37

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RPDT <Rpdt>

Sets the reference path data selector.

Parameters:
<Rpdt> integer

Range: 0  to  254
*RST: 1

Example: see example "Generating a GBAS signal containing message
type 4" on page 112

Manual operation: See "Reference Path Data Selector" on page 40

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RPIF <Rpif>

Sets the reference path identifier for FAS.

Parameters:
<Rpif> string

three or four alphanumeric character

Example: see example "Generating a GBAS signal containing message
type 4" on page 112

Manual operation: See "Reference Path ID" on page 37
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[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RPIT <Rpit>

Sets the reference path identifier for TAP.

Parameters:
<Rpit> string

three or four alphanumeric characters

Example: see example "Generating a GBAS signal containing message
type 4" on page 112

Manual operation: See "Reference Path ID" on page 40

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RUINdicator <Ruin>

Sets the route indicator.

Parameters:
<Ruin> a single upper case alphabetic character

Allowed are letters, excluding “I” and “O”, or the “space” charac-
ter.

Example: see example "Generating a GBAS signal containing message
type 4" on page 112

Manual operation: See "Route Indicator" on page 37

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RUNCertainty <Runc>

Set the refractivity uncertainty.

Parameters:
<Runc> integer

Range: 0  to  255
*RST: 0

Example: see example "Generating a GBAS signal for message format
detection" on page 111

Manual operation: See "Refractivity Uncertainty" on page 32

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SHEight <SHeight>

Sets the scale height.

Parameters:
<SHeight> float

Range: 0  to  25500
Increment: 100
*RST: 0
Default unit: m
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Example: see example "Generating a GBAS signal for message format
detection" on page 111

Manual operation: See "Scale Height" on page 32

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SVIGradient <Svig>

Sets the Sigma_vert_iono_gradient.

Parameters:
<Svig> float

Range: 0  to  2.54999999356187e-05
Increment: 0.1e-6
*RST: 0

Example: see example "Generating a GBAS signal for message format
detection" on page 111

Manual operation: See "Sigma_vert_iono_gradient" on page 32

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:TDSState <Tdss>

Enables the configuration of the Terminal Area Path (TAP) data set.

Parameters:
<Tdss> 0 | 1 | OFF | ON

*RST: 1

Example: see example "Generating a GBAS signal containing message
type 4" on page 112

Manual operation: See "TAP Data Set" on page 39

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:TLAS <Tlas>

Sets the value of the broadcast lateral alert limit.

Parameters:
<Tlas> float

Range: 0  to  2.54
Increment: 0.01
*RST: 0

Example: see example "Generating a GBAS signal containing message
type 4" on page 112

Manual operation: See "TAP Lateral Alert Limit / Status" on page 41

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:TVAS <Tvas>

Sets the value of the broadcast vertical alert limit.
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Parameters:
<Tvas> float

Range: 0  to  127
Increment: 0.5
*RST: 0

Example: see example "Generating a GBAS signal containing message
type 4" on page 112

Manual operation: See "TAP Vertical Alert Limit / Status" on page 41

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:WAYPoint:PREDefined:CATalog?
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:WAYPoint:USER:CATalog?
Queries the names of the existing user defined/predefined waypoint files.

Per default, the instrument stores user defined files in the /var/user/ directory. Use
the command MMEM:CDIRectory to change the default directory to the currently used
one.

Only files with extension *.txt are listed.

Example: see example "Generating a GBAS signal containing message
type 4" on page 112

Usage: Query only

Manual operation: See "Waypoint File" on page 40

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:WAYPoint:PREDefined:FILE
<WpFile>

Loads the selected predeifned file (extension *.txt).

Setting parameters: 
<WpFile> string

Only the file name is required

Example: see example "Generating a GBAS signal containing message
type 4" on page 112

Usage: Setting only

Manual operation: See "Waypoint File" on page 40

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:WAYPoint:USER:FILE <Filename>

Loads the selected user-defined file (extension *.txt).

Per default, the instrument stores user defined files in the /var/user/ directory. Use
the command MMEM:CDIRectory to change the default directory to the currently used
one.
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Setting parameters: 
<Filename> string

For files stored in the default directory, only the file name is
required.

Example: see example "Generating a GBAS signal containing message
type 4" on page 112

Usage: Setting only

Manual operation: See "Waypoint File" on page 40

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:WAYPoint:FILE?

Queries the currently selected waypoint file.

Return values: 
<Filename> string

filename with file extension (*.txt)

Example: see example "Generating a GBAS signal containing message
type 4" on page 112

Usage: Query only

Manual operation: See "Waypoint File" on page 40

10.2.6 Filter, Clipping, Modulation Settings

[:SOURce<hw>]:BB:GBAS:FILTer:TYPE <Type>

The command selects the filter type.

Parameters:
<Type> RCOSine | COSine | GAUSs | LGAuss | CONE | COF705 |

COEQualizer | COFequalizer | C2K3x | APCO25 | SPHase |
RECTangle | PGAuss | LPASs | DIRac | ENPShape |
EWPShape | LPASSEVM
*RST: COSine

Example: see example "Quering the default filter, clipping and modulation
settings" on page 114

Manual operation: See "Filter" on page 43

[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:APCO25 <Apco25>
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:COSine <Cosine>
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:COSine:COFS <CoFs>
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:GAUSs <Gauss>
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:LPASs <LPass>
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:LPASSEVM <LPassevm>
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:PGAuss <PGauss>
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[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:RCOSine <RCosine>
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:SPHase <SPhase>

Sets the corresponding filter parameter.

Filter Type Parameter Parameter Name min max increment default

APCO25 roll-off factor <Apco25> 0.05 0.99 0.01 0.2

COSine roll-off factor <Cosine> 0.05 1.00 0.01 0.35

COSine cut off frequency shift <CoFs> -1 1 0.01 0

GAUSs roll-off factor <Gauss> 0.15 2.5 0.01 0.3

LPASs cut off frequency <LPass> 0.05 2 0.01 0.5

LPASSEVM cut off frequency <LPassEvm> 0.05 2 0.01 0.5

PGAuss roll-off factor <PGauss> 0.15 2.5 0.01 0.3

RCOSine roll-off factor <RCosine> 0.05 1.00 0.01 0.35

SPHase B x T <SPhase> 0.15 2.5 0.01 2

Parameters:
<SPhase> float

Range: 0.15  to  2.5
Increment: 0.01
*RST: 2

Example: see example "Quering the default filter, clipping and modulation
settings" on page 114

Manual operation: See "Roll Off Factor or BxT" on page 43

[:SOURce<hw>]:BB:GBAS:CLIPping:STATe <State>

Enables/disable clipping.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: see example "Quering the default filter, clipping and modulation
settings" on page 114

Manual operation: See "Clipping State" on page 45

[:SOURce<hw>]:BB:GBAS:CLIPping:LEVel <Level>

Sets the limit for clipping.

Parameters:
<Level> integer

Range: 1  to  100
*RST: 100
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Example: see example "Quering the default filter, clipping and modulation
settings" on page 114

Manual operation: See "Clipping Level" on page 46

[:SOURce<hw>]:BB:GBAS:CLIPping:MODE <Mode>

Sets the clipping mode.

Parameters:
<Mode> VECTor | SCALar

*RST: VECTor

Example: see example "Quering the default filter, clipping and modulation
settings" on page 114

Manual operation: See "Clipping Mode" on page 46

[:SOURce<hw>]:BB:GBAS:MSET:MTYPe?

Queries the used modulation.

Return values: 
<MType> string

*RST: D8PSK

Example: see example "Quering the default filter, clipping and modulation
settings" on page 114

Usage: Query only

Manual operation: See "Modulation Type" on page 45

[:SOURce<hw>]:BB:GBAS:MSET:SRATe?

Queries the used sample rate.

Return values: 
<SRate> float

Range: 10.49E3  to  10.51E3
Increment: 1E-3
*RST: 10.5E3

Example: see example "Quering the default filter, clipping and modulation
settings" on page 114

Usage: Query only

Manual operation: See "Sample Rate Variation/Sample Rate Info" on page 26
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10.3 ILS Settings

The BB:ILS subsystem contains all commands for configuring a ILS signal.

See also chapter 10.6, "Trigger Settings ", on page 181 and chapter 10.9, "Clock Set-
tings", on page 191 for a description of the trigger and clock settings.

10.3.1 General Settings

[:SOURce<hw>]:BB:ILS:PRESet..................................................................................... 139
[:SOURce<hw>]:BB:ILS:STATe.......................................................................................139
[:SOURce<hw>]:BB:ILS:TYPE.........................................................................................139

[:SOURce<hw>]:BB:ILS:PRESet

Sets the ILS default settings.

[:SOURce<hw>]:BB:ILS:STATe <State>

Activates/deactivates the ILS modulation.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

[:SOURce<hw>]:BB:ILS:TYPE <Type>

Selects the ILS modulation type.

Parameters:
<Type> GS | LOCalize | GSLope | MBEacon

*RST: GS

Manual operation: See "ILS Component" on page 48

10.3.2 ILS Glide Slope Settings

[:SOURce<hw>]:BB:ILS[:GS|GSLope]:DDM:COUPling...................................................... 140
[:SOURce<hw>]:BB:ILS[:GS|GSLope]:DDM:CURRent.......................................................140
[:SOURce<hw>]:BB:ILS[:GS|GSLope]:DDM:DIRection...................................................... 140
[:SOURce<hw>]:BB:ILS[:GS|GSLope]:DDM:LOGarithmic.................................................. 141
[:SOURce<hw>]:BB:ILS[:GS|GSLope]:DDM:PCT.............................................................. 141
[:SOURce<hw>]:BB:ILS[:GS|GSLope]:DDM:POLarity........................................................141
[:SOURce<hw>]:BB:ILS[:GS|GSLope]:DDM:STEP............................................................ 141
[:SOURce<hw>]:BB:ILS[:GS|GSLope]:DDM:DEPTh.......................................................... 142
[:SOURce<hw>]:BB:ILS[:GS|GSLope]:FREQuency........................................................... 142
[:SOURce<hw>]:BB:ILS[:GS|GSLope]:FREQuency:MODE.................................................142
[:SOURce<hw>]:BB:ILS[:GS|GSLope]:ICAO:CHANnel.......................................................142
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[:SOURce<hw>]:BB:ILS[:GS|GSLope]:LLOBe[:FREQuency].............................................. 143
[:SOURce<hw>]:BB:ILS[:GS|GSLope]:MODE................................................................... 143
[:SOURce<hw>]:BB:ILS[:GS|GSLope]:PHASe.................................................................. 143
[:SOURce<hw>]:BB:ILS[:GS|GSLope]:SDM......................................................................144
[:SOURce<hw>]:BB:ILS[:GS|GSLope]:ULOBe[:FREQuency]..............................................144

[:SOURce<hw>]:BB:ILS[:GS|GSLope]:DDM:COUPling <Coupling>

Selects if the DDM value is fixed or is changed with a change of sum of modulation
depths (SDM, see [:SOURce<hw>]:BB:ILS[:GS|GSLope]:SDM on page 144).

Parameters:
<Coupling> FIXed | SDM

*RST: FIXed

Manual operation: See "DDM - SDM Coupling" on page 53

[:SOURce<hw>]:BB:ILS[:GS|GSLope]:DDM:CURRent <Current>

Sets the DDM value alternatively as a current by means of the ILS indicating instru-
ment. The instrument current is calculated according to:

DDM uA = DDM × 857,1 uA

A variation of the instrument current automatically leads to a variation of the DDM
value and the DDM value in dB.

Parameters:
<Current> float

Range: -8.57125E-4  to  8.57125E-4
Increment: 1E-7
*RST: 0

Manual operation: See "DDM Current" on page 52

[:SOURce<hw>]:BB:ILS[:GS|GSLope]:DDM:DIRection <Direction>

Sets the simulation mode for the ILS-GS modulation signal. A change of the setting
automatically changes the sign of the DDM value.

Parameters:
<Direction> UP | DOWN

UP
The 150-Hz modulation signal is predominant, the DDM value is
negative (the airplane is too low, it must climb).
DOWN
The 90-Hz modulation signal is predominant, the DDM value is
positive (the airplane is too high, it must descend).
*RST: UP

Manual operation: See "Fly" on page 52
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[:SOURce<hw>]:BB:ILS[:GS|GSLope]:DDM:LOGarithmic <Logarithmic>

Sets the depth of modulation value for the ILS-GS in dB.

See also [:SOURce<hw>]:BB:ILS[:GS|GSLope]:DDM:DEPTh on page 142.

Parameters:
<Logarithmic> float

Range: -999.9  to  999.9
Increment: 1E-4
*RST: 0

Manual operation: See "DDM Logarithmic" on page 53

[:SOURce<hw>]:BB:ILS[:GS|GSLope]:DDM:PCT <Pct>

Sets the difference in depth of modulation between the signal of the upper lobe (90 Hz)
and the lower lobe (150 Hz). The maximum value equals the sum of the modulation
depths of the 90 Hz and the 150 Hz tone.

See also [:SOURce<hw>]:BB:ILS[:GS|GSLope]:DDM:DEPTh on page 142.

Parameters:
<Pct> float

Range: -80.0  to  80.0
Increment: 0.01
*RST: 0

Manual operation: See "DDM Percent" on page 53

[:SOURce<hw>]:BB:ILS[:GS|GSLope]:DDM:POLarity <Polarity>

Sets the polarity for DDM calculation (see [:SOURce<hw>]:BB:ILS[:GS|GSLope]:
DDM:DEPTh).

The DDM depth calculation depends on the selected polarity:

● Polarity 90 Hz - 150 Hz (default setting):
DDM = [ AM(90 Hz) - AM (150 Hz) ] / 100%

● Polarity 150 Hz - 90 Hz:
DDM = [ AM(150 Hz) - AM (90 Hz) ] / 100%

Parameters:
<Polarity> P90_150 | P150_90

*RST: P90_150

Manual operation: See "DDM Polarity" on page 50

[:SOURce<hw>]:BB:ILS[:GS|GSLope]:DDM:STEP <DdmStep>

Sets the variation of the difference in depth of modulation via the rotary knob.
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Parameters:
<DdmStep> DECimal | PREDefined

*RST: DECimal

[:SOURce<hw>]:BB:ILS[:GS|GSLope]:DDM:DEPTh <Depth>

Sets the difference in depth of modulation between the signal of the upper/left lobe (90
Hz) and the lower/right lobe (150 Hz). The maximum value equals the sum of the mod-
ulation depths of the 90 Hz and the 150 Hz tone.The following is true:

ILS:GS|GSL:DDM:DEPTh = (AM(90Hz) - AM(150Hz))/100%
A variation of the DDM value automatically leads to a variation of the DDM value in dB
and the value of the instrument current.

Parameters:
<Depth> float

Range: -0.8  to  0.8
Increment: 1E-4
*RST: 0

Manual operation: See "DDM Depth" on page 52

[:SOURce<hw>]:BB:ILS[:GS|GSLope]:FREQuency <CarrierFreq>

Sets the carrier frequency if [:SOURce<hw>]:BB:ILS[:GS|GSLope]:FREQuency:
MODE is set to USER.

Parameters:
<CarrierFreq> float

Range: 100E3  to  6E9
Increment: 0.01
*RST: 334.7e6

Manual operation: See "Carrier Frequency" on page 50

[:SOURce<hw>]:BB:ILS[:GS|GSLope]:FREQuency:MODE <Mode>

Sets the carrier frequency mode for the ILS-GS modulation signal.

Parameters:
<Mode> USER | ICAO

*RST: USER

Manual operation: See "Carrier Frequency Mode" on page 49

[:SOURce<hw>]:BB:ILS[:GS|GSLope]:ICAO:CHANnel <Channel>

Selects the ICAO channel i.e., the ILS-GS transmitting frequency. The RF frequency is
set to the value selected here. The ICAO channel settings for ILS-GS and ILS-LOC are
coupled.
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Parameters:
<Channel> CH18X | CH18Y | CH20X | CH20Y | CH22X | CH22Y | CH24X |

CH24Y | CH26X | CH26Y | CH28X | CH28Y | CH30X | CH30Y |
CH32X | CH32Y | CH34X | CH34Y | CH36X | CH36Y | CH38X |
CH38Y | CH40X | CH40Y | CH42X | CH42Y | CH44X | CH44Y |
CH46X | CH46Y | CH48X | CH48Y | CH50X | CH50Y | CH52X |
CH52Y | CH54X | CH54Y | CH56X | CH56Y
*RST: CH18X

Manual operation: See "ICAO Channel" on page 50

[:SOURce<hw>]:BB:ILS[:GS|GSLope]:LLOBe[:FREQuency] <Frequency>

Sets the modulation frequency of the antenna lobe arranged at the bottom viewed from
the air plane for the ILS-GS modulation signal.

Parameters:
<Frequency> float

Range: 100  to  200
Increment: 0.05
*RST: 150

Manual operation: See "Down Frequency" on page 51

[:SOURce<hw>]:BB:ILS[:GS|GSLope]:MODE <Mode>

Sets the operating mode for the ILS-GS modulation signal.

Parameters:
<Mode> NORM | ULOBe | LLOBe

NORM
ILS-GS modulation is active.
ULOBe
Amplitude modulation of the output signal with the upper lobe
(90Hz) signal component of the ILS-GS signal is active.
LLOBe
Amplitude modulation of the output signal with the lower lobe
(150Hz) signal component of the ILS-GS signal is active.
*RST: NORM

Manual operation: See "Mode" on page 50

[:SOURce<hw>]:BB:ILS[:GS|GSLope]:PHASe <Phase>

Sets the phase between the modulation signals of the upper and lower antenna lobe of
the ILS-GS signal. The zero crossing of the lower lobe (150Hz) signal serves as a ref-
erence. The angle refers to the period of the signal of the right antenna lobe.

ILS Settings



Remote-Control CommandsAvionics Standards

144Operating Manual 1176.8600.02 ─ 05

Parameters:
<Phase> float

Range: -60  to  120
Increment: 0.01
*RST: 0.0

Manual operation: See "Up/Down Phase" on page 51

[:SOURce<hw>]:BB:ILS[:GS|GSLope]:SDM <Sdm>

Sets the arithmetic sum of the modulation depths of the upper lobe (90Hz) and lower
lobe (150Hz) for the ILS-GS signal contents. The RMS modulation depth of the sum
signal depends on the phase setting of both modulation tones.

Parameters:
<Sdm> float

Range: 0  to  100
Increment: 0.1
*RST: 80

Manual operation: See "Sum of Depth (SDM)" on page 52

[:SOURce<hw>]:BB:ILS[:GS|GSLope]:ULOBe[:FREQuency] <Frequency>

Sets the modulation frequency of the antenna lobe arranged at the top viewed from the
air plane (up frequency).

Parameters:
<Frequency> float

Range: 60  to  120
Increment: 0.03
*RST: 90

Manual operation: See "Up Frequency" on page 51

10.3.3 ILS Localizer Settings

[:SOURce<hw>]:BB:ILS:LOCalizer:COMid:CODE............................................................. 145
[:SOURce<hw>]:BB:ILS:LOCalizer:COMid:DASH..............................................................145
[:SOURce<hw>]:BB:ILS:LOCalizer:COMid:DEPTh............................................................ 145
[:SOURce<hw>]:BB:ILS:LOCalizer:COMid:DOT................................................................146
[:SOURce<hw>]:BB:ILS:LOCalizer:COMid:FREQuency..................................................... 146
[:SOURce<hw>]:BB:ILS:LOCalizer:COMid:LETTer............................................................146
[:SOURce<hw>]:BB:ILS:LOCalizer:COMid:PERiod............................................................146
[:SOURce<hw>]:BB:ILS:LOCalizer:COMid:SYMBol...........................................................147
[:SOURce<hw>]:BB:ILS:LOCalizer:COMid:TSCHema........................................................147
[:SOURce<hw>]:BB:ILS:LOCalizer:COMid[:STATe]...........................................................147
[:SOURce<hw>]:BB:ILS:LOCalizer:DDM:COUPling...........................................................147
[:SOURce<hw>]:BB:ILS:LOCalizer:DDM:CURRent............................................................148
[:SOURce<hw>]:BB:ILS:LOCalizer:DDM:DIRection........................................................... 148
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[:SOURce<hw>]:BB:ILS:LOCalizer:DDM:LOGarithmic....................................................... 148
[:SOURce<hw>]:BB:ILS:LOCalizer:DDM:PCT...................................................................149
[:SOURce<hw>]:BB:ILS:LOCalizer:DDM:POLarity.............................................................149
[:SOURce<hw>]:BB:ILS:LOCalizer:DDM:DEPTh...............................................................149
[:SOURce<hw>]:BB:ILS:LOCalizer:FREQuency................................................................ 150
[:SOURce<hw>]:BB:ILS:LOCalizer:FREQuency:MODE..................................................... 150
[:SOURce<hw>]:BB:ILS:LOCalizer:ICAO:CHANnel........................................................... 150
[:SOURce<hw>]:BB:ILS:LOCalizer:LLOBe[:FREQuency]................................................... 150
[:SOURce<hw>]:BB:ILS:LOCalizer:MODE........................................................................151
[:SOURce<hw>]:BB:ILS:LOCalizer:PHASe....................................................................... 151
[:SOURce<hw>]:BB:ILS:LOCalizer:RLOBe[:FREQuency]...................................................151
[:SOURce<hw>]:BB:ILS:LOCalizer:SDM.......................................................................... 152

[:SOURce<hw>]:BB:ILS:LOCalizer:COMid:CODE <Code>

Sets the coding of the COM/ID signal by the international short name of the airport
(e.g. MUC for the Munich airport).

Available only if [:SOURce<hw>]:BB:ILS:LOCalizer:COMid:TSCHema is set to
USER.

Parameters:
<Code> string

Manual operation: See "Code" on page 58

[:SOURce<hw>]:BB:ILS:LOCalizer:COMid:DASH <Dash>

Sets the length of a morse dash in seconds.

Available only if [:SOURce<hw>]:BB:ILS:LOCalizer:COMid:TSCHema is set to
USER.

Parameters:
<Dash> float

Range: 0.05  to  1
Increment: 1E-4
*RST: 0.3

Manual operation: See "Dash Length" on page 59

[:SOURce<hw>]:BB:ILS:LOCalizer:COMid:DEPTh <Depth>

Sets the AM modulation depth of the of the COM/ID signal.

Parameters:
<Depth> float

Range: 0  to  100
Increment: 0.1
*RST: 10

Manual operation: See "Depth" on page 59
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[:SOURce<hw>]:BB:ILS:LOCalizer:COMid:DOT <Dot>

Sets the length of a morse dot in seconds. If the time schema is set to STD the length
of the dash (3xdot), symbol space (=dot) and letter space (=3xdot) is also determined
by this entry.

Parameters:
<Dot> float

Range: 0.05  to  1
Increment: 1E-4
*RST: 0.1

Manual operation: See "Dot Length" on page 59

[:SOURce<hw>]:BB:ILS:LOCalizer:COMid:FREQuency <Frequency>

Sets the frequency of the COM/ID signal.

Parameters:
<Frequency> float

Range: 0.1  to  20E3
Increment: 0.01
*RST: 1020

Manual operation: See "Frequency" on page 58

[:SOURce<hw>]:BB:ILS:LOCalizer:COMid:LETTer <Letter>

Sets the length of a letter space in seconds.

Available only if [:SOURce<hw>]:BB:ILS:LOCalizer:COMid:TSCHema is set to
USER.

Parameters:
<Letter> float

Range: 0.05  to  1
Increment: 1E-4
*RST: 0.3

Manual operation: See "Letter Space" on page 59

[:SOURce<hw>]:BB:ILS:LOCalizer:COMid:PERiod <Period>

Sets the period of the COM/ID signal in seconds.

Parameters:
<Period> float

Range: 0  to  120
Increment: 1E-3
*RST: 9

Manual operation: See "Period" on page 59
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[:SOURce<hw>]:BB:ILS:LOCalizer:COMid:SYMBol <Symbol>

Sets the length of the symbol space in seconds.

Available only if [:SOURce<hw>]:BB:ILS:LOCalizer:COMid:TSCHema is set to
USER.

Parameters:
<Symbol> float

Range: 0.05  to  1
Increment: 1E-4
*RST: 0.1

Manual operation: See "Symbol Space" on page 59

[:SOURce<hw>]:BB:ILS:LOCalizer:COMid:TSCHema <TSchema>

Sets the time schema for the COM/ID signal.

In the standard time schema (STD) the set dot length determines the dash length (=
three times the dot length) whereas in the user time schema (USER) all length param-
eters can be set independently.

Parameters:
<TSchema> STD | USER

*RST: STD

Manual operation: See "Time Schema" on page 59

[:SOURce<hw>]:BB:ILS:LOCalizer:COMid[:STATe] <State>

Switches on/ off the addittional COM/ID signal.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Manual operation: See "State" on page 58

[:SOURce<hw>]:BB:ILS:LOCalizer:DDM:COUPling <Coupling>

Selects if the DDM value is fixed or is changed with a change of sum of modulation
depths (SDM, see[:SOURce<hw>]:BB:ILS:LOCalizer:SDM on page 152).

Parameters:
<Coupling> FIXed | SDM

*RST: FIXed

Manual operation: See "DDM - SDM Coupling" on page 57
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[:SOURce<hw>]:BB:ILS:LOCalizer:DDM:CURRent <Current>

Sets the DDM value alternatively as a current by means of the ILS indicating instru-
ment. The instrument current is calculated according to:

DDM uA = DDM × 857,1 uA

A variation of the instrument current automatically leads to a variation of the DDM
value and the DDM value in dB.

Parameters:
<Current> float

Range: -9.6775E-4  to  9.6775E-4
Increment: 1E-7
*RST: 0

Manual operation: See "DDM Current" on page 56

[:SOURce<hw>]:BB:ILS:LOCalizer:DDM:DIRection <Direction>

Sets the simulation mode for the ILS-LOC modulation signal. A change of the setting
automatically changes the sign of the DDM value.

Parameters:
<Direction> LEFT | RIGHt

LEFT
The 150-Hz modulation signal is predominant, the DDM value is
negative (the airplane is too far to the right, it must turn to the
left).
RIGHT
The 90-Hz modulation signal is predominant, the DDM value is
positive (the airplane is too far to the left, it must turn to the
right).
*RST: LEFT

Manual operation: See "Fly" on page 56

[:SOURce<hw>]:BB:ILS:LOCalizer:DDM:LOGarithmic <Logarithmic>

Sets the depth of modulation value for the ILS-LOC in dB.

See also [:SOURce<hw>]:BB:ILS:LOCalizer:DDM:DEPTh on page 149.

Parameters:
<Logarithmic> float

Range: -999.9  to  999.9
Increment: 1E-4
*RST: 0

Manual operation: See "DDM Logarithmic" on page 57
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[:SOURce<hw>]:BB:ILS:LOCalizer:DDM:PCT <Pct>

Sets the difference in depth of modulation between the signal of the left lobe (90 Hz)
and the right lobe (150 Hz). The maximum value equals the sum of the modulation
depths of the 90 Hz and the 150 Hz tone.

See also [:SOURce<hw>]:BB:ILS:LOCalizer:DDM:DEPTh on page 149.

Parameters:
<Pct> float

Range: -80.0  to  80.0
Increment: 0.01
*RST: 0

Manual operation: See "DDM Percent" on page 57

[:SOURce<hw>]:BB:ILS:LOCalizer:DDM:POLarity <Polarity>

Sets the polarity for DDM calculation (see [:SOURce<hw>]:BB:ILS:LOCalizer:
DDM:DEPTh on page 149).

The DDM depth calculation depends on the selected polarity:

● Polarity 90 Hz - 150 Hz (default setting):
DDM = [ AM(90 Hz) - AM (150 Hz) ] / 100%

● Polarity 150 Hz - 90 Hz:
DDM = [ AM(150 Hz) - AM (90 Hz) ] / 100%

Parameters:
<Polarity> P90_150 | P150_90

*RST: P90_150

Manual operation: See "DDM polarity" on page 54

[:SOURce<hw>]:BB:ILS:LOCalizer:DDM:DEPTh <Depth>

Sets the difference in depth of modulation between the signal of the upper/left lobe (90
Hz) and the lower/right lobe (150 Hz). The maximum value equals the sum of the mod-
ulation depths of the 90 Hz and the 150 Hz tone.The following is true:

ILS:LOC:DDM:DEPTh = (AM(90Hz) - AM(150Hz))/100%
A variation of the DDM value automatically leads to a variation of the DDM value in dB
and the value of the instrument current.

Parameters:
<Depth> float

Range: -0.4  to  0.4
Increment: 1E-4
*RST: 0

Manual operation: See "DDM Depth" on page 57
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[:SOURce<hw>]:BB:ILS:LOCalizer:FREQuency <CarrierFreq>

Sets the carrier frequency if [:SOURce<hw>]:BB:ILS:LOCalizer:FREQuency:
MODE is set to USER.

Parameters:
<CarrierFreq> float

Range: 100E3  to  6E9
Increment: 0.01
*RST: 108.1e6

Manual operation: See "Carrier Frequency" on page 54

[:SOURce<hw>]:BB:ILS:LOCalizer:FREQuency:MODE <Mode>

Sets the carrier frequency mode for the ILS-LOC modulation signal.

Parameters:
<Mode> USER | ICAO

*RST: USER

Manual operation: See "Carrier Frequency Mode" on page 49

[:SOURce<hw>]:BB:ILS:LOCalizer:ICAO:CHANnel <Channel>

Selects the ICAO channel i.e., the ILS-LOC transmitting frequency. The RF frequency
is set to the value selected here. The ICAO channel settings for ILS-GS and ILS-LOC
are coupled.

Parameters:
<Channel> CH18X | CH18Y | CH20X | CH20Y | CH22X | CH22Y | CH24X |

CH24Y | CH26X | CH26Y | CH28X | CH28Y | CH30X | CH30Y |
CH32X | CH32Y | CH34X | CH34Y | CH36X | CH36Y | CH38X |
CH38Y | CH40X | CH40Y | CH42X | CH42Y | CH44X | CH44Y |
CH46X | CH46Y | CH48X | CH48Y | CH50X | CH50Y | CH52X |
CH52Y | CH54X | CH54Y | CH56X | CH56Y
*RST: CH18X

Manual operation: See "ICAO Channel" on page 50

[:SOURce<hw>]:BB:ILS:LOCalizer:LLOBe[:FREQuency] <Frequency>

Sets the modulation frequency of the antenna lobe arranged at the bottom viewed from
the air plane for the ILS-LOC modulation signal.

Parameters:
<Frequency> float

Range: 60  to  120
Increment: 0.03
*RST: 90
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Manual operation: See "Left Frequency" on page 55

[:SOURce<hw>]:BB:ILS:LOCalizer:MODE <Mode>

Sets the operating mode for the ILS-LOC modulation signal.

Parameters:
<Mode> NORM | LLOBe | RLOBe

NORM
ILS-LOC modulation is active.
LLOBe
Amplitude modulation of the output signal with the left lobe
(90Hz) signal component of the ILS-LOC signal is active.
RLOBe
Amplitude modulation of the output signal with the right lobe
(150Hz) signal component of the ILS-LOC signal is active.
*RST: NORM

Manual operation: See "Mode" on page 55

[:SOURce<hw>]:BB:ILS:LOCalizer:PHASe <Phase>

Sets the phase between the modulation signals of the left and right antenna lobe of the
ILS-GS signal. The zero crossing of the right lobe (150Hz) signal serves as a refer-
ence. The angle refers to the period of the signal of the right antenna lobe.

Parameters:
<Phase> float

Range: -60  to  120
Increment: 0.01
*RST: 0

Manual operation: See "Left/Right Phase" on page 55

[:SOURce<hw>]:BB:ILS:LOCalizer:RLOBe[:FREQuency] <Frequency>

Sets the modulation frequency of the antenna lobe arranged at the right viewed from
the air plane.

Parameters:
<Frequency> float

Range: 100  to  200
Increment: 0.05
*RST: 150

Manual operation: See "Right Frequency" on page 55
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[:SOURce<hw>]:BB:ILS:LOCalizer:SDM <Sdm>

Sets the arithmetic sum of the modulation depths of the left lobe (90Hz) and right lobe
(150Hz) for the ILS-LOC signal contents. The RMS modulation depth of the sum signal
depends on the phase setting of both modulation tones.

Parameters:
<Sdm> float

Range: 0  to  100
Increment: 0.1
*RST: 40

Manual operation: See "Sum of Depth" on page 56

10.3.4 ILS Marker Beacon Settings

[:SOURce<hw>]:BB:ILS:MBEacon:COMid:CODE..............................................................152
[:SOURce<hw>]:BB:ILS:MBEacon:COMid:DASH.............................................................. 152
[:SOURce<hw>]:BB:ILS:MBEacon:COMid:DEPTh.............................................................153
[:SOURce<hw>]:BB:ILS:MBEacon:COMid:DOT................................................................ 153
[:SOURce<hw>]:BB:ILS:MBEacon:COMid:FREQuency..................................................... 153
[:SOURce<hw>]:BB:ILS:MBEacon:COMid:LETTer............................................................ 153
[:SOURce<hw>]:BB:ILS:MBEacon:COMid:PERiod............................................................ 154
[:SOURce<hw>]:BB:ILS:MBEacon:COMid:SYMBol........................................................... 154
[:SOURce<hw>]:BB:ILS:MBEacon:COMid:TSCHema........................................................154
[:SOURce<hw>]:BB:ILS:MBEacon:COMid[:STATe]........................................................... 155
[:SOURce<hw>]:BB:ILS:MBEacon:FREQuency................................................................ 155
[:SOURce<hw>]:BB:ILS:MBEacon:FREQuency:MODE......................................................155
[:SOURce<hw>]:BB:ILS:MBEacon:MARKer:FREQuency................................................... 155
[:SOURce<hw>]:BB:ILS:MBEacon[:MARKer]:DEPTh.........................................................155

[:SOURce<hw>]:BB:ILS:MBEacon:COMid:CODE <Code>

Sets the coding of the COM/ID signal by the international short name of the airport
(e.g. MUC for the Munich airport).

Parameters:
<Code> string

Manual operation: See "Code" on page 61

[:SOURce<hw>]:BB:ILS:MBEacon:COMid:DASH <Dash>

Sets the length of a morse dash in seconds.

Available only if [:SOURce<hw>]:BB:ILS:MBEacon:COMid:TSCHema is set to
USER.
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Parameters:
<Dash> float

Range: 0.05  to  1
Increment: 1E-4
*RST: 0.3

[:SOURce<hw>]:BB:ILS:MBEacon:COMid:DEPTh <Depth>

Sets the AM modulation depth of the of the COM/ID signal.

Parameters:
<Depth> float

Range: 0  to  100
Increment: 0.1
*RST: 5

Manual operation: See "Depth" on page 61

[:SOURce<hw>]:BB:ILS:MBEacon:COMid:DOT <Dot>

Sets the length of a morse dot in seconds. If the time schema is set to STD the length
of the dash (3xdot), symbol space (=dot) and letter space (=3xdot) is also determined
by this entry.

Parameters:
<Dot> float

Range: 0.05  to  1
Increment: 1E-4
*RST: 0.1

Manual operation: See "Dot Length" on page 62

[:SOURce<hw>]:BB:ILS:MBEacon:COMid:FREQuency <Frequency>

Sets the frequency of the COM/ID signal.

Parameters:
<Frequency> float

Range: 0.1  to  20E3
Increment: 0.01
*RST: 1020

Manual operation: See "Frequency" on page 61

[:SOURce<hw>]:BB:ILS:MBEacon:COMid:LETTer <Letter>

Sets the length of a letter space in seconds.

Available only if [:SOURce<hw>]:BB:ILS:MBEacon:COMid:TSCHema is set to
USER.
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Parameters:
<Letter> float

Range: 0.05  to  1
Increment: 1E-4
*RST: 0.3

Manual operation: See "Letter Space" on page 62

[:SOURce<hw>]:BB:ILS:MBEacon:COMid:PERiod <Period>

Sets the period of the COM/ID signal in seconds.

Parameters:
<Period> float

Range: 0  to  120
Increment: 1E-3
*RST: 9

Manual operation: See "Period" on page 61

[:SOURce<hw>]:BB:ILS:MBEacon:COMid:SYMBol <Symbol>

Sets the length of the symbol space in seconds.

Available only if [:SOURce<hw>]:BB:ILS:MBEacon:COMid:TSCHema is set to
USER.

Parameters:
<Symbol> float

Range: 0.05  to  1
Increment: 1E-4
*RST: 0.1

Manual operation: See "Symbol Space" on page 62

[:SOURce<hw>]:BB:ILS:MBEacon:COMid:TSCHema <Tschema>

Sets the time schema for the COM/ID signal.

In the standard time schema (STD) the set dot length determines the dash length (=
three times the dot length) whereas in the user time schema (USER) all length param-
eters can be set independently.

Parameters:
<Tschema> STD | USER

*RST: STD

Manual operation: See "Time Schema" on page 62
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[:SOURce<hw>]:BB:ILS:MBEacon:COMid[:STATe] <State>

Switches on/ off the addittional COM/ID signal.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Manual operation: See "State" on page 61

[:SOURce<hw>]:BB:ILS:MBEacon:FREQuency <CarrierFreq>

Sets the carrier frequency for the ILS-MB modulation signal.

Parameters:
<CarrierFreq> float

Range: 100E3  to  6E9
Increment: 0.01
*RST: 75E6

Manual operation: See "Carrier Frequency" on page 60

[:SOURce<hw>]:BB:ILS:MBEacon:FREQuency:MODE <Mode>

Sets the carrier frequency mode of the ILS-MB modulation signal.

Parameters:
<Mode> USER | PREDefined

*RST: USER

Manual operation: See "Carrier Frequency Mode" on page 60

[:SOURce<hw>]:BB:ILS:MBEacon:MARKer:FREQuency <Frequency>

Sets the modulation frequency of the marker signal for the ILS-MB modulation signal.

Parameters:
<Frequency> integer

Range: 400  to  3000
*RST: 0

Manual operation: See "Marker Frequency" on page 60

[:SOURce<hw>]:BB:ILS:MBEacon[:MARKer]:DEPTh <Depth>

Sets the modulation depth of the marker signal for the ILS-MB signal.

ILS Settings



Remote-Control CommandsAvionics Standards

156Operating Manual 1176.8600.02 ─ 05

Parameters:
<Depth> float

Range: 0  to  100
Increment: 0.1
*RST: 95

Manual operation: See "Marker Depth" on page 60

10.4 VOR Settings

The BB:VOR subsystem contains all commands for configuring a VOR signal.

See also chapter 10.6, "Trigger Settings ", on page 181 and chapter 10.9, "Clock Set-
tings", on page 191 for a description of the trigger and clock settings.

10.4.1 VOR General Settings

[:SOURce<hw>]:BB:VOR:MODE..................................................................................... 156
[:SOURce<hw>]:BB:VOR:PRESet................................................................................... 157
[:SOURce<hw>]:BB:VOR:STATe.....................................................................................157

[:SOURce<hw>]:BB:VOR:MODE <Mode>

Sets the operating mode for the VOR modulation signal.
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Parameters:
<Mode> NORM | VAR | SUBCarrier | FMSubcarrier

NORM
VOR modulation is active.
VAR
Amplitude modulation of the output signal with the variable sig-
nal component (30Hz signal content) of the VOR signal.
The modulation depth of the 30 Hz signal can be set with [:
SOURce<hw>]:BB:VOR:VAR:DEPTh.

SUBCarrier
Amplitude modulation of the output signal with the unmodulated
FM carrier (9960Hz) of the VOR signal.
The modulation depth of the 30 Hz signal can be set with [:
SOURce<hw>]:BB:VOR:SUBCarrier:DEPTh.

FMSubcarrier
Amplitude modulation of the output signal with the frequencymo-
dulated FM carrier (9960Hz) of the VOR signal.
The modulation depth of the 30 Hz signal can be set with [:
SOURce<hw>]:BB:VOR:SUBCarrier:DEPTh.
The frequency deviation can be set with [:SOURce<hw>]:BB:
VOR:REFerence[:DEViation].

*RST: NORM

Manual operation: See "Mode" on page 66

[:SOURce<hw>]:BB:VOR:PRESet

Sets all parameters to their default values (*RST values specified for the commands).

[:SOURce<hw>]:BB:VOR:STATe <State>

Activates/deactivates the VOR modulation.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

10.4.2 VOR System Configuration Settings

[:SOURce<hw>]:BB:VOR:FREQuency............................................................................. 158
[:SOURce<hw>]:BB:VOR:FREQuency:MODE...................................................................158
[:SOURce<hw>]:BB:VOR:ICAO:CHANnel........................................................................ 158
[:SOURce<hw>]:BB:VOR:REFerence[:DEViation]............................................................. 159
[:SOURce<hw>]:BB:VOR:SUBCarrier:DEPTh...................................................................159
[:SOURce<hw>]:BB:VOR:SUBCarrier[:FREQuency]..........................................................160
[:SOURce<hw>]:BB:VOR:VAR:FREQuency......................................................................160
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[:SOURce<hw>]:BB:VOR:VAR:DEPTh.............................................................................160
[:SOURce<hw>]:BB:VOR:BANGle................................................................................... 160
[:SOURce<hw>]:BB:VOR:BANGle:DIRection....................................................................161

[:SOURce<hw>]:BB:VOR:FREQuency <CarrierFreq>

Sets the carrier frequency of the signal if [:SOURce<hw>]:BB:VOR:FREQuency:
MODE is set to USER.

Parameters:
<CarrierFreq> float

Range: 100E3  to  6E9
Increment: 0.01
*RST: 108e6

Manual operation: See "Carrier Frequency" on page 65

[:SOURce<hw>]:BB:VOR:FREQuency:MODE <Mode>

Sets the frequency mode for the VOR modulation signal.

Parameters:
<Mode> USER | ICAO

*RST: USER

Manual operation: See "Carrier Frequency Mode" on page 65

[:SOURce<hw>]:BB:VOR:ICAO:CHANnel <Channel>

Sets the ICAO channel i.e., the VOR transmitting frequency if [:SOURce<hw>]:BB:
VOR:FREQuency:MODE is set to ICAO. The RF frequency is set to the value selected
here.
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Parameters:
<Channel> CH17X | CH17Y | CH19X | CH19Y | CH21X | CH21Y | CH23X |

CH23Y | CH25X | CH25Y | CH27X | CH27Y | CH29X | CH29Y |
CH31X | CH31Y | CH33X | CH33Y | CH35X | CH35Y | CH37X |
CH37Y | CH39X | CH39Y | CH41X | CH41Y | CH43X | CH43Y |
CH45X | CH45Y | CH47X | CH47Y | CH49X | CH49Y | CH51X |
CH51Y | CH53X | CH53Y | CH55X | CH55Y | CH57X | CH57Y |
CH58X | CH58Y | CH59X | CH59Y | CH70X | CH70Y | CH71X |
CH71Y | CH72X | CH72Y | CH73X | CH73Y | CH74X | CH74Y |
CH75X | CH75Y | CH76X | CH76Y | CH77X | CH77Y | CH78X |
CH78Y | CH79X | CH79Y | CH80X | CH80Y | CH81X | CH81Y |
CH82X | CH82Y | CH83X | CH83Y | CH84X | CH84Y | CH85X |
CH85Y | CH86X | CH86Y | CH87X | CH87Y | CH88X | CH88Y |
CH89X | CH89Y | CH90X | CH90Y | CH91X | CH91Y | CH92X |
CH92Y | CH93X | CH93Y | CH94X | CH94Y | CH95X | CH95Y |
CH96X | CH96Y | CH97X | CH97Y | CH98X | CH98Y | CH99X |
CH99Y | CH100X | CH100Y | CH101X | CH101Y | CH102X |
CH102Y | CH103X | CH103Y | CH104X | CH104Y | CH105X |
CH105Y | CH106X | CH106Y | CH107X | CH107Y | CH108X |
CH108Y | CH109X | CH109Y | CH110X | CH110Y | CH111X |
CH111Y | CH112X | CH112Y | CH113X | CH113Y | CH114X |
CH114Y | CH115X | CH115Y | CH116X | CH116Y | CH117X |
CH117Y | CH118X | CH118Y | CH119X | CH119Y | CH120X |
CH120Y | CH121X | CH121Y | CH122X | CH122Y | CH123X |
CH123Y | CH124X | CH124Y | CH125X | CH125Y | CH126X |
CH126Y
*RST: CH17X

Manual operation: See "ICAO Channel" on page 65

[:SOURce<hw>]:BB:VOR:REFerence[:DEViation] <Deviation>

Sets the frequency deviation of the reference signal on the FM carrier.

Parameters:
<Deviation> integer

Range: 0  to  960
*RST: 480
Default unit: Hz

[:SOURce<hw>]:BB:VOR:SUBCarrier:DEPTh <Depth>

Sets the AM modulation depth of the FM carrier.

Parameters:
<Depth> float

Range: 0  to  100
Increment: 0.1
*RST: 30
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Manual operation: See "Subcarrier Depth" on page 66

[:SOURce<hw>]:BB:VOR:SUBCarrier[:FREQuency] <Frequency>

Sets the frequency of the FM carrier.

Parameters:
<Frequency> float

Range: 5E3  to  15E3
Increment: 0.01
*RST: 9.96E3

Manual operation: See "Subcarrier Frequency" on page 66

[:SOURce<hw>]:BB:VOR:VAR:FREQuency <Frequency>

Sets the frequency of the variable and the reference signal. As the two signals must
have the same frequency, the setting is valid for both signals.

Parameters:
<Frequency> float

Range: 10  to  60
Increment: 0.01
*RST: 30

Manual operation: See "VAR/REF Frequency" on page 66

[:SOURce<hw>]:BB:VOR:VAR:DEPTh <Depth>

Sets the AM modulation depth of the 30Hz variable signal.

Parameters:
<Depth> float

Range: 0  to  100
Increment: 0.1
*RST: 30

Manual operation: See "VAR Depth" on page 66

[:SOURce<hw>]:BB:VOR:BANGle <BAngle>

Sets the bearing angle between the VAR signal and the reference signal. The orienta-
tion of the angle can be set with [:SOURce<hw>]:BB:VOR:BANGle:DIRection.

Parameters:
<BAngle> float

Range: 0  to  360
Increment: 0.01
*RST: 0

Manual operation: See "Bearing Angle" on page 67
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[:SOURce<hw>]:BB:VOR:BANGle:DIRection <Direction>

Sets the reference position of the phase information.

Parameters:
<Direction> FROM | TO

FROM
The bearing angle is measured between the geographic north
and the connection line from beacon to airplane.
TO
The bearing angle is measured between the geographic north
and the connection line from airplane to beacon.
*RST: FROM

Manual operation: See "Direction" on page 67

10.4.3 VOR COM/ID Settings

[:SOURce<hw>]:BB:VOR:COMid:CODE.......................................................................... 161
[:SOURce<hw>]:BB:VOR:COMid:DASH...........................................................................161
[:SOURce<hw>]:BB:VOR:COMid:DEPTh......................................................................... 162
[:SOURce<hw>]:BB:VOR:COMid:DOT.............................................................................162
[:SOURce<hw>]:BB:VOR:COMid:FREQuency.................................................................. 162
[:SOURce<hw>]:BB:VOR:COMid:LETTer......................................................................... 162
[:SOURce<hw>]:BB:VOR:COMid:PERiod.........................................................................163
[:SOURce<hw>]:BB:VOR:COMid:SYMBol........................................................................ 163
[:SOURce<hw>]:BB:VOR:COMid:TSCHema.....................................................................163
[:SOURce<hw>]:BB:VOR:COMid[:STATe]........................................................................163

[:SOURce<hw>]:BB:VOR:COMid:CODE <Code>

Sets the coding of the COM/ID signal by the international short name of the airport
(e.g. MUC for the Munich airport).

Parameters:
<Code> string

Manual operation: See "Code" on page 68

[:SOURce<hw>]:BB:VOR:COMid:DASH <Dash>

Sets the length of a morse dash in seconds.

Available only if [:SOURce<hw>]:BB:VOR:COMid:TSCHema is set to USER.

Parameters:
<Dash> float

Range: 0.05  to  1
Increment: 1E-4
*RST: 0.3
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[:SOURce<hw>]:BB:VOR:COMid:DEPTh <Depth>

Sets the AM modulation depth of the of the COM/ID signal.

Parameters:
<Depth> float

Range: 0  to  100
Increment: 0.1
*RST: 10

Manual operation: See "Depth" on page 68

[:SOURce<hw>]:BB:VOR:COMid:DOT <Dot>

Sets the length of a morse dot in seconds. If the time schema is set to STD the length
of the dash (3xdot), symbol space (=dot) and letter space (=3xdot) is also determined
by this entry.

Parameters:
<Dot> float

Range: 0.05  to  1
Increment: 1E-4
*RST: 0.1

Manual operation: See "Dot Length" on page 68

[:SOURce<hw>]:BB:VOR:COMid:FREQuency <Frequency>

Sets the frequency of the COM/ID signal.

Parameters:
<Frequency> float

Range: 0.1  to  20E3
Increment: 0.01
*RST: 1020

Manual operation: See "Frequency" on page 68

[:SOURce<hw>]:BB:VOR:COMid:LETTer <Letter>

Sets the length of a letter space in seconds.

Available only if [:SOURce<hw>]:BB:VOR:COMid:TSCHema is set to USER.

Parameters:
<Letter> float

Range: 0.05  to  1
Increment: 1E-4
*RST: 0.3

Manual operation: See "Letter Space" on page 69
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[:SOURce<hw>]:BB:VOR:COMid:PERiod <Period>

Sets the period of the COM/ID signal in seconds.

Parameters:
<Period> float

Range: 0  to  120
Increment: 1E-3
*RST: 9

Manual operation: See "Period" on page 68

[:SOURce<hw>]:BB:VOR:COMid:SYMBol <Symbol>

Sets the length of the symbol space in seconds.

Available only if [:SOURce<hw>]:BB:VOR:COMid:TSCHema is set to USER.

Parameters:
<Symbol> float

Range: 0.05  to  1
Increment: 1E-4
*RST: 0.1

Manual operation: See "Symbol Space" on page 69

[:SOURce<hw>]:BB:VOR:COMid:TSCHema <Tschema>

Sets the time schema for the COM/ID signal.

In the standard time schema (STD) the set dot length determines the dash length (=
three times the dot length) whereas in the user time schema (USER) all length param-
eters can be set independently.

Parameters:
<Tschema> STD | USER

*RST: STD

Manual operation: See "Time Schema" on page 68

[:SOURce<hw>]:BB:VOR:COMid[:STATe] <State>

Switches on/ off the addittional COM/ID signal.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Manual operation: See "State" on page 67
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10.5 DME Settings

The BB:DME subsystem contains all commands for configuring a DME signal.

See also chapter 10.6, "Trigger Settings ", on page 181 and chapter 10.9, "Clock Set-
tings", on page 191 for a description of the trigger and clock settings.

10.5.1 DME General Settings

[:SOURce<hw>]:BB:DME:STATe.....................................................................................164
[:SOURce<hw>]:BB:DME:PRESet................................................................................... 164
[:SOURce<hw>]:BB:DME:MODE.....................................................................................164

[:SOURce<hw>]:BB:DME:STATe <State>

Activate/deactivate DME modulation.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

[:SOURce<hw>]:BB:DME:PRESet

Sets the DME default settings.

[:SOURce<hw>]:BB:DME:MODE <Mode>

Selects the mode of the DME modulation. The mode determines the signal type that is
simulated. The exact timing of the signal for each mode is determined by the channel
selected with[:SOURce<hw>]:BB:DME:CSUFfix.

Parameters:
<Mode> INTerrogation | REPLy

INTerrogation
The interrogation signal of the airborne transmitter is simulated.
REPLy
The reply signal of the ground based transponder is simulated.
The trigger is automatically set to external and the default trigger
delay either to 50 us (channel X) or 56 us (channel Y) depending
on the selected channel ([:SOURce<hw>]:BB:DME:CSUFfix).
The interval between the pulse pairs can be set to a fixed value
(repetition rate, [:SOURce<hw>]:BB:DME:RATE) or to random
generation (pulse squitter, [:SOURce<hw>]:BB:DME:
SQUitter). The trigger signal is input via the PULSE EXT con-
nector.
*RST: INTerrogation

Manual operation: See "DME Mode" on page 71
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10.5.2 DME System Configuration Settings

[:SOURce<hw>]:BB:DME:CSUFfix...................................................................................165
[:SOURce<hw>]:BB:DME:EFFiciency...............................................................................165
[:SOURce<hw>]:BB:DME:FALL.......................................................................................165
[:SOURce<hw>]:BB:DME:FREQuency.............................................................................166
[:SOURce<hw>]:BB:DME:ICAO:CHANnel........................................................................ 166
[:SOURce<hw>]:BB:DME:PPS........................................................................................ 167
[:SOURce<hw>]:BB:DME:PPST...................................................................................... 168
[:SOURce<hw>]:BB:DME:RATE......................................................................................168
[:SOURce<hw>]:BB:DME:RDIStance...............................................................................168
[:SOURce<hw>]:BB:DME:RDIStance:UNIT.......................................................................169
[:SOURce<hw>]:BB:DME:RISE....................................................................................... 169
[:SOURce<hw>]:BB:DME:SHAPe.................................................................................... 169
[:SOURce<hw>]:BB:DME:SINGle.................................................................................... 170
[:SOURce<hw>]:BB:DME:SQUitter.................................................................................. 170
[:SOURce<hw>]:BB:DME:PINPut:SOURce.......................................................................170
[:SOURce<hw>]:BB:DME:PINPut:DELay..........................................................................171
[:SOURce<hw>]:BB:DME:PINPut:TRIGger:LEVel?............................................................171
[:SOURce<hw>]:BB:DME:PINPut:TRIGger:SEARch?........................................................ 172
[:SOURce<hw>]:BB:DME:WIDTh.....................................................................................172

[:SOURce<hw>]:BB:DME:CSUFfix <CSuffix>

Sets the channel that is simulated. Standard compliant X and Y channels differ in the
spacing between the two pulses of the pulse pair and the delay of the ground station.

Parameters:
<CSuffix> X | Y | ICAO

*RST: X

Manual operation: See "Channel Mode" on page 72

[:SOURce<hw>]:BB:DME:EFFiciency <Efficiency>

Sets the relation between reply pulse pairs and received trigger signals, e.g. with a set
efficiency of 50% only every second trigger event leads to the generation of a reply
pulse pair.

Parameters:
<Efficiency> integer

Range: 0  to  100
*RST: 100

[:SOURce<hw>]:BB:DME:FALL <Fall>

Sets the fall time of the pulse (90% to 10% of peak voltage).
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Parameters:
<Fall> float

Range: 0.5E-6  to  20E-6
Increment: 10E-9
*RST: 2E-6

Manual operation: See "Pulse Fall" on page 76

[:SOURce<hw>]:BB:DME:FREQuency <CarreierFreq>

Sets the carrier frequency of the signal.

Parameters:
<CarreierFreq> float

Range: 100E3  to  6E9
Increment: 0.01
*RST: 1025E6

Manual operation: See "Carrier Frequency" on page 73

[:SOURce<hw>]:BB:DME:ICAO:CHANnel <Channel>

Sets the ICAO channel i.e., the DME transmitting frequency. The RFfrequency is set to
the value selected here.
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Parameters:
<Channel> CH1X | CH1Y | CH2X | CH2Y | CH3X | CH3Y | CH4X | CH4Y |

CH5X | CH5Y | CH6X | CH6Y | CH7X | CH7Y | CH8X | CH8Y |
CH9X | CH9Y | CH10X | CH10Y | CH11X | CH11Y | CH12X |
CH12Y | CH13X | CH13Y | CH14X | CH14Y | CH15X | CH15Y |
CH16X | CH16Y | CH17X | CH17Y | CH18X | CH18Y | CH19X |
CH19Y | CH20X | CH20Y | CH21X | CH21Y | CH22X | CH22Y |
CH23X | CH23Y | CH24X | CH24Y | CH25X | CH25Y | CH26X |
CH26Y | CH27X | CH27Y | CH28X | CH28Y | CH29X | CH29Y |
CH30X | CH30Y | CH31X | CH31Y | CH32X | CH32Y | CH33X |
CH33Y | CH34X | CH34Y | CH35X | CH35Y | CH36X | CH36Y |
CH37X | CH37Y | CH38X | CH38Y | CH39X | CH39Y | CH40X |
CH40Y | CH41X | CH41Y | CH42X | CH42Y | CH43X | CH43Y |
CH44X | CH44Y | CH45X | CH45Y | CH46X | CH46Y | CH47X |
CH47Y | CH48X | CH48Y | CH49X | CH49Y | CH50X | CH50Y |
CH51X | CH51Y | CH52X | CH52Y | CH53X | CH53Y | CH54X |
CH54Y | CH55X | CH55Y | CH56X | CH56Y | CH57X | CH57Y |
CH58X | CH58Y | CH59X | CH59Y | CH60X | CH60Y | CH61X |
CH61Y | CH62X | CH62Y | CH63X | CH63Y | CH64X | CH64Y |
CH65X | CH65Y | CH66X | CH66Y | CH67X | CH67Y | CH68X |
CH68Y | CH69X | CH69Y | CH70X | CH70Y | CH71X | CH71Y |
CH72X | CH72Y | CH73X | CH73Y | CH74X | CH74Y | CH75X |
CH75Y | CH76X | CH76Y | CH77X | CH77Y | CH78X | CH78Y |
CH79X | CH79Y | CH80X | CH80Y | CH81X | CH81Y | CH82X |
CH82Y | CH83X | CH83Y | CH84X | CH84Y | CH85X | CH85Y |
CH86X | CH86Y | CH87X | CH87Y | CH88X | CH88Y | CH89X |
CH89Y | CH90X | CH90Y | CH91X | CH91Y | CH92X | CH92Y |
CH93X | CH93Y | CH94X | CH94Y | CH95X | CH95Y | CH96X |
CH96Y | CH97X | CH97Y | CH98X | CH98Y | CH99X | CH99Y |
CH100X | CH100Y | CH101X | CH101Y | CH102X | CH102Y |
CH103X | CH103Y | CH104X | CH104Y | CH105X | CH105Y |
CH106X | CH106Y | CH107X | CH107Y | CH108X | CH108Y |
CH109X | CH109Y | CH110X | CH110Y | CH111X | CH111Y |
CH112X | CH112Y | CH113X | CH113Y | CH114X | CH114Y |
CH115X | CH115Y | CH116X | CH116Y | CH117X | CH117Y |
CH118X | CH118Y | CH119X | CH119Y | CH120X | CH120Y |
CH121X | CH121Y | CH122X | CH122Y | CH123X | CH123Y |
CH124X | CH124Y | CH125X | CH125Y | CH126X | CH126Y
*RST: CH1X

Manual operation: See "ICAO Channel" on page 73

[:SOURce<hw>]:BB:DME:PPS <Pps>

Sets the spacing between the first and second pulse of a pulse pair (time between half-
voltage points on the leading edge of each pulse).

Available only for [:SOURce<hw>]:BB:DME:SINGleOFF
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Parameters:
<Pps> float

Range: 1E-6  to  200E-6
Increment: 20E-9
*RST: 12E-6

Manual operation: See "Pulse Spacing" on page 76

[:SOURce<hw>]:BB:DME:PPST <SpacTolerance>

Sets the pulse pair spacing tolerance.

Parameters:
<SpacTolerance> float

Range: 0  to  (200E-6)/2
Increment: 20E-9
*RST: 5E-6

[:SOURce<hw>]:BB:DME:RATE <Rate>

If [:SOURce<hw>]:BB:DME:MODE is set to INTerrogation, sets the pulse repetition
rate.

If [:SOURce<hw>]:BB:DME:MODE is set to REPLy, indicates the mean pulse repeti-
tion rate in squitter mode.

Parameters:
<Rate> integer

Range: 10  to  6000
*RST: 48

Manual operation: See "Pulse Repetition Rate" on page 74

[:SOURce<hw>]:BB:DME:RDIStance <RDistance>

Sets the simulated distance between the interrogator and the transponder for reply
mode (:BB:DME:MODE:REPLy).

The distance can be given in nautic miles (NM) or µs with the command [:
SOURce<hw>]:BB:DME:RDIStance:UNIT.

If the unit is not provided next to the value, the value is considered to be in the current
unit (last unit set via GUI or the SCPI). The query always provide the value in the unit
set with [:SOURce<hw>]:BB:DME:RDIStance:UNIT.

The range distance and the external trigger delay are interdependent according to:

range distance = (trigger delay – X/Y mode delay)/12.359 μs/nm

(X mode delay = 50 μs, Y mode delay is 56 μs)

Changing one value automatically changes the other value.
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Parameters:
<RDistance> float

Range: -4.046 (X), -4.531 (Y)  to  400
Increment: 0.001
*RST: 0

Example: SOURce1:BB:DME:RDIS:UNIT NM
sets the unit to NM
:SOURce1:BB:DME:RDIS 1.5NM
sets the range distance to 1.5 NM
:SOURce1:BB:DME:RDIS?
Response:1.5
:SOURce1:BB:DME:RDIS 20US
sets the range distance to 20 us
:SOURce1:BB:DME:RDIS?
Response: 1.618

Manual operation: See "Range Distance" on page 73

[:SOURce<hw>]:BB:DME:RDIStance:UNIT <Unit>

Sets the unit for the range distance that can be defined with the [:SOURce<hw>]:BB:
DME:RDIStance.

The distance can be given in nautic miles (NM) or µs. 1 nm is 1852.01 meters and cor-
responds to a run time of 12.359 µs.

Parameters:
<Unit> US | NM

*RST: NM

Manual operation: See "Range Distance" on page 73

[:SOURce<hw>]:BB:DME:RISE <Rise>

Sets the rise time of the pulse (10% to 90% of peak voltage).

Parameters:
<Rise> float

Range: 0.5E-6  to  20E-6
Increment: 10E-9
*RST: 2E-6

Manual operation: See "Pulse Rise" on page 76

[:SOURce<hw>]:BB:DME:SHAPe <Shape>

Sets the pulse shape.
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Parameters:
<Shape> COS2 | LIN | COS | GAUSs

COS2|
The rising edge is cos shaped and the falling edge is cos^2 sha-
ped.
LIN
The falling and the rising edge of the pulse are shaped linear.
COS
The falling and the rising edge of the pulse are cos^2 shaped.
*RST: COS2

Manual operation: See "Pulse Shape" on page 75

[:SOURce<hw>]:BB:DME:SINGle <Single>

Activates/deactivates generation of a single test pulse.

Parameters:
<Single> 0 | 1 | OFF | ON

*RST: 0

Manual operation: See "Single Pulse" on page 76

[:SOURce<hw>]:BB:DME:SQUitter <Squitter>

Activates/deactivates the random pulse repetition rate.

The average repetition rate is 2700 pp/s. The pulse spacing is distributed randomly in
the range of 60 μs to about 1500 μs according to EUROCAE EN-54 6.2.12. The squit-
ter pulses are constantly sent by the ground station in order to ensure proper operation
and in order to ease synchronization of the aircraft interrogator to the ground station.

Parameters:
<Squitter> 0 | 1 | OFF | ON

*RST: 0

Manual operation: See "Pulse Squitter" on page 73

[:SOURce<hw>]:BB:DME:PINPut:SOURce <InputSource>

Selects the trigger mode for DME modulation signals.
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Parameters:
<InputSource> EXTernal | PSENsor

EXTernal
The signals are triggered by an external trigger event. The trig-
ger signal is supplied via the PULSE EXT connector.
PSENsor
The signals are triggered by an external power sensor. This
mode is only available if [:SOURce<hw>]:BB:DME:MODE
on page 164 is set to INTerrogation.
*RST: EXTernal

Manual operation: See "Input Source" on page 74

[:SOURce<hw>]:BB:DME:PINPut:DELay <Delay>

Sets the delay between the external trigger and the first DME output pulse (50% volt-
age point of first pulse). Available only if [:SOURce<hw>]:BB:DME:PINPut:SOURce
is set to EXTernal.

For DME Reply mode this simulates the defined delay of the DME transponder and
twice the run time of the signal (from interrogator to transponder and back). The delay
is a measure of the range distance, thus, the two values are interdependent according
to:

Delay = X/Y mode delay + range distance * 12.359 nm/μs

(X mode delay = 50 μs, Y mode delay is 56 μs)

Changing one value automatically changes the other value.

Parameters:
<Delay> float

Range: 4E-6  to  5E-3
Increment: 20E-9
*RST: 50E-6

Manual operation: See "Reply Delay" on page 75

[:SOURce<hw>]:BB:DME:PINPut:TRIGger:LEVel?

Queries the measured trigger treshold.

Return values: 
<TriggerLevel> float

Range: -200  to  200
Increment: 0.01
*RST: 0

Usage: Query only
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[:SOURce<hw>]:BB:DME:PINPut:TRIGger:SEARch?

Determines the trigger level = 50% voltage point of first pulse of the external DME
interrogation signal.

This command determines the trigger point after connecting the R&S NRP-Z81 power
sensor to the external interrogation signal source. The search function has to be exe-
cuted with each change of the level of the external DME signal.

Return values: 
<Search> 0 | 1 | OFF | ON

*RST: 0

Usage: Query only

Manual operation: See "Search Trigger Level" on page 75

[:SOURce<hw>]:BB:DME:WIDTh <Width>

Sets the pulse width (50% to 50% of peak voltage).

Parameters:
<Width> float

Range: 1E-6  to  100E-6
Increment: 20E-9
*RST: 3.5E-6

Manual operation: See "Pulse Width" on page 76

10.5.3 DME Analysis Settings

[:SOURce<hw>]:BB:DME:ANALysis:EFFiciency?..............................................................173
[:SOURce<hw>]:BB:DME:ANALysis:EFFiciency:OK?........................................................ 173
[:SOURce<hw>]:BB:DME:ANALysis:GATE:COUNt............................................................173
[:SOURce<hw>]:BB:DME:ANALysis:GATE:EDELay.......................................................... 173
[:SOURce<hw>]:BB:DME:ANALysis:GATE[:LENGth].........................................................174
[:SOURce<hw>]:BB:DME:ANALysis:GATE:TIME.............................................................. 174
[:SOURce<hw>]:BB:DME:ANALysis:NORMalize?............................................................. 174
[:SOURce<hw>]:BB:DME:ANALysis:POWer?................................................................... 175
[:SOURce<hw>]:BB:DME:ANALysis:POWer:OK?..............................................................175
[:SOURce<hw>]:BB:DME:ANALysis:PRRate?...................................................................175
[:SOURce<hw>]:BB:DME:ANALysis:PRRate:OK?.............................................................176
[:SOURce<hw>]:BB:DME:ANALysis:RDIStance?.............................................................. 176
[:SOURce<hw>]:BB:DME:ANALysis:STATe......................................................................176
[:SOURce<hw>]:BB:DME:ANALysis:TIME?...................................................................... 176
[:SOURce<hw>]:BB:DME:ANALysis:TIME:OK?.................................................................177
[:SOURce<hw>]:BB:DME:ANALysis:TRIGger:SEARch?.................................................... 177
[:SOURce<hw>]:BB:DME:ANALysis:IAFactor?..................................................................177
[:SOURce<hw>]:BB:DME:ANALysis:PSAFactor?.............................................................. 177
[:SOURce<hw>]:BB:DME:ANALysis:UAFactor.................................................................. 178
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[:SOURce<hw>]:BB:DME:ANALysis:EFFiciency?

Queries the measured reply efficiency in percent. The measurement is the ratio of the
number of measured valid reply pulse pairs to transmitted pulse pairs in a measure-
ment cycle.

Return values: 
<Efficiency> float

Range: 0  to  100
Increment: 0.1
*RST: 100

Usage: Query only

Manual operation: See "Reply Efficiency" on page 74

[:SOURce<hw>]:BB:DME:ANALysis:EFFiciency:OK?

Queries if there are valid reply efficiency measurement values available in the set mea-
surement window.

Return values: 
<Ok> 0 | 1 | OFF | ON

*RST: 1

Usage: Query only

Manual operation: See "Reply Efficiency" on page 79

[:SOURce<hw>]:BB:DME:ANALysis:GATE:COUNt <Count>

Sets the number of pulse pairs which are sent from the R&S SMBV (= interrogator) to
the ground station in one measurement cycle. Only reply pulses for which the 50%
voltage point of the rising edge of the first pulse is within the measurement window are
used to evaluate the delay time and reply efficiency.

Parameters:
<Count> integer

Range: 1  to  10000
Increment: 1
*RST: 100

Manual operation: See "Measurement Time" on page 78

[:SOURce<hw>]:BB:DME:ANALysis:GATE:EDELay <Edelay>

Sets the expected reply delay. The expected reply delay and the gate length determine
the measurement window (expected reply delay +/- gate length/2).
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Parameters:
<Edelay> float

Range: 0  to  150E-6
Increment: 1E-7
*RST: 50E-6

Manual operation: See "Expected Reply Delay" on page 78

[:SOURce<hw>]:BB:DME:ANALysis:GATE[:LENGth] <Length>

Sets the gate length for the measurement window.

The measurement gate settings determine the measurement window (expected reply
delay +/- gate length/2). Only reply pulses for which the 50% voltage point of the rising
edge of the first pulse is within the measurement window are used to evaluate the
delay time and reply efficiency. The delay measurement is averaged within the mea-
surement cycle. The reply efficiency is calculated once for each measurement cycle.

The gate length is 1 µs and the expected reply delay is 50 µs. The measurement win-
dow lies in the range between 49.5 and 50.5 µs. Only pulse pairs are used for the mea-
surement whose 50% voltage point of the rising edge of the first pulse is within this
range.

Parameters:
<Length> integer

Range: 100E-9  to  326E-6
Increment: 100E-9
*RST: 10E-6

Manual operation: See "Gate Length" on page 78

[:SOURce<hw>]:BB:DME:ANALysis:GATE:TIME <MeasurementTime>

Sets the DME analysis measurement time.

Parameters:
<MeasurementTime> float

Range: 0.1  to  20
Increment: 0.1
*RST: 1

[:SOURce<hw>]:BB:DME:ANALysis:NORMalize?

Performs a normalization of the test setup. The delay due to the test setup is measured
and subsequently considered in the reply measurements.
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Return values: 
<Normalize> 0 | 1 | OFF | ON

Usage: Query only

Manual operation: See "Normalize Setup" on page 83

[:SOURce<hw>]:BB:DME:ANALysis:POWer?

Queries the measured average peak level of all valid pulse pairs in a measurement
cycle.

Return values: 
<Power> float

Range: -200  to  200
Increment: 0.01
*RST: 0

Usage: Query only

Manual operation: See "Peak Level" on page 78

[:SOURce<hw>]:BB:DME:ANALysis:POWer:OK?

Queries if there are peak level measurement values available in the set measurement
window.

Return values: 
<Ok> 0 | 1 | OFF | ON

*RST: 1

Usage: Query only

Manual operation: See "Peak Level" on page 78

[:SOURce<hw>]:BB:DME:ANALysis:PRRate?

Queries the measured mean pulse repetition rate of the DME ground station. All
received pulses of the DME ground station are considered.

Return values: 
<Rate> float

Range: 0  to  10000
Increment: 0.1
*RST: 0

Usage: Query only

Manual operation: See "Pulse Repetition Rate" on page 79
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[:SOURce<hw>]:BB:DME:ANALysis:PRRate:OK?

Queries if there are valid pulse repetition measurement values available in the set
measurement window.

Return values: 
<Ok> 0 | 1 | OFF | ON

*RST: 1

Usage: Query only

Manual operation: See "Pulse Repetition Rate" on page 79

[:SOURce<hw>]:BB:DME:ANALysis:RDIStance?

Queries the measured average range distance of all valid pulse pairs in a measure-
ment cycle. .

Return values: 
<RangeDistance> float

Usage: Query only

Manual operation: See "Range Distance" on page 78

[:SOURce<hw>]:BB:DME:ANALysis:STATe <State>

Activates/deactivates the DME analysis. The setting is only available after connecting
the R&S NRP-Z81 power sensor.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Manual operation: See "State" on page 77

[:SOURce<hw>]:BB:DME:ANALysis:TIME?

Queries the measured average reply delay of all valid pulse pairs in a measurement
cycle.

Return values: 
<Time> float

Range: -1E-3  to  1E-3
Increment: 10E-9
*RST: 0

Usage: Query only

Manual operation: See "Reply Delay" on page 79
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[:SOURce<hw>]:BB:DME:ANALysis:TIME:OK?

Queries if there are valid measurement values available in the set measurement win-
dow.

Return values: 
<Ok> 0 | 1 | OFF | ON

Usage: Query only

Manual operation: See "Reply Delay" on page 79

[:SOURce<hw>]:BB:DME:ANALysis:TRIGger:SEARch?

Determines the trigger level = 50% voltage point of first pulse of the external DME
interrogation signal.

This command determines the trigger point after connecting the R&S NRP-Z81 power
sensor to the external interrogation signal source. The search function has to be exe-
cuted with each change of the level of the external DME signal.

Return values: 
<Search> 0 | 1 | OFF | ON

*RST: 0

Usage: Query only

[:SOURce<hw>]:BB:DME:ANALysis:IAFactor?

Queries the internal adjustment factor, the mathematically calculated value of the time,
when the pulse reaches its 50% level.

Return values: 
<InternalAdjFact> float

Range: 0  to  200
Increment: 10E-9
*RST: 0

Usage: Query only

Manual operation: See "Internal Adjustment Factor" on page 84

[:SOURce<hw>]:BB:DME:ANALysis:PSAFactor?

Queries the power sensor adjustment factor determined during a normalization of the
setup. You can normalize the setup with [:SOURce<hw>]:BB:DME:ANALysis:
NORMalize?.

Return values: 
<PowSensAdjFact> float

Range: 0  to  200
Increment: 10E-9
*RST: 0
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Usage: Query only

Manual operation: See "Power Sensor Adjustment Factor" on page 83

[:SOURce<hw>]:BB:DME:ANALysis:UAFactor <UsedFactor>

Sets which internal adjustment factor should be used.

Parameters:
<UsedFactor> INTernal | PSENsor

INTernal
The mathematically calculated value of the time, when the pulse
reaches its 50% level. Query the internal adjustment factor with
[:SOURce<hw>]:BB:DME:ANALysis:IAFactor?
PSENsor
The during a normalization setup measured adjustment factor.
Query the power sensor adjustment factor with [:
SOURce<hw>]:BB:DME:ANALysis:PSAFactor?
*RST: INTernal

Manual operation: See "Used Adjustment Factor" on page 84

10.5.4 DME COM/ID Settings

[:SOURce<hw>]:BB:DME:ID:CODE................................................................................. 178
[:SOURce<hw>]:BB:DME:ID:DASH................................................................................. 178
[:SOURce<hw>]:BB:DME:ID:DOT....................................................................................179
[:SOURce<hw>]:BB:DME:ID:LETTer................................................................................179
[:SOURce<hw>]:BB:DME:ID:PPP[:STATe]....................................................................... 179
[:SOURce<hw>]:BB:DME:ID:PPS.................................................................................... 180
[:SOURce<hw>]:BB:DME:ID:PERiod................................................................................180
[:SOURce<hw>]:BB:DME:ID:PRESet...............................................................................180
[:SOURce<hw>]:BB:DME:ID:RATE..................................................................................180
[:SOURce<hw>]:BB:DME:ID:SYMBol...............................................................................180
[:SOURce<hw>]:BB:DME:ID:TSCHema........................................................................... 181
[:SOURce<hw>]:BB:DME:ID[:STATe]...............................................................................181

[:SOURce<hw>]:BB:DME:ID:CODE <Code>

Sets the coding of the COM/ID signal by the international short name of the airport
(e.g. MUC for the Munich airport).

Parameters:
<Code> string

Manual operation: See "Code" on page 81

[:SOURce<hw>]:BB:DME:ID:DASH <Dash>

Sets the length of a morse dash in seconds.
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Available only if [:SOURce<hw>]:BB:DME:ID:TSCHema is set to USER.

Parameters:
<Dash> float

Range: 0.05  to  1
Increment: 1E-4
*RST: 0.3

Manual operation: See "Dash Length" on page 82

[:SOURce<hw>]:BB:DME:ID:DOT <Dot>

Sets the length of a morse dot in seconds. If the time schema is set to STD the length
of the dash (3xdot), symbol space (=dot) and letter space (=3xdot) is also determined
by this entry.

Parameters:
<Dot> float

Range: 0.05  to  1
Increment: 1E-4
*RST: 0.1

Manual operation: See "Dot Length" on page 81

[:SOURce<hw>]:BB:DME:ID:LETTer <Letter>

Sets the length of a letter space in seconds.

Available only if [:SOURce<hw>]:BB:DME:ID:TSCHema is set to USER.

Parameters:
<Letter> float

Range: 0.05  to  1
Increment: 1E-4
*RST: 0.3

Manual operation: See "Letter Space" on page 82

[:SOURce<hw>]:BB:DME:ID:PPP[:STATe] <PairOfPulsePair>

Sets the state of the pair of pulse pairs for the ID signal generation. When enabled a
pair of pulse pairs is transmitted during the set [:SOURce<hw>]:BB:DME:ID:RATE.

Parameters:
<PairOfPulsePair> 0 | 1 | OFF | ON

*RST: 0

Manual operation: See "Pair of Pulse Pairs" on page 80
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[:SOURce<hw>]:BB:DME:ID:PPS <PulsePairSpacin>

Sets the morse pulse pair spacing.

Parameters:
<PulsePairSpacin> float

Range: 2E-6  to  300E-6
Increment: 20E-9
*RST: 100E-6

Manual operation: See "Pulse Pair Spacing" on page 81

[:SOURce<hw>]:BB:DME:ID:PERiod <Period>

Sets the period of the COM/ID signal in seconds.

Parameters:
<Period> integer

Range: 10  to  120
*RST: 40

Manual operation: See "Period" on page 81

[:SOURce<hw>]:BB:DME:ID:PRESet

Sets the default settings for the ID signal.

Usage: Event

[:SOURce<hw>]:BB:DME:ID:RATE <Rate>

Sets the pulse repetition rate of the ID sequence.

Parameters:
<Rate> float

Range: 100  to  10E3
Increment: 0.01
*RST: 1350

Manual operation: See "Rate" on page 81

[:SOURce<hw>]:BB:DME:ID:SYMBol <Symbol>

Sets the length of the symbol space in seconds.

Available only if [:SOURce<hw>]:BB:DME:ID:TSCHema is set to USER.
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Parameters:
<Symbol> float

Range: 0.05  to  1
Increment: 1E-4
*RST: 0.1

Manual operation: See "Symbol Space" on page 82

[:SOURce<hw>]:BB:DME:ID:TSCHema <TSchema>

Sets the time schema for the COM/ID signal.

In the standard time schema (STD) the set dot length determines the dash length (=
three times the dot length) whereas in the user time schema (USER) all length param-
eters can be set independently.

Parameters:
<TSchema> STD | USER

*RST: STD

Manual operation: See "Time Schema" on page 81

[:SOURce<hw>]:BB:DME:ID[:STATe] <State>

Switches on/ off the addittional COM/ID signal.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Manual operation: See "COM/ID State " on page 80

10.6 Trigger Settings

EXTernal<ch>
The numeric suffix to EXTernal<ch> distinguishes between the external trigger via
the TRIGGER 1 (suffix 1) and TRIGGER 2 (suffix 2) connector.

[:SOURce<hw>]:BB:DME:TRIGger:ARM:EXECute............................................................182
[:SOURce<hw>]:BB:GBAS:TRIGger:ARM:EXECute.......................................................... 182
[:SOURce<hw>]:BB:ILS:TRIGger:ARM:EXECute.............................................................. 182
[:SOURce<hw>]:BB:VOR:TRIGger:ARM:EXECute............................................................ 182
[:SOURce<hw>]:BB:DME:TRIGger:EXECute....................................................................183
[:SOURce<hw>]:BB:GBAS:TRIGger:EXECute.................................................................. 183
[:SOURce<hw>]:BB:ILS:TRIGger:EXECute...................................................................... 183
[:SOURce<hw>]:BB:VOR:TRIGger:EXECute.................................................................... 183
[:SOURce<hw>]:BB:DME:TRIGger:EXTernal:SYNChronize:OUTPut...................................183
[:SOURce<hw>]:BB:ILS:TRIGger:EXTernal:SYNChronize:OUTPut..................................... 183
[:SOURce<hw>]:BB:GBAS:TRIGger:EXTernal:SYNChronize:OUTPut.................................183
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[:SOURce<hw>]:BB:VOR:TRIGger:EXTernal:SYNChronize:OUTPut...................................183
[:SOURce<hw>]:BB:DME:TRIGger:OBASeband:DELay.....................................................184
[:SOURce<hw>]:BB:GBAS:TRIGger:OBASeband:DELay...................................................184
[:SOURce<hw>]:BB:ILS:TRIGger:OBASeband:DELay....................................................... 184
[:SOURce<hw>]:BB:VOR:TRIGger:OBASeband:DELay.....................................................184
[:SOURce<hw>]:BB:DME:TRIGger:OBASeband:INHibit.....................................................184
[:SOURce<hw>]:BB:GBAS:TRIGger:OBASeband:INHibit...................................................184
[:SOURce<hw>]:BB:ILS:TRIGger:OBASeband:INHibit....................................................... 184
[:SOURce<hw>]:BB:VOR:TRIGger:OBASeband:INHibit.....................................................184
[:SOURce<hw>]:BB:DME:TRIGger:RMODe?....................................................................184
[:SOURce<hw>]:BB:GBAS:TRIGger:RMODe?.................................................................. 184
[:SOURce<hw>]:BB:ILS:TRIGger:RMODe?...................................................................... 184
[:SOURce<hw>]:BB:VOR:TRIGger:RMODe?....................................................................184
[:SOURce<hw>]:BB:DME:TRIGger:SLENgth.................................................................... 184
[:SOURce<hw>]:BB:GBAS:TRIGger:SLENgth...................................................................184
[:SOURce<hw>]:BB:ILS:TRIGger:SLENgth.......................................................................185
[:SOURce<hw>]:BB:VOR:TRIGger:SLENgth.....................................................................185
[:SOURce<hw>]:BB:GBAS:TRIGger:SLUNit..................................................................... 185
[:SOURce<hw>]:BB:DME:TRIGger:SOURce.....................................................................185
[:SOURce<hw>]:BB:GBAS:TRIGger:SOURce...................................................................185
[:SOURce<hw>]:BB:ILS:TRIGger:SOURce.......................................................................185
[:SOURce<hw>]:BB:VOR:TRIGger:SOURce.....................................................................185
[:SOURce<hw>]:BB:DME:TRIGger[:EXTernal<ch>]:DELay................................................ 185
[:SOURce<hw>]:BB:GBAS:TRIGger[:EXTernal<ch>]:DELay.............................................. 185
[:SOURce<hw>]:BB:ILS:TRIGger[:EXTernal<ch>]:DELay...................................................185
[:SOURce<hw>]:BB:VOR:TRIGger[:EXTernal<ch>]:DELay................................................ 185
[:SOURce<hw>]:BB:DME:TRIGger[:EXTernal<ch>]:INHibit................................................ 186
[:SOURce<hw>]:BB:GBAS:TRIGger[:EXTernal<ch>]:INHibit.............................................. 186
[:SOURce<hw>]:BB:ILS:TRIGger[:EXTernal<ch>]:INHibit...................................................186
[:SOURce<hw>]:BB:VOR:TRIGger[:EXTernal<ch>]:INHibit................................................ 186
[:SOURce<hw>]:BB:DME[:TRIGger]:SEQuence................................................................186
[:SOURce<hw>]:BB:GBAS[:TRIGger]:SEQuence.............................................................. 186
[:SOURce<hw>]:BB:ILS[:TRIGger]:SEQuence.................................................................. 186
[:SOURce<hw>]:BB:VOR[:TRIGger]:SEQuence................................................................ 186

[:SOURce<hw>]:BB:DME:TRIGger:ARM:EXECute
[:SOURce<hw>]:BB:GBAS:TRIGger:ARM:EXECute
[:SOURce<hw>]:BB:ILS:TRIGger:ARM:EXECute
[:SOURce<hw>]:BB:VOR:TRIGger:ARM:EXECute
Stops signal generation for trigger modes "Armed_Auto" and "Armed_Retrigger". A
subsequent internal or external trigger event restart signal generation.
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Example: BB:VOR:TRIG:SOUR INT
sets internal triggering.
BB:VOR:TRIG:SEQ ARET
sets Armed_Retrigger mode, i.e. every trigger event causes sig-
nal generation to restart.
BB:VOR:TRIG:EXEC
executes a trigger, signal generation is started.
BB:VOR:TRIG:ARM:EXEC
signal generation is stopped.
BB:VOR:TRIG:EXEC
executes a trigger, signal generation is started again.

Usage: Event

Manual operation: See "Arm" on page 27

[:SOURce<hw>]:BB:DME:TRIGger:EXECute
[:SOURce<hw>]:BB:GBAS:TRIGger:EXECute
[:SOURce<hw>]:BB:ILS:TRIGger:EXECute
[:SOURce<hw>]:BB:VOR:TRIGger:EXECute
Executes a trigger. The internal trigger source must be selected using the command
BB:xxx:TRIG:SOUR INT( where xxx stands for ILS, VOR or DME) and a trigger
mode other than AUTO must be selected using the command BB:xxx:TRIG:SEQ.

Usage: Event

Manual operation: See "Execute Trigger" on page 26

[:SOURce<hw>]:BB:DME:TRIGger:EXTernal:SYNChronize:OUTPut <Output>
[:SOURce<hw>]:BB:ILS:TRIGger:EXTernal:SYNChronize:OUTPut <Output>
[:SOURce<hw>]:BB:GBAS:TRIGger:EXTernal:SYNChronize:OUTPut <Output>
[:SOURce<hw>]:BB:VOR:TRIGger:EXTernal:SYNChronize:OUTPut <Output>

Enables/disables output of the signal synchronous to the external trigger event.

Parameters:
<Output> 0 | 1 | OFF | ON

ON
The signal calculation starts simultaneously with the external
trigger event but because of the instrument's processing time
the first samples are cut off and no signal is outputted. After
elapsing of the internal processing time, the output signal is syn-
chronous to the trigger event.
OFF
The signal output begins after elapsing of the processing time
and starts with sample 0, i.e. the complete signal is outputted.
This mode is recommended for triggering of short signal sequen-
ces with signal duration comparable with the processing time of
the instrument.
*RST: 1
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Manual operation: See "Sync. Output to External Trigger" on page 87

[:SOURce<hw>]:BB:DME:TRIGger:OBASeband:DELay <Delay>
[:SOURce<hw>]:BB:GBAS:TRIGger:OBASeband:DELay <Delay>
[:SOURce<hw>]:BB:ILS:TRIGger:OBASeband:DELay <Delay>
[:SOURce<hw>]:BB:VOR:TRIGger:OBASeband:DELay <Delay>

The command specifies the trigger delay (expressed as a number of samples) for trig-
gering by the trigger signal from the second path.

Parameters:
<Delay> float

Range: 0 samples  to  2^32-1 samples
Increment: 1 sample
*RST: 0 samples

Manual operation: See "Trigger Delay" on page 89

[:SOURce<hw>]:BB:DME:TRIGger:OBASeband:INHibit <Inhibit>
[:SOURce<hw>]:BB:GBAS:TRIGger:OBASeband:INHibit <Inhibit>
[:SOURce<hw>]:BB:ILS:TRIGger:OBASeband:INHibit <Inhibit>
[:SOURce<hw>]:BB:VOR:TRIGger:OBASeband:INHibit <Inhibit>

Specifies the number of samples by which a restart is to be inhibited following a trigger
event. This command applies only for triggering by the second path.

Parameters:
<Inhibit> integer

Range: 0  to  67108863
*RST: 0

Manual operation: See "Trigger Inhibit" on page 90

[:SOURce<hw>]:BB:DME:TRIGger:RMODe?
[:SOURce<hw>]:BB:GBAS:TRIGger:RMODe?
[:SOURce<hw>]:BB:ILS:TRIGger:RMODe?
[:SOURce<hw>]:BB:VOR:TRIGger:RMODe?
Queries the current status of signal generation for all trigger modes modulation on.

Return values: 
<RunMode> STOP | RUN

*RST: STOP

Usage: Query only

Manual operation: See "Running/Stopped" on page 86

[:SOURce<hw>]:BB:DME:TRIGger:SLENgth <SeqLength>
[:SOURce<hw>]:BB:GBAS:TRIGger:SLENgth <Slength>
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[:SOURce<hw>]:BB:ILS:TRIGger:SLENgth <SeqLength>
[:SOURce<hw>]:BB:VOR:TRIGger:SLENgth <SeqLength>

The command defines the length of the signal sequence to be output in the "Single"
trigger mode (SOUR:BB:xxx:SEQ SING, where xxx stands for ILS, VOR or DME). The
input is made in terms of samples.

It is possible to output deliberately just part of the frame, an exact sequence of the
frame, or a defined number of repetitions of the frame.

Parameters:
<SeqLength> integer

Range: 1 samples  to  2^32-1 samples
*RST: 100

Manual operation: See "Trigger Signal Duration" on page 86

[:SOURce<hw>]:BB:GBAS:TRIGger:SLUNit <Slunit>

Sets the units the trigger sequence length is exprecced in.

Parameters:
<Slunit> SEQuence | SAMPle

*RST: SEQuence

Manual operation: See "Signal Duration Unit" on page 86

[:SOURce<hw>]:BB:DME:TRIGger:SOURce <TriggerSource>
[:SOURce<hw>]:BB:GBAS:TRIGger:SOURce <Source>
[:SOURce<hw>]:BB:ILS:TRIGger:SOURce <TriggerSource>
[:SOURce<hw>]:BB:VOR:TRIGger:SOURce <TriggerSource>

Selects the trigger source.

Parameters:
<TriggerSource> INTernal|EXTernal

INTernal
manual trigger or *TRG.
EXTernal
trigger signal on the TRIGGER connector.
*RST: INTernal

Manual operation: See "Trigger Source" on page 87

[:SOURce<hw>]:BB:DME:TRIGger[:EXTernal<ch>]:DELay <Delay>
[:SOURce<hw>]:BB:GBAS:TRIGger[:EXTernal<ch>]:DELay <Delay>
[:SOURce<hw>]:BB:ILS:TRIGger[:EXTernal<ch>]:DELay <Delay>
[:SOURce<hw>]:BB:VOR:TRIGger[:EXTernal<ch>]:DELay <Delay>

Sets the trigger delay.
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Parameters:
<Delay> float

Range: 0  to  65535
Increment: 0.01
*RST: 0

Example: BB:VOR:TRIG:SOUR EXT
selects an external trigger.
BB:VOR:TRIG:EXT:DEL 50
sets a delay of 50 symbols for the trigger.

Manual operation: See "Trigger Delay" on page 89

[:SOURce<hw>]:BB:DME:TRIGger[:EXTernal<ch>]:INHibit <Inhibit>
[:SOURce<hw>]:BB:GBAS:TRIGger[:EXTernal<ch>]:INHibit <Inhibit>
[:SOURce<hw>]:BB:ILS:TRIGger[:EXTernal<ch>]:INHibit <Inhibit>
[:SOURce<hw>]:BB:VOR:TRIGger[:EXTernal<ch>]:INHibit <Inhibit>

Specifies the number of samples by which a restart is to be inhibited following an exter-
nal trigger event.

Parameters:
<Inhibit> integer

Range: 0  to  67108863
*RST: 0

Example: BB:VOR:TRIG:SOUR EXT
selects an external trigger.
BB:VOR:TRIG:EXT:INH 200
sets a restart inhibit for 200 samples following a trigger event.

Manual operation: See "Trigger Inhibit" on page 90

[:SOURce<hw>]:BB:DME[:TRIGger]:SEQuence <TriggerMode>
[:SOURce<hw>]:BB:GBAS[:TRIGger]:SEQuence <Sequence>
[:SOURce<hw>]:BB:ILS[:TRIGger]:SEQuence <TriggerMode>
[:SOURce<hw>]:BB:VOR[:TRIGger]:SEQuence <TriggerMode>

Selects the trigger mode.
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Parameters:
<TriggerMode> AUTO | RETRigger | AAUTo | ARETrigger | SINGle

AUTO
The modulation signal is generated continuously.
RETRigger
The modulation signal is generated continuously. A trigger event
(internal or external) causes a restart.
AAUTo
The modulation signal is generated only when a trigger event
occurs. After the trigger event the signal is generated continu-
ously. Signal generation is stopped with command
SOUR:BB:xxx:TRIG:ARM:EXEC( xxx stands for ILS, VOR or
DME) and started again when a trigger event occurs.

ARETrigger
The modulation signal is generated only when a trigger event
occurs. The device automatically toggles to RETRigger mode.
Every subsequent trigger event causes a restart.
Signal generation is stopped with command
SOUR:BB:xxx:TRIG:ARM:EXEC and started again when a trig-
ger event occurs.
SINGle
The modulation signal is generated only when a trigger event
occurs. Then the signal is generated once to the length specified
with command SOUR:BB:xxx:TRIG:SLEN. Every subsequent
trigger event causes a restart.
*RST: AUTO

Manual operation: See "Trigger Mode" on page 85

10.7 Marker Settings DME

[:SOURce<hw>]:BB:DME:MARKer<ch>:DELay.................................................................187
[:SOURce<hw>]:BB:DME:MARKer<ch>:MODE.................................................................188
[:SOURce<hw>]:BB:DME:MARKer<ch>:PDELay?.............................................................188
[:SOURce<hw>]:BB:DME:MARKer<ch>:WIDTh................................................................ 188

[:SOURce<hw>]:BB:DME:MARKer<ch>:DELay <Delay>

Sets the delay between the marker signal at the marker outputs relative to the signal
generation start.

Parameters:
<Delay> integer

Range: 0  to  127
*RST: 0

Manual operation: See "Marker Delay" on page 93
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[:SOURce<hw>]:BB:DME:MARKer<ch>:MODE <Mode>

Sets the mode for the selected marker.

Parameters:
<Mode> FPSTart | FP50P | PSTart | P50P | PRECeived

FPSTart: first pulse start
FP50: first pulse 50%
PSTart: pulse start
P50: pulse 50%
PRECeived: received pulse

*RST: PSTart

Manual operation: See "Marker x" on page 92

[:SOURce<hw>]:BB:DME:MARKer<ch>:PDELay?

Queries the marker processing delay, internally measured value. This command is
avaliable only for "Marker 2 ".

Return values: 
<ProcessedDelay> float

Range: 0  to  1
Increment: 10E-9
*RST: 0

Usage: Query only

Manual operation: See "Processing Delay" on page 94

[:SOURce<hw>]:BB:DME:MARKer<ch>:WIDTh <Width>

Sets the width of the corresponding marker in chips (0.05us).

Parameters:
<Width> integer

Range: 1  to  127
*RST: 10

Manual operation: See "Marker Width" on page 93

10.8 Marker Settings GBAS

Provided are the following commands:

[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:MODE <Mode>

Defines the signal for the selected marker output.
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Parameters:
<Mode> PULSe | RESTart | PATTern | RATio | TRIGger | PPS

*RST: PPS

Example: see example "Adjusting clock, marker and trigger settings"
on page 113

Manual operation: See "Marker Mode" on page 90

[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:PATTern <Pattern>

Defines the bit pattern used to generate the marker signal PATTern.

Parameters:
<Pattern> integer

Example: SOURce1:BB:GBAS:TRIGger:OUTPut1:MODE PATTern
SOURce1:BB:GBAS:TRIGger:OUTPut1:PATTern
#H5670,15

Manual operation: See "Marker Mode" on page 90

[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:PULSe:DIVider <Divider>

Sets the divider for Pulse marker mode (PULSe).

Parameters:
<Divider> integer

Range: 2  to  1024
*RST: 2

Example: SOURce1:BB:GBAS:MSET:SRATe?
Response: 10500
SOURce1:BB:GBAS:TRIGger:OUTPut2:MODE PULSe
SOURce1:BB:GBAS:TRIGger:OUTPut2:PULSe:DIVider 4
SOURce1:BB:GBAS:TRIGger:OUTPut2:PULSe:
FREQuency?
Response: 2625
2625 = 10500/4

Manual operation: See "Marker Mode" on page 90

[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:PULSe:FREQuency?

Queries the pulse frequency of the pulsed marker signal PULSe.

Return values: 
<Frequency> float

Range: 2  to  1024
Increment: 1E-3
*RST: 2

Usage: Query only
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Manual operation: See "Marker Mode" on page 90

[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:ONTime <OnTime>
[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:OFFTime <OffTime>

Sets the number of symbols in a period (ON time + OFF time) for marker RATio
Parameters:
<OffTime> integer

Range: 1  to  16777215
*RST: 1

Example: see example "Adjusting clock, marker and trigger settings"
on page 113

Manual operation: See "Marker Mode" on page 90

[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:DELay <Delay>

Sets the marker delay.

Parameters:
<Delay> float

Range: 0  to  16777215
Increment: 1E-3
*RST: 0

Example: SOURce1:BB:GBAS:TRIGger:OUTPut1:DELay?
Manual operation: See "Marker x Delay" on page 91

[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:DELay:MINimum?
[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:DELay:MAXimum?
Queries the minimum/maximum marker delay for fixed marker delay setting.

Return values: 
<Maximum> float

Range: 0  to  max
Increment: 1E-3
*RST: 2000

Example: SOURce1:BB:GBAS:TRIGger:OUTPut1:DELay:MAXimum?
Usage: Query only

Manual operation: See "Marker x Delay" on page 91

[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut:DELay:FIXed <Fixed>

Restricts the marker delay setting range to the dynamic range.
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Parameters:
<Fixed> 0 | 1 | OFF | ON

*RST: 0

Example: SOURce1:BB:GBAS:TRIGger:OUTPut1:DELay:FIXed?
Manual operation: See "Marker x Delay" on page 91

10.9 Clock Settings

[:SOURce<hw>]:BB:DME:CLOCk:MODE......................................................................... 191
[:SOURce<hw>]:BB:GBAS:CLOCk:MODE........................................................................191
[:SOURce<hw>]:BB:ILS:CLOCk:MODE............................................................................191
[:SOURce<hw>]:BB:VOR:CLOCk:MODE..........................................................................191
[:SOURce<hw>]:BB:DME:CLOCk:MULTiplier................................................................... 191
[:SOURce<hw>]:BB:GBAS:CLOCk:MULTiplier..................................................................191
[:SOURce<hw>]:BB:ILS:CLOCk:MULTiplier......................................................................192
[:SOURce<hw>]:BB:VOR:CLOCk:MULTiplier....................................................................192
[:SOURce<hw>]:BB:DME:CLOCk:SOURce...................................................................... 192
[:SOURce<hw>]:BB:GBAS:CLOCk:SOURce.....................................................................192
[:SOURce<hw>]:BB:ILS:CLOCk:SOURce.........................................................................192
[:SOURce<hw>]:BB:VOR:CLOCk:SOURce.......................................................................192
[:SOURce<hw>]:BB:DME:CLOCk:SYNChronization:EXECute............................................ 192
[:SOURce<hw>]:BB:GBAS:CLOCk:SYNChronization:EXECute.......................................... 192
[:SOURce<hw>]:BB:ILS:CLOCk:SYNChronization:EXECute.............................................. 192
[:SOURce<hw>]:BB:VOR:CLOCk:SYNChronization:EXECute............................................ 192
[:SOURce<hw>]:BB:DME:CLOCk:SYNChronization:MODE................................................193
[:SOURce<hw>]:BB:GBAS:CLOCk:SYNChronization:MODE..............................................193
[:SOURce<hw>]:BB:ILS:CLOCk:SYNChronization:MODE..................................................193
[:SOURce<hw>]:BB:VOR:CLOCk:SYNChronization:MODE................................................193

[:SOURce<hw>]:BB:DME:CLOCk:MODE <MOde>
[:SOURce<hw>]:BB:GBAS:CLOCk:MODE <Mode>
[:SOURce<hw>]:BB:ILS:CLOCk:MODE <MOde>
[:SOURce<hw>]:BB:VOR:CLOCk:MODE <MOde>

Sets the type of externally supplied clock.

Parameters:
<MOde> CHIP | MCHip

*RST: CHIP

Manual operation: See "Clock Mode" on page 95

[:SOURce<hw>]:BB:DME:CLOCk:MULTiplier <Multiplier>
[:SOURce<hw>]:BB:GBAS:CLOCk:MULTiplier <Multiplier>
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[:SOURce<hw>]:BB:ILS:CLOCk:MULTiplier <Multiplier>
[:SOURce<hw>]:BB:VOR:CLOCk:MULTiplier <Multiplier>

Note: This command is available for clock source "External" and in clock mode "Multi-
ple Sample" only.

The command specifies the multiplier for clock type "Multiplied" (BB:xxx:CLOCk:
MODE MSAMple) in the case of an external clock source, where xxx stands for ILS,
VOR or DME.

Parameters:
<Multiplier> integer

Range: 1  to  64
*RST: 4

Example: BB:xxx:CLOCk:SOURce EXTernal
selects the external clock source.
BB:xxx:CLOCk:MODE MSAMple
selects clock type "Multiplied", i.e. the supplied clock has a rate
which is a multiple of the sample rate.
BB:xxx:CLOCk:MULTiplier 12
the multiplier for the external clock rate is 12.

Manual operation: See "Clock Multiplier" on page 95

[:SOURce<hw>]:BB:DME:CLOCk:SOURce <Source>
[:SOURce<hw>]:BB:GBAS:CLOCk:SOURce <Source>
[:SOURce<hw>]:BB:ILS:CLOCk:SOURce <Source>
[:SOURce<hw>]:BB:VOR:CLOCk:SOURce <Source>
Parameters:
<Source> INTernal | EXTernal

INTernal
The internal clock reference is used.
EXTernal
The external clock reference is supplied to the CLOCK connec-
tor.
*RST: INTernal

Manual operation: See "Clock Source" on page 95

[:SOURce<hw>]:BB:DME:CLOCk:SYNChronization:EXECute
[:SOURce<hw>]:BB:GBAS:CLOCk:SYNChronization:EXECute
[:SOURce<hw>]:BB:ILS:CLOCk:SYNChronization:EXECute
[:SOURce<hw>]:BB:VOR:CLOCk:SYNChronization:EXECute
Performs automatically adjustment of the instrument's settings required for the syn-
chronization mode, set with the command BB:xxx:CLOC:SYNC:MODE, where xxx
stands for ILS, VOR or DME.
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Example: BB:xxx:CLOC:SYNC:MODE MAST
the instrument is configured to work as a master one.
BB:xxx:CLOC:SYNC:EXEC
all synchronization's settings are adjusted accordingly.

Usage: Event

Manual operation: See "Set Synchronization Settings" on page 95

[:SOURce<hw>]:BB:DME:CLOCk:SYNChronization:MODE <Mode>
[:SOURce<hw>]:BB:GBAS:CLOCk:SYNChronization:MODE <Mode>
[:SOURce<hw>]:BB:ILS:CLOCk:SYNChronization:MODE <Mode>
[:SOURce<hw>]:BB:VOR:CLOCk:SYNChronization:MODE <Mode>

Selects the synchronization mode.

This parameter is used to enable generation of very precise synchronous signal of sev-
eral connected R&S SMBVs.

Note: If several instruments are connected, the connecting cables from the master
instrument to the slave one and between each two consecutive slave instruments must
have the same length and type.Avoid unnecessary cable length and branching points.

Parameters:
<Mode> NONE | MASTer | SLAVe

NONE
The instrument is working in stand-alone mode.
MASTer
The instrument provides all connected instrument with its syn-
chronization (including the trigger signal) and reference clock
signal.
SLAVe
The instrument receives the synchronization and reference clock
signal from another instrument working in a master mode.
*RST: NONE

Manual operation: See "Sync. Mode" on page 94
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A Annex

A.1 Morse Code Settings

The COM/ID tone is sent according to the selected code (see table 1-1). The length of
the Morse code can be varied. For selected standard time scheme, the selected dot
length determines the setting of all other length parameters of the Morse code (dash
length, symbol space and letter space) . For selected user time scheme, all length
parameters of the code can be set independently. If no coding is entered, the COM/ID
tone is sent uncoded (key down).

The following values are default values:
● A dot (.) has a tone duration of 100 ms
● A dash (-) has a tone duration of 300ms
● The time between two tones is 100ms
● The time between two letters is 300ms

After each word a word space is entered. The word repetition rate is 7 words/minute.
As the word length can vary between 900 ms and 4500 ms the word space between
the words varies accordingly.

Example: 
ID code = MUC
The word length =
(300+100+300)+300+(100+100+100+100+300)+300+(300+100+100+100+300+100+1
00) = 3100 ms

Table 1-1: Morse Code

Letter Morse Code Letter Morse Code

A . - N - .

B - . . . O - - -

C - . - . P . - - .

D - . . Q - - . -

E . R . - .

F . . - . S . . .

G - - . T -

H . . . . U . . -

I . . V . . . -

J . - - - W . - -

K - . - X - . . -
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Letter Morse Code Letter Morse Code

L . - . . Y - . - -

M - - Z - - . .

A.2 ICAO Channel Frequencies

In the following chapter the standardized transmitting frequencies for the ILS, DME and
VOR standards are listed.

A.2.1 ILS Channel Frequencies

The individual values in the table are:
● Ch. No. = ICAO channel number
● LOC Freq. = ILS Localizer transmitting frequency (MHz)
● GS Freq. = ILS GS frequency (MHz)

Table 1-2: Standardized ILS-GS and ILS-LOC transmitting frequencies (MHz) and the associated ICAO
channels

Ch. No. LOC
Freq.

GS Freq.  Ch.
No.

LOC
Freq.

GS Freq.  Ch.
No.

LOC
Freq.

GS Freq.

18X

18Y

108.10

108.15

334.70

334.55

 32X

32Y

109.50

109.55

332.60

332.45

 46X

46Y

110.90

110.95

330.80

330.65

20X

20Y

108.30

108.35

334.10

333.95

 34X

34Y

109.70

109.75

333.20

333.05

 48X

48Y

111.10

111.15

331.70

331.55

22X

22X

108.50

108.55

329.90

329.75

 36X

36Y

109.90

109.95

333.80

333.65

 50X

50Y

111.30

111.35

332.30

332.15

24X

24Y

108.70

108.75

330.50

330.35

 38X

38Y

110.10

110.15

334.40

334.25

 52X

52Y

111.50

111.55

332.90

332.75

26X

26Y

108.90

108.95

329.30

329.15

 40X

40Y

110.30

110.35

335.00

334.85

 54X

54Y

111.70

111.75

333.50

333.35

28X

28Y

109.10

109.15

331.40

331.25

 42X

42Y

110.50

110.55

329.60

329.45

 56X

56Y

111.90

111.95

331.10

330.95

30X

30Y

109.30

109.35

332.00

331.85

 44X

44Y

110.70

110.75

330.20

330.05

    

A.2.2 VOR Channel Frequencies

The individual values in the table cells are:
● Ch. No. = ICAO channel number
● VOR Freq. = VOR Interrogation frequency (MHz)
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Table 1-3: Standardized VOR transmitting frequencies (MHz) and the associated ICAO channels

Ch.
No.

VOR
Freq.

 Ch.
No.

VOR
Freq.

 Ch.
No.

VOR
Freq.

 Ch.
No.

VOR
Freq.

 Ch.
No.

VOR
Freq.

 Ch.
No.

VOR
Freq.

17X

17Y

108.00

108.05

 45X

45Y

110.80

110.85

 75X

75Y

112.80

112.85

 89X

89Y

114.20

114.25

 103X

103Y

115.60

115.65

 117X

117Y

117.00

117.05

19X

19Y

108.20

108.25

 47X

47Y

111.00

111.05

 76X

76Y

112.90

112.95

 90X

90Y

114.30

114.35

 104X

104Y

115.70

115.75

 118X

118Y

117.10

117.15

21X

21Y

108.40

108.45

 49X

49Y

111.20

111.25

 77X

77Y

113.00

113.05

 91X

91Y

114.40

114.45

 105X

105Y

115.80

115.85

 119X

119Y

117.20

117.25

23X

23Y

108.60

108.65

 51X

51Y

111.40

111.45

 78X

78Y

113.10

113.15

 92X

92Y

114.50

114.55

 106X

106Y

115.90

115.95

 120X

120Y

117.30

117.35

25X

25Y

108.80

108.85

 53X

53Y

111.60

111.65

 79X

79Y

113.20

113.25

 93X

93Y

114.60

114.65

 107X

107Y

116.00

116.05

 121X

121Y

117.40

117.45

27X

27Y

109.00

109.05

 55X

55Y

111.80

111.85

 80X

80Y

113.30

113.35

 94X

94Y

114.70

114.75

 108X

108Y

116.10

116.15

 122X

122Y

117.50

117.55

29X

29Y

109.20

109.25

 57X

57Y

112.00

112.05

 81X

81Y

113.40

113.45

 95X

95Y

114.80

114.85

 109X

109Y

116.20

116.25

 123X

123Y

117.60

117.65

31X

31Y

109.40

109.45

 58X

58Y

112.10

112.15

 82X

82Y

113.50

113.55

 96X

96Y

114.90

114.95

 110X

110Y

116.30

116.35

 124X

124Y

117.70

117.75

33X

33Y

109.60

109.65

 59X

59Y

112.20

112.25

 83X

83Y

113.60

113.65

 97X

97Y

115.00

115.05

 111X

111Y

116.40

116.45

 125X

125Y

117.80

117.85

35X

35Y

109.80

109.85

 70X

70Y

112.30

112.35

 84X

84Y

113.70

113.75

 98X

98Y

115.10

115.15

 112X

112Y

116.50

116.55

 126X

126Y

117.90

117.95

37X

37Y

110.00

110.05

 71X

71Y

112.40

112.45

 85X

85Y

113.80

113.85

 99X

99Y

115.20

115.25

 113X

113Y

116.60

116.65

   

39X

39Y

110.20

110.25

 72X

72Y

112.50

112.55

 86X

86Y

113.90

113.95

 100X

100Y

115.30

115.35

 114X

114Y

116.75

116.75

   

41X

41Y

110.40

110.45

 73X

73Y

112.60

112.65

 87Y

87Y

114.00

114.05

 101X

101Y

115.40

115.45

 115X

115Y

116.80

116.85

   

43X

43Y

110.60

110.65

 74X

74Y

112.70

112.75

 88X

88Y

114.10

114.15

 102X

102Y

115.50

115.55

 116X

116Y

116.90

116.95

   

A.2.3 DME Channel Frequencies

The individual values in the table are:
● Ch. No. = ICAO channel number
● VOR Freq. = VOR interrogation frequency
● DME Interrog. Freq. = DME interrogation frequency (MHz)
● DME Reply Freq. = DME reply frequency (MHz)
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Table 1-4: Standardized DME transmitting frequencies (MHz) and the associated ICAO channels for interrogation and reply

Ch.
No.

VOR
Freq.

DME
Interrog.

Freq.

DME
Reply
Freq.

 Ch.
No.

VOR
Freq.

DME
Interrog..

Freq.

DME
Reply
Freq.

 Ch.
No.

VOR
Freq.

DME
Interrog.

Freq.

DME
Reply
Freq.

1X

1Y

 1025

1025

962

1088

 43X

43Y

110.60

110.65

1067

1067

1004

1130

 85X

85Y

113.80

113.85

1109

1109

1172

1046

2X

2Y

 1026

1026

963

1089

 44X

44Y

110.70

110.75

1068

1068

1005

1131

 86X

86Y

113.90

113.95

1110

1110

1173

1047

3X

3Y

 1027

1027

964

1090

 45X

45Y

110.80

110.85

1069

1069

1106

1132

 87X

87Y

114.00

114.05

1111

1111

1174

1048

4X

4Y

 1028

1028

965

1091

 46X

46Y

110.90

110.95

1070

1070

1007

1133

 88X

88Y

114.10

114.15

1112

1112

1175

1049

5X

5Y

 1029

1029

966

1092

 47X

47Y

111.00

111.05

1071

1071

1008

1134

 89X

89Y

114.20

114.25

1113

1113

1176

1050

6X

6Y

 1030

1030

967

1093

 48X

48Y

111.10

111.15

1072

1072

1009

1135

 90X

90Y

114.30

114.35

1114

1114

1177

1051

7X

7Y

 1031

1031

968

1094

 49X

49Y

111.20

111.25

1073

1073

1010

1136

 91X

91Y

114.40

114.45

1115

1115

1178

1052

8X

8Y

 1032

1032

969

1095

 50X

50Y

111.30

111.35

1074

1074

1011

1137

 92X

92Y

114.50

114.55

1116

1116

1179

1053

9X

9Y

 1033

1033

970

1096

 51X

51Y

111.40

111.45

1075

1075

1012

1138

 93X

93Y

114.60

114.65

1117

1117

1180

1054

10X

10Y

 1034

1034

971

1097

 52X

52Y

111.50

111.55

1076

1076

1013

1139

 94X

94Y

114.70

114.75

1118

1118

1181

1055

11X

11Y

 1035

1035

972

1098

 53X

53Y

111.60

111.65

1077

1077

1014

1140

 95X

95Y

114.80

114.85

1119

1119

1182

1056

12X

12Y

 1036

1036

973

1099

 54X

54Y

111.70

111.75

1078

1078

1015

1141

 96X

96Y

114.90

114.95

1120

1120

1183

1057

13X

13Y

 1037

1037

974

1100

 55X

55Y

111.80

111.85

1079

1079

1016

1142

 97X

97Y

115.00

115.05

1121

1121

1184

1058

14X

14Y

 1038

1038

975

1101

 56X

56Y

111.90

111.95

1080

1080

1017

1143

 98X

98Y

115.10

115.15

1122

1122

1185

1059

15X

15Y

 1039

1039

976

1102

 57X

57Y

112.00

112.05

1081

1081

1018

1144

 99X

99Y

115.20

115.25

1123

1123

1186

1060

16X

16Y

 1040

1040

977

1103

 58X

58Y

112.10

112.15

1082

1082

1019

1145

 100X

100Y

115.30

115.35

1124

1124

1187

1061

17X

17Y

108.00

108.05

1041

1041

978

1104

 59X

59Y

112.20

112.25

1083

1083

1020

1146

 101X

101Y

115.40

115.45

1125

1125

1188

1062

18X

18Y

108.10

108.15

1042

1042

979

1105

 60X

60Y

 1084

1084

1021

1147

 102X

102Y

115.50

115.55

1126

1126

1189

1063

ICAO Channel Frequencies



AnnexAvionics Standards

198Operating Manual 1176.8600.02 ─ 05

Ch.
No.

VOR
Freq.

DME
Interrog.

Freq.

DME
Reply
Freq.

 Ch.
No.

VOR
Freq.

DME
Interrog..

Freq.

DME
Reply
Freq.

 Ch.
No.

VOR
Freq.

DME
Interrog.

Freq.

DME
Reply
Freq.

19X

19Y

108.20

108.25

1043

1043

980

1106

 61X

61Y

 1085

1085

1022

1148

 103X

103Y

115.60

115.65

1127

1127

1190

1064

20X

20Y

108.30

108.35

1044

1044

981

1107

 62X

62Y

 1086

1086

1023

1149

 104X

104Y

115.70

115.75

1128

1128

1191

1065

21X

21Y

108.40

108.45

1045

1045

982

1108

 63X

63Y

 1087

1087

1024

1150

 105X

105Y

115.80

115.85

1129

1129

1192

1066

22X

22Y

108.50

108.55

1046

1046

983

1109

 64X

64Y

 1088

1088

1151

1025

 106X

106Y

115.90

115.95

1130

1130

1193

1067

23X

23Y

108.60

108.65

1047

1047

984

1110

 65X

65Y

 1089

1089

1152

1026

 107X

107Y

116.00

116.05

1131

1131

1194

1068

24X

24Y

108.70

108.75

1048

1048

985

1111

 66X

66Y

 1090

1090

1153

1027

 108X

108Y

116.10

116.15

1132

1132

1195

1069

25X

25Y

108.80

108.85

1049

1049

986

1112

 67X

67Y

 1091

1091

1154

1028

 109X

109Y

116.20

116.25

1133

1133

1196

1070

26X

26Y

108.90

108.95

1050

1050

987

1113

 68X

68Y

 1092

1092

1155

1029

 110X

110Y

116.30

116.35

1134

1134

1197

1071

27X

27Y

109.00

109.05

1051

1051

988

1114

 69X

69Y

 1093

1093

1156

1030

 111X

111Y

116.40

116.45

1135

1135

1198

1072

28X

28Y

109.10

109.15

1052

1052

989

1115

 70X

70Y

112.30

112.35

1094

1094

1157

1031

 112X

112Y

116.50

116.55

1136

1136

1199

1073

29X

29Y

109.20

109.25

1053

1053

990

1116

 71X

71Y

112.40

112.45

1095

1095

1158

1032

 113X

113Y

116.60

116.65

1137

1137

1200

1074

30X

30Y

109.30

109.35

1054

1054

991

1117

 72X

72Y

112.50

112.55

1096

1096

1159

1033

 114X

114Y

116.70

116.75

1138

1138

1201

1075

31X

31Y

109.40

109.45

1055

1055

992

1118

 73X

73Y

112.60

112.65

1097

1097

1160

1034

 115X

115Y

116.80

116.85

1139

1139

1202

1076

32X

32Y

109.50

109.55

1056

1056

993

1119

 74X

74Y

112.70

112.75

1098

1098

1161

1035

 116X

116Y

116.90

116.95

1140

1140

1203

1077

33X

33Y

109.60

109.65

1057

1057

994

1120

 75X

75Y

112.80

112.85

1099

1099

1162

1036

 117X

117Y

117.00

117.05

1141

1141

1204

1078

34X

34Y

109.70

109.75

1058

1058

995

1121

 76X

76Y

112.90

112.95

1100

1100

1163

1037

 118X

118Y

117.10

117.15

1142

1142

1205

1079

35X

35Y

109.80

109.85

1059

1059

996

1122

 77X

77Y

113.00

113.05

1101

1101

1164

1038

 119X

119Y

117.20

117.25

1143

1143

1206

1080

36X

36Y

109.90

109.95

1060

1060

997

1123

 78X

78Y

113.10

113.15

1102

1102

1165

1039

 120X

120Y

117.30

117.35

1144

1144

1207

1081
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Ch.
No.

VOR
Freq.

DME
Interrog.

Freq.

DME
Reply
Freq.

 Ch.
No.

VOR
Freq.

DME
Interrog..

Freq.

DME
Reply
Freq.

 Ch.
No.

VOR
Freq.

DME
Interrog.

Freq.

DME
Reply
Freq.

37X

37Y

110.00

110.05

1061

1061

998

1124

 79X

79Y

113.20

113.25

1103

1103

1166

1040

 121X

121Y

117.40

117.45

1145

1145

1208

1082

38X

38Y

110.10

110.15

1062

1062

999

1125

 80X

80Y

113.30

113.35

1104

1104

1167

1041

 122X

122Y

117.50

117.55

1146

1146

1209

1083

39X

39Y

110.20

110.25

1063

1063

1000

1126

 81X

81Y

113.40

113.45

1105

1105

1168

1042

 123X

123Y

117.60

117.65

1147

1147

1210

1084

40X

40Y

110.30

110.35

1064

1064

1001

1127

 82X

82Y

113.50

113.55

1106

1106

1169

1043

 124X

124Y

117.70

117.75

1148

1148

1211

1085

41X

41Y

110.40

110.45

1065

1065

1002

1128

 83X

83Y

113.60

113.65

1107

1107

1170

1044

 125X

125Y

117.80

117.85

1149

1149

1212

1086

42X

42Y

110.50

110.55

1066

1066

1003

1129

 84X

84Y

113.70

113.75

1108

1108

1171

1045

 126X

126Y

117.90

117.95

1150

1150

1213

1087

A.3 Default Settings

In the following chapter the standard default settings for the Avionic standards are lis-
ted. The preset value of each parameter is specified also in the description of the cor-
responding remote command.

A.3.1 GBAS

The default settings for the GBAS standard are:

Parameter Value

State Not affected by "Set to Default"

Filter, Clipping Cosine, Clipping Off

Trigger Internal, Auto

Clock Internal

Multiple Frequency Channels Off

Sample Rate 10.5 KHz

A.3.2 ILS

The default settings for the ILS standard are:
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Table 1-5: Glide slope default settings

Parameter Value

State Not affected by Set to default

Sum of Depth 80 Percent

Fly Up

DDM 0

Mode Norm

Up Frequency 90 Hz

Down Frequency 150 Hz

Up/Down Phase 0 deg

COM/ID State Off

COM/ID Frequency 1020 kHz

COM/ID Depth 10 percent

Table 1-6: Localizer default settings

Parameter Value

State Not affected by Set to default

Sum of Depth 40 Percent

Fly Up

DDM 0

Mode Norm

Left frequency 90 Hz

Right Frequency 150 Hz

Left/Right Phase 0 deg

COM/ID State Off

COM/ID Frequency 1020 kHz

COM/ID Period 9 s

COM/ID Depth 10 percent

Table 1-7: Marker Beacon default settings

Parameter Value

State Not affected by Set to default

Marker frequency 400 Hz

Marker Depth 95 %

COM/ID State Off

COM/ID Frequency 1020 kHz

Default Settings
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Parameter Value

COM/ID Period 9 s

COM/ID Depth 10 percent

Rf frequency 75 MHz

A.3.3 DME

The default settings for the DME standard are:

Table 1-8: Default settings for the DME standard

Parameter Value

General Parameters

State Not affected by Set to default

DME Mode Interrogation

Signal Settings

Channel Mode X Channel

Carrier Frequency 1.025 000 000 000 GHz

Pulse Squitter Off

Pulse Repetition Rate 48 Hz

Pulse Settings

Pulse Shape Cos^2

Pulse Rise 2.00 µs

Pulse Width 3.50 µs

Pulse Fall 2.00 µs

Pulse Spacing 12.00 µs

Single Pulse Off

Receive Settings

Pulse Pair Spacing Tolerance 1.00 µs

A.3.4 VOR

The default settings for the VOR standard are:

Table 1-9: VOR default settings

Parameter Value

State Not affected by Set to default

Carrier Frequency Mode User Defined
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Parameter Value

Carrier Frequency 108.000 000 000 MHz

Mode Norm

VAR/REF Frequency 30.0 Hz

VAR Depth 30.0 %

Subcarrier Frequency 9.960 0 kHz

Subcarrier Depth 30. 0%

REF Deviation 480 Hz

Bearing Angle 0.00 deg

Direction From

COM/ID State Off

A.4 Supported File Formats

The R&S SMBV supports the following file formats:
● waypoint files, see chapter A.4.1, "Waypoint File Format", on page 202.
● files with GBAS differential data, see chapter A.4.2, "GBAS Differential File For-

mat", on page 203.

These files use predefined file extensions and file structure.

A.4.1 Waypoint File Format

The waypoint files use the file extension *.txt. The file format is a list of coordinates
(longitude, latitude, altitude) and a respective resolution in milliseconds (see exam-
ple "Contents of the predefined waypoint file Braunschweig.txt" on page 202).

Example: Contents of the predefined waypoint file Braunschweig.txt
The resolution command at the beginning of the format specifies the sampling interval
to be used for the WGS84 geodetic coordinates list. The resolution gives the time (in
ms) between two consecutive waypoints.

RESOLUTION: 10000
10.48270840370976,52.32054084253119,1200
10.48782531447518,52.32057768227161,1100
10.49064540739393,52.32038679250167,1000
10.49541991083499,52.32019512664971,900
10.50027587576012,52.32000536916035,800
10.50535314978533,52.3200431506525,700
10.50926768002483,52.32002989881414,600
10.51213496693413,52.31984142364868,500
10.51596247360969,52.31963813345246,400
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10.52023872584375,52.31964325051492,300
10.52435479286515,52.31930292486343,200
10.52746875803649,52.31913528562811,100

A.4.2 GBAS Differential File Format

The GBAS differential files are proprietary files with file extension *.rs_gbas. The file
contains the required information for message type 1, as defined in the GBAS specifi-
cation RTCA DO-246D.

See example "Contents of the predefined GBAS differential file Correction1.rs_gbas"
on page 204 for an example of the file format.
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Example: Contents of the predefined GBAS differential file Correction1.rs_gbas
<reference1>
    <general>
            <property refcoord="11.5833,48.15,110"/>
    </general>
    <dgnssrecord>
        <property modifiedzcount="215.1"/>
        <property measurementtype="0"/>
        <property ephemeriscrc="0xECF0"/>
        <dgnssvector data="G1,4,311.49,-1.20"/>
        <dgnssvector data="G3,16,81.6,3.41"/>
        <dgnssvector data="G4,110,65,-1.1"/>
        <dgnssvector data="G10,21,6.31,-0.51"/>
        <dgnssvector data="R6,61,5.85,-0.41"/>
        <dgnssvector data="S125,126,212.15,9.41"/>
    </dgnssrecord>
    <dgnssrecord>
        <property modifiedzcount="225.1"/>
        <property measurementtype="0"/>
        <property ephemeriscrc="0xEFF0"/>    
        <dgnssvector data="G1,4,311.49,-1.20"/>
        <dgnssvector data="G3,16,81.6,3.41"/>
        <dgnssvector data="G4,110,65,-1.1"/>
        <dgnssvector data="G10,21,6.31,-0.51"/>
        <dgnssvector data="R6,61,5.85,-0.41"/>
        <dgnssvector data="S125,126,212.15,9.41"/>
    </dgnssrecord>
    <dgnssrecord>
        <property modifiedzcount="235.1"/>
        <property measurementtype="0"/>
        <property ephemeriscrc="0xBCF0"/>    
        <dgnssvector data="G1,4,311.49,-1.20"/>
        <dgnssvector data="G3,16,81.6,3.41"/>
        <dgnssvector data="G4,110,65,-1.1"/>
        <dgnssvector data="G10,21,6.31,-0.51"/>
        <dgnssvector data="R6,61,5.85,-0.41"/>
        <dgnssvector data="S125,126,212.15,9.41"/>
    </dgnssrecord>    
</reference1>

The table 1-10 describes the used tags and parameters.

Table 1-10: Format of *.rs_gbas file

Container Tag name Parameter Description

<reference1>    

<general>    

 <property> <refcoord> longitude, latitude and altitude of the reference point

<dgnssrecord>   one <dgnssrecord> per measurements

Supported File Formats
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Container Tag name Parameter Description

 <property> <modifiedzcount> modified z-count for the record (s)

  <measurementtype> measurement type

  <ephemeriscrc> ephemeris CRC

 <dgnssvector> <data> One <dgnssvector> per each of the N measurement blocks:

<GNSS _Standard><SVID>,<Issue of Data (IOD)>,<Pseudor-
ange Correction (PRC) in (m)>,<Range Rate Correction (RRC)
in (m/s)>

GNSS _Standard=G for GPS, R for Glonass and S for SBAS

Supported File Formats
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Glossary: Specifications and References
Symbols

1MA193: 1MA193_0e Application Note, "Aeronautical radio navigation measurement
solutions"

R
RTCA DO-246D: "GNSS-Based Precision Approach Local Area Augmentation System
(LAAS) Signal-in-Space Interface Control Document (ICD)"
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List of Commands
[:SOURce<hw>]:BB:DME:ANALysis:EFFiciency:OK?...................................................................................173
[:SOURce<hw>]:BB:DME:ANALysis:EFFiciency?.........................................................................................173
[:SOURce<hw>]:BB:DME:ANALysis:GATE:COUNt...................................................................................... 173
[:SOURce<hw>]:BB:DME:ANALysis:GATE:EDELay.....................................................................................173
[:SOURce<hw>]:BB:DME:ANALysis:GATE:TIME......................................................................................... 174
[:SOURce<hw>]:BB:DME:ANALysis:GATE[:LENGth]...................................................................................174
[:SOURce<hw>]:BB:DME:ANALysis:IAFactor?.............................................................................................177
[:SOURce<hw>]:BB:DME:ANALysis:NORMalize?........................................................................................ 174
[:SOURce<hw>]:BB:DME:ANALysis:POWer:OK?.........................................................................................175
[:SOURce<hw>]:BB:DME:ANALysis:POWer?...............................................................................................175
[:SOURce<hw>]:BB:DME:ANALysis:PRRate:OK?........................................................................................176
[:SOURce<hw>]:BB:DME:ANALysis:PRRate?..............................................................................................175
[:SOURce<hw>]:BB:DME:ANALysis:PSAFactor?......................................................................................... 177
[:SOURce<hw>]:BB:DME:ANALysis:RDIStance?......................................................................................... 176
[:SOURce<hw>]:BB:DME:ANALysis:STATe................................................................................................. 176
[:SOURce<hw>]:BB:DME:ANALysis:TIME:OK?............................................................................................177
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